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ABSTRACT

THE PUEBLITOS OF PALLUCHE CANYON:
AN EXAMINATION OF THE ETHNIC AFFILIATION
OF THE PUEBLITO INHABITANTS
AND RESULTS OF ARCHAEOLOGICAL SURVEY
AT LA 9073, LA 10732 AND LA 86895,

NEW MEXICO

Leslie-lynne Sinkey
Department of Anthropology

Master of Arts

The small, above-ground masonry structures of northwestern New
Mexico called “pueblitos” first came to the attention of anthropologists in
over a century ago. In 1920, the noted archaeologist A.V. Kidder
hypothesized that these masonry structures might have been built by
Puebloan refugees fleeing Spanish reprisals in the wake of the Spanish
reconquest of New Mexico after the Pueblo Revolt, and he proposed that
this hypothesis be tested. Over the next several decades, however, the

hypothesis remained untested, but it became both accepted as
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established fact and the basis for most anthropological, archaeological,
and historical reconstructions of Navajo history and cultural
development.

This thesis attempts to validate or disprove Kidder’s hypothesis,
based on the archeological remains at the sites, and based on
ethnographic evidence recorded for both the Navajo and Puebloan
groups. The evidence presented by the ceramic wares (utility wares in
particular), the architecture and construction techniques at the sites,
and the settlement and community organization evident at and
surrounding the sites were all considered. Theoretical models were
developed, reflecting the sites as they would appear if they were
constructed and occupied solely by Navajo, solely by Puebloans, or by a
co-resident population consisting of both groups. The archaeological
evidence from twelve pueblito sites and their surrounding complexes is
then compared against expectations in the models.

In order to provide a larger database upon which to base
conclusions, three pueblito sites (LA 9073, LA 10732, and LA 86895) and
their surrounding complexes were surveyed and documented in the fall
of 2002. The results are included herein.

The ceramic, architectural, settlement and ethnographic data all
serve to disprove Kidder’s eighty-year-old hypothesis, to establish that

the builders of the sites were, in fact, Navajo. This provides further
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impetus for the formulation of new hypotheses in the realm of Navajo

archaeology.

o AJLb
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1 Introduction

The so-called “Pueblito Phenomenon” (Towner 1996:149) of
northwestern New Mexico is one that has engaged the attention of
archaeologists and anthropologists for more than nine decades. In spite
of the attention paid to their existence and supposed origins, however,
surprisingly little archaeological research has been conducted on the
structures themselves.

Pueblitos are small, above-ground structures generally constructed
in defensible positions, such as the tops of small mesas or large boulders
(Towner 1996:149) (Figure 1.1). Some 130 such structures are known.
Due to their contiguous rooms and stone walls, they bear a striking
resemblance to the architecture of the Puebloan groups of the American
Southwest (thus the name “pueblitos”, meaning “little pueblos”).
However, these sites also exhibit considerable evidence of occupation by
Navajo groups, particularly in the form of wooden structures, often now
collapsed, interpreted to be the remains of forked-pole hogans, a form of
traditional Navajo dwelling (Jett and Spencer 1991; Mindeleff 1898).

In the early part of the twentieth century and on the basis of
extremely limited excavation and a quotation from anthropologist and
historian Adolf Bandelier (1892:216), the noted archaeologist A.V. Kidder
proposed that these sites were constructed and occupied by Puebloans

seeking refuge in Navajo territory from Spanish reprisals in the wake of
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the Pueblo Revolt of 1680 (Kidder 1920:327-328). Over time his
hypothesis has been promulgated in the archaeological literature until it
attained the status of generally accepted fact (Bailey and Bailey 1986:15;

Brugge 1968: 16; Hester 1962:4, 5; Hogan 1991:3).

Figure 1.1 Frances Canyon Pueblito.

For a period of some seventy years Kidder’s untested “refugee
hypothesis” formed the basis for the archaeological, anthropological,
historical, and biological understanding of the Navajo culture (and
people) as it exists today (Bailey and Bailey 1986:15; Hogan 1991:7). In
recent years, however, the “refugee hypothesis,” and its implications,

have begun to be questioned by a number of researchers.
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Patrick Hogan (1991) has argued forcefully and convincingly, on
the basis of historical documents, that the number of Puebloan refugees
was in reality considerably lower than previously believed. He suggests
that most of those who fled the Rio Grande pueblos can be accounted for
by refugee populations which settled at Zuni and Hopi, as well as others
who remained in hiding in the mountains surrounding their original
pueblos.

Ronald Towner (1992, 1996) provided the first archaeological
approach to the re-analysis of the refugee question, by conducting
extensive dendrochronological dating of the pueblito structures and
surrounding hogans. His work has demonstrated that the vast majority
of pueblitos were, in fact, constructed well after the Pueblo Revolt and
subsequent reconquest, during a time of comparative peace with the
Spaniards.

Whereas Towner and Hogan have attempted to address the
question of ethnic co-residence at pueblito sites, they have approached it
from dendrochronological and historic standpoints, respectively, rather
than through the archaeological remains at the sites themselves.
Although dendrochronology does rely upon material remains, it can only
tell the “when” of the sites, and not the “who.”

Other researchers have recently applied other lines of
archaeological evidence such as ceramics and rock art to demonstrate

long-standing, pre-Revolt interaction between the Navajo and Puebloan
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groups (e.g. Copeland and Rogers 1996; Reed and Reed 1992; Reed and
Reed 1996). These long-standing relationships may help in part to
explain noted similarities between Navajo and Puebloan cultures, but
they do not, in and of themselves, address the question of whether ethnic
co-residence did or did not occur at pueblito sites. The only means by
which this question may be resolved is by a closer examination of the
archaeological evidence at the pueblitos themselves.

The necessity of exploration of this question from an archaeological
standpoint has been acknowledged by a number of researchers. Gary

Brown (1996:47,52) has recently observed:

Rather than rely on historical documents and ethnohistory...
archaeological and ethnoarchaeological data are critical for
elucidating both the historic and protohistoric
periods...Chronometric data may be sufficient to place a site
component into an archaeological chronology, but additional

information about who occupied the site is necessary. (emphasis

added)

Charles Wheeler, Scott Wilcox, and David Ayers (1996:232) have

also noted that:

Whether the [Navajo] interaction with the Pueblos occurred as a
result of Pueblo Indians living with the Navajo after the Revolt, as a
result of interaction during alliance formation...or in a relationship

similar to the Pueblo/Plains macroeconomy...remains an
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important question. Only when the chronology is clear can the
cultural dynamics be studied. There is an important difference
between the kinds of social interactions and cultural processes
that occur between groups living together and groups interacting
socially and/or economically. Reviews and interpretations of the
historical data are instructive, but archaeological data are equally

important to the definition and analysis of the interaction.

David Brugge (1996:256) has likewise concluded:

The significant question, in my mind, is not whether there has
been Puebloan introgression, but when it took place, the rate of

incorporation, and the conditions under which it took place.

In spite of this consensus among archaeologists of the need for
direct archaeological evidence to clarify the extent and nature of Navajo-
Puebloan interaction during the Gobernador phase (c. 1680-1750), and
by extension our understanding of Southwestern protohistory, such
research has not been undertaken. Although there can be no doubt that
the Navajo did interact with the residents of the pueblos—history, oral
history, and archaeological evidence all bear record of both raiding and
trading (see Marshall 1995; Matthews 1994; Reed and Reed 1992; Reeve
1958; Schaafsma 2002)—the question remains unresolved whether or
not the range of inter-ethnic interaction included Navajo and Puebloan

co-residence at pueblito sites. That, then, is the focus of this thesis.
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Theoretical Orientation

The question of ethnic identity is a notoriously difficult one to
address, even for anthropologists working with living groups. A single
individual, for instance, may variously identify himself as a Lutheran, an
African-American, a Minnesotan, or an American, depending upon the
circumstances. The problem of assigning ethnic identity becomes even
more complex when dealing with the archaeological record, with the
material culture of individuals who can no longer be consulted regarding
their own perceptions of their ethnic identity, whom they consider “self,”
or part of their own group, and who they consider “other,” or outsiders.

Limited as they are by the nature of their database, archaeologists
must search for material evidence which they then, in turn, presume to
reflect distinctions between ethnic groups. This material evidence can
take numerous forms: ceramics, basketry, architecture, clothing,
hairstyles, cranial deformation practices, and a host of others. The
defining characteristics used in differentiating variations in this material
evidence are generally referred to as “style.” “Style” can be most simply
defined as “a way of doing something,” (Hegmon 1995:1). This can
include “decoration,” or conscious style—such as the choice of a pottery
motif—or sub-conscious style—such as the technique used in forming a

pot, whether by coiling, molding, or paddle-and-anvil. This latter, sub-
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conscious style has variously been described as “isochrestic style”
(Sackett 1990) or “technological style” (Stark 1995).

Many of the most heated arguments among archaeologists regard
the relationship between style and ethnicity—whether variations in the
former are the hallmark of variation in the latter. In truth, ethnic
identity is a fluid concept (Stark 1995:331, 362), one which may be
variously delineated (as with the Lutheran African-American Minnesotan)
in differing contexts, as well as variously manifested in the archaeological
record. In some instances, such manifestations may cross-cut linguistic
and other lines which might otherwise be used to define “ethnicity”
(Stark 1995:344). Archaeologically and ethnohistorically, such a
phenomenon can be seen in the kachina cult of the American Southwest,
or in the contemporary example cited above, membership in the
Lutheran church. In other instances, stylistic variations may signal
membership in a sub-set of individuals within a society (African-
Americans, or Minnesotans) and intimate membership in a particular
moiety, clan, or village. The problem most commonly confronting
archaeologists, then, is determining both whether stylistic variation is
indicative of ethnic variation, and if so, what type of ethnic variation is
indicated.

A distinct advantage held by archaeologists working in the historic
and proto-historic periods is that in many instances an understanding of

the definitions of ethnic categories is available to them—not as
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archaeologists would define those categories, but as the group members
themselves would define them (with the recognition that those definitions
may still be fluid, with the “out” group being variously members of other
moieties, villages, or linguistic groups). From this perspective, then, it is
possible to select a level of ethnic identity (moiety, village, tribe, language
family), and proceed to establish the material culture correlates, or
archaeological markers, which identify that ethnic group. These markers
are generally perceived as variations in artifact style.

For the purposes of this research, the ethnic groups in question
are defined at a relatively large scale—Navajo vs. Puebloan. Historical
records and oral history make it quite clear that these were ethnic
distinctions—based on linguistic, subsistence, settlement, religious, and
material cultural differences—which were recognized by the people
themselves, living at that time. Historic accounts, in concert with
archaeological research provide a “direct historical” approach to the
definition of the archaeological indices of membership in each of these
ethnic groups.

This project focuses on three major categories of archaeological
data: ceramics, architecture, and settlement patterns. These three prove
effective guides to ethnicity in this instance, as they are durable,
ubiquitous, and distinctly different between the two groups. Thus the
immigration of Puebloan refugees into Navajo territory, as postulated by

Kidder, should be abundantly evident in the introduction of new artifact,
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architectural, and settlement styles into the archaeological record of the
Dinétah region.

The presence of small quantities of Puebloan ceramics has long
been noted at pueblito sites, but the focus of this study will be on the
presence, or absence, of Navajo and Puebloan utility wares. Utility wares
are less apt to be present on a site as a consequence of trade and are
more accurate indices of the actual presence of members of an ethnic
group at the site (Stark 1995:333, 336). Therefore, it is postulated here
that the presence of utility wares belonging to a particular ethic group at
pueblito sites is evidence of the presence of members of that particular
ethnic group—Dinétah Gray of the presence of Navajos, and Puebloan
utility wares of the presence of Puebloans, and that their absence
signifies the absence of members of that particular ethnic group (see
Chapter 11 for a further discussion).

Architectural styles are a key index of ethnicity, as they often
reflect both a community’s social organization and its perception of the
organization of the cosmos (Bell 2000:116-117; Hegmon 1989:5-10; Jett
and Spencer 1981:22-23, 239; Ortiz 1969:18-24.) As a form of
“isochrestic” or “technological” style, it is less subject to modification
than are decorative styles. An even more significant consideration is
construction technique: for instance, numerous different masonry and
adobe construction styles have been employed in the American

Southwest over the centuries, but once they have been plastered over
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with adobe—as was universally the case—there is little on the exterior to
distinguish between the core-and-veneer walls of Chaco Canyon, the
rough masonry walls built by the Towa, and the all-adobe construction
utilized by the Tewa. Therefore, such variations represent solely a
community’s conception of the “right way of doing things,” rather than
being used to signal ethnic affiliation to visitors to the pueblo. If, as
Kidder proposed, the pueblitos were built and inhabited by Puebloan
refugees among the Navajo, the construction techniques and overall
architecture of the structures should reflect that, and even indicate
which ethnic group, or suite of ethnic groups with similar practices, the
refugees hailed from. If the pueblitos were an indigenous Navajo
adaptation, that, too, should be reflected in the architecture and
construction of the structures (see Chapter 12 for a further discussion).
Like architecture, community settlement patterns are a reflection
of the social mores of a group, and in the case of the Navajo and
Puebloans, they are widely variant. The hunter-gatherer/agriculturalist,
incipient pastoralist lifeways of the Navajo were well suited to their
dispersal on the landscape, and stands in stark contrast to the highly-
aggregated settlements of the Puebloans. Both of these patterns were
well-adapted to the defensive techniques of each group—an important
consideration in light of the evident role of the pueblitos as defensive
structures. The widely-variant settlement patterns of the Navajo and the

Puebloans are also reflective of their ceremonial and religious practices,
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with the Navajo religion being largely individualistic and shamanistic,
whereas the Puebloan kiva religion was highly regimented and played a
major role in social incorporation, regulation, and cohesion.

As with ceramics and architecture, the differences in settlement
patterns should be evident both at individual pueblito sites, and in the
patterning of pueblitos across the landscape, with aggregation being
indicative of Puebloans as the builders and inhabitants of the sites, and
dispersion characteristic of Navajo construction (see Chapter 13 for a

further discussion).

Thesis Overview

In order to provide an overview of the historical framework in
which the pueblitos were constructed, a brief overview of Navajo
prehistory and history follows (see Chapter 2), based on current
archaeological research and contemporary Spanish documents. This
summary includes the period from the presumed first arrival of
Athapaskan groups in the American southwest to the 1805 massacre of
Navajos in Canyon de Chelly by Spanish forces, at which time the Navajo
had largely abandoned the Dinétah region, and pueblito construction in
the area had ended. This is followed by a brief overview of the Pueblo
Revolt (see Chapter 3) and a detailed review of the history of pueblito

research, beginning in the 1880s (see Chapter 4).
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Details of the survey methodology are presented in Chapter 5. The
subsequent four chapters address Palluche Canyon and its pueblitos—
the first, Chapter 6, provides an overview of the canyon proper, its
topography, climate, vegetation, wildlife, and archaeology. The next
three chapters provide data on the results of survey conducted at and
around three pueblito sites in the fall of 2002.

Archaeological research and Spanish archives are by no means the
only record of the history and interactions of Navajo and Spanish groups.
Kidder’s original hypothesis regarding the residents of the pueblitos was
based on his interpretation of Towa oral tradition, as recorded by Adolf
Bandelier (Kidder 1920:327-328). Thus, a review of pertinent portions of
the oral histories of Navajo migration and clan origins, as well as Towa
and Tewa oral histories regarding the 1680 Pueblo Revolt and its
aftermath, are included in Chapter 10. These histories were drawn from
published sources—no attempt was made to conduct interviews with
informants.

This is followed by the formulation of three theoretical models,
postulating the anticipated ceramic remains (Chapter 11), architectural
styles and construction techniques (Chapter 12), and the patterning of
community organization and settlement patterns (Chapter 13). The
models reflect three scenarios: the characteristics expected of a
community built and inhabited by Navajos, those of a community built

and inhabited by Puebloans, or the postulated character of an ethnically
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mixed community of Navajos and Puebloans. It is these models against
which the data gleaned from eleven pueblito sites were compared (three
found in Palluche Canyon, and results from a similar 1990 survey of
eight pueblitos by Michael Marshall [1991, 1995]). The survey results in
the three categories (ceramics, architecture, and settlement) are
considered individually, each in the appropriate chapter.

Tapacito Ruin (LA 2298) stands as a unique structure among the
pueblitos of the Dinétah region, and in keeping with Towner’s suggestion
that it “be viewed as a separate entity” (1996:166), it receives
independent consideration in Chapter 14. Again, the models previously
developed are invoked to attempt to determine the nature of this unusual
case.

The final chapter includes a summary of the evidence arguing for
the pueblitos as solely Navajo phenomena. This is followed by a
consideration of the implications for the current understanding of Navajo

archaeology, and some directions for future research.
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2 Overview of Navajo History to 1805

Arrival in the Southwest

To the Navajo, their beginnings, as outlined in their origin stories
(Fishler 1953; Klah 1942; Matthews 1994; O’Bryan 1956) are quite clear.
From the western archaeological and historical perspective, however,
Navajo origins are far more enigmatic. The following presents a brief
overview of what is known, and what is believed to be known, about the
Navajo sojourn in the American southwest until the end of the eighteenth
century, by which time pueblito construction—the major focus of this
thesis—had ceased, and the Dinétah region had been largely abandoned
as a habitation area (Towner 1997:331).

The Navajo, like various Apache groups, speak an Athapaskan
language (Hoijer 1938:75). The term Athapaskan derives from the name
of a northern Canadian lake which straddles the Alberta-Saskatchewan
border. Like their namesake, most Athapaskan-speaking groups are
found in the northern boreal forest of Canada and Alaska, and indeed
comprise the bulk of the languages of this region, with a limited number
of Athapaskan-speakers stretching south along the northwest coast of
North America (Hoijer 1938:75). The Navajo and Apache are the only

Southwestern representatives of the language family, and indications are
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that they represent a southward movement of Athapaskan speakers,
rather than a remnant left from a northward migration (Hoijer 1938).

While linguistics indicate that the Navajo and Apache are relatively
recent arrivals in the American southwest—glottochronology suggests
500-1000 years—(Hoijer 1956:232), there is little or no indication of the
route that they followed to reach it. Two schools of thought have
developed over the years, which Towner (1997:391) has characterized as
the “Early Entry-Mountain Route” and the “Late Entry-High Plains”
models respectively (see also Wilcox 1981:215). A third proposed route
to the southwest, via intermountain valleys to the Great Basin and
thence southward to the American Southwest, has also been proposed
(Steward 1936:62; Wilcox 1981:215). More recent research, however,
has largely discredited Steward’s model (Wilcox 1981:217-218).

The salient aspects of the Early Entry-Mountain Route hypothesis
involves an Athapaskan group—which later differentiated into Apache
and Navajo—making its way southward from northern Canada via
intermountain valleys and passes, to arrive in the southwest prior to AD
1500, and possibly early enough to overlap with the Anasazi occupation
of the San Juan region. Subsequent to the Anasazi abandonment of the
area in approximately AD 1300 (Gerow and Hogan 2000:11), the Navajo
became the only permanent indigenous residents of the area, while other

Apachean groups settled to the south and east.
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In contrast, the Late Entry-High Plains model envisions bison-
hunting Athapaskan-speakers drifting southward from the Black Hills,
subsisting on bison, until they reached the southwest approximately
1525 AD, where they began trading with the western pueblos shortly
before the arrival of the Spaniards (Hester 1962:5). This group gradually
dispersed to form the various Apache tribes, with the Navajo moving
west, adopting corn agriculture from the Puebloans (Wilcox 1981), and
settling in the Piedra Lumbre valley in the mid-seventeen century
(Schaafsma 2002:306-309). Increased conflict with the Spaniards,
including involvement with the Pueblo Revolt and subsequent reprisals,
then forced the Navajo farther west (Schaafsma 2002:303) into the region
now known as Dinétah—the Navajo homeland.

Although these are the two primary models of Athapaskan arrival
in the southwest, each suffers from significant shortfalls in supporting
data. The Late Entry-High Plains model is based primarily on
ambiguous historic Spanish accounts, particularly that of the initial
Coronado expedition of 1541, in which they record encountering a group
of bison-hunting dog-nomads on the plains east of Pecos, and whom they
dubbed “Querechos” (Gunnerson 1956:346; Wilcox 1981:219). Although
there is no clear evidence that these Indians were Navajo, or even
Athapaskan-speaking, it is commonly accepted in the archaeological
literature that they were (Towner and Dean 1996: 4; Wilcox 1981:220;

but see Hodge 1895:253). Although later Spanish accounts appear to be
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quite clear about the presence of Navajo groups (often specifically so
named) in the Chama River drainage in the mid-1600s (Schaafsma
2002:237-241; Reeve 1956:295), the archaeological evidence of Navajo
occupation of the Piedra Lumbre area is inconclusive at best, and most
archaeologists believe the “Piedra Lumbre phase” (Schaafsma 1979) to be
the remains of Tewa sheep-herding camps, rather than of Navajo
homesteads (Carillo 1992:323-325, Kemerer 1992:101-102; Wozniak
1992a:329; Wozniak 1992b:4-5).

The Early Entry-Mountain Route model, while devoid of historic
documentation, rests on a firmer archaeological and oral historical
foundation. Navajo sacred geography and oral history is firmly centered
in the northwest corner of New Mexico (Hester 1962:85; Matthews 1994;
Klah 1942; O’'Bryan 1956; Fishler 1953), and the earliest unambiguous
archaeological evidence of Navajo occupation occurs in the San Juan
region during the Dinétah phase, c. 1500-1650 (Gerow and Hogan
2000:12; Brown1996:57). At this time the people were manufacturing
Dinétah Gray pottery, using grooved shaft abraders, and constructing
earth-covered, forked-pole hogans in shallow excavated pits—all traits
which would carry on into the later Gobernador phase (1650-1775, see
Brown 1996:57) of the Navajo occupation. Structure and community
layouts were already formalized, and again correspond with those known

from later, definitively Navajo sites (Brown 1996:62-63).
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Early Historic Accounts

The Navajo first incontrovertibly appear in Spanish records in Fray
Zarate de Salmeron’s 1626 reference to the “Apache de Nabaju” (Hester
1962:21), which suggests that they were engaged in agriculture along the
Chama River drainage. From this period on, Spanish historic records
provide the best—although at times sporadic and ambiguous—indication
of the sweep of events affecting the Navajo during the next two centuries.

Although Zarate Salmeron’s observations are the first
contemporary mention of the Navajo, it is likely not the first interaction
between the Spaniards and their Navajo neighbors. Robert Roessel
(1983:54), citing an unnamed Spanish chronicler, indicates that the
Navajo may have caused the AD1610 abandonment of the New Mexican

capital of San Gabriel, established 11 years previous:

San Gabriel was for some years the provincial capital, later,
perhaps because...it was then the open border of the Navajo
Apaches, it was abandoned and moved to where it now stands with

the name Santa Fe. (Author’s translation)

Internal evidence in this quote, however, suggests that this
account was written some time after the actual abandonment, although
given the absence of Roessel’s specification of his source, it is impossible

to know how many years later.
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It was likely during the period 1630-1680 that the Navajo first
acquired the horse (Hester 1962:21). The additional range of travel
permitted by this adoption likely contributed to their greater contact—
and at times conflict—with the Spaniards.

In 1650, additional horses were turned over to the Navajo by
Puebloan leaders, in anticipation of a planned revolt. The plot was
discovered before it could be consummated, however, and the Puebloan
insurgents were hanged (Hester 1962:21).

During the period between the abortive and the later successful
revolt, the Navajo appear to have alternately raided and traded with the
pueblos (McNitt 1972:11). Raids extended into, as well as originated
from, Navajo territory. Although slavery was illegal in New Mexico, the
law was not enforced, and slavery flourished, with an Apachean
(including Navajo) slave being equal to the value of four oxen, or three to

five horses (Kessell 1979:364; McNitt 1972:12).

The Pueblo Revolt and Its Aftermath

Resentment against the austerity and brutality of Spanish rule
continued to simmer, and in 1680, the Puebloans, spearheaded by the
Tewa and Towa and aided by the Navajo, Colorado River Apache, and
other pueblo tribes, united to drive the Spanish settlers out of New

Mexico. In spite of an abortive attempt at reconquest the year after the
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revolt and two additional brutal campaigns against the pueblos (Preucel
2002:3), the Spaniards remained exiled from New Mexico until don Diego
de Vargas led a return expedition in 1692 (Hester 1962:22). The
resulting twelve-year hiatus also results in a gap in the Spanish
historical records for the area. At the time de Vargas returned, he found
many of the people of Jemez living in the mountains, ostensibly for
protection from the Navajo (McNitt 1972:19), suggesting that the anti-
Spanish alliance was short-lived after the expulsion of the Spaniards.
Schaafsma, however, suggests that the alliance was still in effect, since
Don Luis Picuri, an indigenous Puebloan leader, met first with the
Navajo before journeying to Santa Fe to meet with de Vargas (2002:260).
The Puebloans were still resistant to Spanish domination, and
many fled to the mountains or to distant pueblos less subject to Spanish
reprisals. It is during this four-year period from 1692-1696, that
numerous Puebloan refugees have long been believed by historians and
archaeologists to have fled to live among the Navajo (but see Hogan 1991;
Towner 1997:400-401) The years 1693-1694 saw conflict between the
advancing Spaniards and the Puebloans, who found allies among the
Colorado River Apache and the Navajo. By 1695, most of the Rio Grande
pueblos were again under Spanish control, although Acoma, Zuni, Hopi,
and the Athapaskan groups remained unconquered (Hester 1962:22).
The last abortive attempt to throw off the Spanish yoke occurred in 1696,

as the Navajo, Keres, Tewa, and Towa conspired to eliminate the Spanish

www.manaraa.com



21

colonists. Naranjo, an Indian of Santa Clara, informed Diego Xenome
(Dieguillo), the cacique of Nambe, that the “Apaches...had agreed to
advise them what they decided and determine about what they must do
and carry out” (Schaafsma 2002:282). The primary goal of the Navajo
involvement in the second revolt may have been the acquisition of
additional horses (Schaafsma 2002:282-283).

In spite of the failure of the attempted 1696 revolt, the Navajo
continued their depredations against Spanish interests (Schaafsma
2002:297). In 1704, the Navajo, Utes, and Tewa planned attacks against
the Spanish, but the Navajo were roundly defeated northwest of Abiquiu
(Hester 1962:22). As a consequence of this, and stock raids against
Tewa pueblos (Hester 1962:22, McNitt 1972:19), in 1705 Roque de
Madrid led a punitive expedition against the Navajo living in Dinétah. In
his journal of the expedition, Madrid records encountering two women—
one Navajo, the other from Jemez but married to a Navajo, whom he
tortured to death (Hendricks and Wilson 1996:20). This reference has
been construed as additional evidence of a significant Jemez presence
among the Navajo, although it reflects the fate of only one unfortunate
transplanted Puebloan.

Additional punitive expeditions were mounted against the Navajo
by the Spaniards in the period 1708-1716 (Hester 1962:22), including six
more under the captaincy of Roque de Madrid in 1709 (Hendricks and

Wilson 1996). It was evidence given by Spaniards involved in the
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reprisals that provided the material for the Rabal Document (Hill 1940),
which covered various Spanish encounters with the Navajo in the period
1706-1743. The witnesses to the Rabal document make repeated
reference to the Navajo trading baskets, buckskin, and woolen fabric
with the Spanish settlers and Pueblo villages (Hill 1940:400-413).
During this period raiding, primarily for livestock, may also have been a
significant part of the Navajo economy (Hester 1962:27) By 1720 the
Navajo and the Spaniards established an uneasy truce which endured

until the 1770s (Hester 1962:22).

Spanish Peace, Ute Tensions

The Spaniards were not the only ones with whom the Navajo had
to contend. Shortly after 1709, the Navajo began to come under
increasing pressure from the Ute and Comanche in the north, an alliance
that lasted until the 1750s (McNitt 1972:23). Ute and Comanche
incursions may have had considerable impact on the Navajo-Spanish
peace during this period, with the Navajo unwilling to engage a war on
two fronts (McNitt 1972:23).

By 1744, the Franciscan Friars estimated the Navajo population at
between four and five thousand (Roessel 1983:59). It was in October of
that year that the Rabal Document was deposed before Sargent Major

Don Joachin Codallos y Rabal for the Viceroy of New Spain (Hill
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1940:395). In 1748, a large number of Navajo moved south to the
Cebolleta region, and the following year they requested Spanish
protection against the Ute (Reeve 1959:24). Three years later Ute
aggressions again forced the Navajo southward and westward, and by
1753-1754, numerous Navajo had taken refuge in the Canyon de Chelly
area, west of Dinétah (Fall 1981:35; Hester 1962:23, James 1976:14).
Issuance of Spanish land grants in the Dinétah region between 1753 and
1772 were also a contributing factor in the Navajo westward migration
(McNitt 1972:29). This period of exodus, combined with ceramic
changes, mark the transition from the Gobernador archaeological phase

to the subsequent Cabezon phase (Brown 1996:56).

The latter half of the century was marked by a series of shifting
alliances. In 1772, the Navajo formed an alliance with other Apachean
groups against the Comanche (McNitt 1972:29). In 1785, the Spanish
governor Jan Bautista de Anza broke the alliance by offering the Navajo a
bounty, and forbidding trading between the Navajo and Apache. The
following year the Navajo met with de Anza to form an alliance against
the Apache. Two Comanches were present and threatened the Navajo
with “extermination” if they did not carry through. De Anza responded
with a promise to protect the Navajo from the Ute and Comanche in

exchange for Navajo cooperation (McNitt 1972:29-32).
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Six years later, in 1792, the Navajo and Ute joined forces against
the Comanche, and in 1796 the Navajo arranged a truce with the
Apache, which lasted eleven years (McNitt 1972:35).

With threat of incursion by other Native American groups reduced,
in 1796 the Navajo again began raiding Spanish settlements. These
raids, however, did little to curb Spanish expansion, and 30 new land
grants were issued to Spanish settlers in the Cebolleta region at the turn
of the eighteenth century. Although the Navajo petitioned the Spanish
governor at Santa Fe for return of their lands, and when refused attacked
and forced the abandonment of the Cebolleta settlement, their efforts
failed to stem the Spanish advance. The Spaniards retaliated in 1805,
massacring 115 Navajos in Canyon de Chelly, which forced the
establishment of a lasting peace between the Spaniards and the Navajo
(McNitt 1972:37-45) that continued until the Spanish crown lost control

of the region sixteen years later.
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3 A Brief History of the Pueblo Revolt

The Entrada

The history of the Navajo people is not the only history with
bearing on the question of the cultural affiliation of the pueblito
complexes. The history of Puebloan groups, with particular reference to
the period of the Pueblo Revolt, is also intimately tied to the issue. As a
consequence, a brief overview of the historical events of the period
follows, with particular emphasis on the roles of and effects upon Towa
and northern Tewa groups, as these have been determined to have been
the most likely source for a postulated influx of refugees among the
Navajo (Barrett 2002:91-114; Hogan 1991:21; Reed and Reed 1992:102).

The first direct contact between the Spaniards and Puebloan
groups occurred with Coronado’s 1540 reconnaissance mission to the
Rio Grande and western Plains, but it was another 48 years before Juan
de Onate arrived at the head of the first group of colonists (Espinoza
1988:4-5.) By 1680, however, the Spanish colonists and missionaries—
though never numerous—had had a profound impact on the population
and culture of Rio Grande pueblos (Barrett 2002:67-80; Espinoza
1988:4-32:). Several abortive attempts had been made by individual

pueblo groups to free themselves from Spanish oppression, but each of
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these had been swiftly and ruthlessly crushed (Elliott 2002:46; Espinosa

1988:30; Haskell 1975:55; Wozniak 1992:10).

The Revolt

By the summer of 1680, however, resentment simmered in the
southwestern heat, and prominent leaders from several of the eastern
pueblos had concluded that a concerted, united effort was necessary if
the pueblos were to be free of Spanish dominion. Plans were made and
couriers sent out to the respective pueblos, each bearing a knotted cord.
One knot of the cord was to be untied each day, until the last knot was
untied the day of the rebellion: August 11th (Espinosa 1988:34: Sando
1992:63). Before the plans could be put into effect, however, two of the
couriers were captured, and the plans were revealed just two days before
the revolt was to start. Fearing that the revolt could be thwarted
altogether if the Spaniards were given time to prepare, the decision was
made to begin the revolt effective immediately and hostilities erupted
August 10t (Espinosa 1988:34; Preucel 2002:3; Sando 1992:65). By the
time the conflict ended, more than 400 Spanish missionaries and
colonists were dead, and the roughly 2500 survivors, joined by Piro
Indians who had supported the revolt, fled south to El Paso (Barrett

2002:91; Terrell 1973:297, 303).
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The Spaniards were determined not to be vanquished, and in
November of the following year, Antonio de Otermin returned at the head
of 300 men to attempt to retake the area (Kessell 1979:240; Terrell
1973:305). Most of the pueblo villages were found abandoned (Kessell
1979:240; Terrell 1973:306). Sandia Pueblo, one of the few still
occupied, (Figure 3.1 for pueblo locations) was set ablaze, and its
inhabitants were forced to flee to Hopi, where they remained for the next
six decades at the village of Hano (Sando 1992:65-67). The harsh
weather, absence of Puebloan stores to be plundered for supplies, and
Puebloan resistance forced Otermin’s retreat to El Paso in January of
1682 (Terrell 1973:307-309).

In 1693, without returning again to New Mexico, Otermin resigned
(Terrell 1973:309). Prior to Otermin’s resignation, in 1688, his ultimate
replacement, Pedro Reneros de Posada ventured into New Mexico and
attacked and destroyed several villages, including Santa Ana (Espinoza
1988:37; Sando 1992:67). The following year, Domingo Jironza Petris
Cruzate led an expedition of approximately 130 men back to New Mexico,
and burned the pueblo of Zia, killing several hundred Indians, with the
survivors fleeing to a location west of present-day Jemez Pueblo (Sando
1992:67; Terrell 1973:312), while Cruzate and his men returned again to

El Paso.
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The Reconquest

In 1691, Cruzate was replaced by don Diego José de Vargas Zapata
Lujan Ponce de Leon y Contreras, whose determination to recapture the
province of New Mexico was spurred on by Spanish concerns regarding
French victories in the Mississippi area and potential French expansion
westward (Kessell 1979:243; Terrell 1973:313, 319). Consequently,
Vargas set out from El Paso in August of 1692 with a force of 200,
comprised predominantly of Indian auxiliaries, but they found the
pueblos largely deserted. He reached Santa Fe in mid-September of the
same year, and the town quickly surrendered. There he was informed
that the inhabitants of Pecos and Taos had fled to the mountains (Kessell
1979:267; Terrell 1973:323). After a brief expedition to deserted Pecos,
Vargas returned to Santa Fe (Terrell 1973:323). Vargas’s next foray was
to the newly-established Keres pueblo located near burned Zia (Terrell
1973:323). Likely mindful of the recent fate of Zia, the inhabitants
bowed to Vargas’s demands of obeisance to the Spanish King and the
Christian God. They were followed in quick succession by the
inhabitants of Santa Ana, Jemez, Sandia, San Felipe, Santo Domingo,
Cochiti, San Ildefonso, Pojoaque, and San Juan (Terrell 1973:323).
Vargas next ventured north to Taos and received the allegiance of the
people there. From thence he traveled on to Acoma and Zuni (Terrell

1973:323-325). Vargas made no attempt to negotiate with the Navajo,
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but he continued on to Hopi where he was faced with the task of
dissuading the Hopi from believing stories of Spanish atrocities
promulgated by the Navajo (Terrell 1973:325-326). Having achieved the
“reconquest” of New Mexico without bloodshed, Vargas and his men
returned to El Paso in late December of 1692.

The following October Vargas again set out for New Mexico, this
time accompanied by some 100 soldiers and their families, 18 padres, 80
families of settlers, and a motley assortment of convicted thieves,
swindlers, lawyers, shopkeepers, masons and carpenters, totaling some
800 people (Terrell 1973:329). In spite of only a year having passed since
his “reconquest,” Vargas found that only Pecos and the Keres pueblos of
Santa Ana, Zia, and San Felipe were willing to ally themselves with the
Spaniards (Espinoza 1988:41; Terrell 1973:330). The governor of Pecos
warned Vargas that the Tewa, Tano, Picuris, Towa, Hopi, and the pueblos
of Acoma and Taos were prepared to do battle (Espinoza 1988:41).

Vargas camped outside the walls of Santa Fe for two weeks, before
a pitched battle erupted on the 30t of December (Espinoza 1988:42;
Terrell 1973:332). Soon afterward the Jemez, Santo Domingo, Keres,
Tano, and Tewa retreated to the mesa tops, while the Picuris and Taos,
more distant from the fighting, remained in their pueblos (Espinoza
1988:44).

In late February of 1694, Vargas set out for Black Mesa, a volcanic

extrusion located north of San Ildefonso Pueblo, but he was immediately
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bogged down by heavy snowfall (Barrett 2002:87; Hendricks
2002:184,186). Vargas laid siege to the mesa, which was held by some
one thousand defenders from a variety of Tewa and Tano (southern Tewa)
pueblos, for more than two weeks, at which point he lifted the siege,
returning to Santa Fe (Espinoza 1988:44; Hendricks 2002:186-188).

Soon thereafter Roque de Madrid, under orders from Vargas, led
some 190 Spanish and Keres warriors to Horn Mesa (Potrero Viejo) about
11 kilometers northwest of Cochiti, where members of Cochiti and San
Marcos pueblos had taken refuge at the pueblo of Kotyiti (Hendricks
2002:188-189). A three-pronged attack on the mesa on 17 April 1694
quickly overwhelmed the defenses and 8 warriors were killed and 355
prisoners taken (Hendricks 2002:190).

Vargas’s attention turned next to the Jemez redoubt of Astialakwa
on Guadalupe Mesa, arriving there at the end of July, and attacking with
a force of some 190 soldiers and Indian auxiliaries from San Felipe,
Santa Ana, and Zia. There he faced opposition from approximately 430
defenders from the Towa pueblos, and their allies from Acoma, Zuni,
Hopi, Cochiti, and the Navajo province (Barrett 2002:98; Hendricks
2002:190-191).

Vargas stormed the mesa on 24 July killing 84 and capturing 361,
among whom were an Apache and a war captain from Santo Domingo
(Hendricks 2002:191-192; Sando 1992:72). The prisoners were taken to

Santa Fe, and when Towa leaders approached Vargas to appeal for their
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release, they were told that the prisoners would be freed provided the
Towa participated in Vargas’s planned second attack on Black Mesa, and
then be returned to their pueblo at Patokwa (Sando 1992:72). With this
demand acceded to, Vargas and his augmented forces laid siege to Black
Mesa on the 4t of September of 1694 (Hendricks 2002:192).

By this time Black Mesa served as a refuge for members of seven
Tewa pueblos (Tesuque, Cuyamunge, Nambe, Pojoaque, Jacona, San
[ldefonso, and Santa Clara), as well as refugees from two Tano (southern
Tewa) pueblos, San Lazaro and San Cristobal. By this time the mesa may
have served as a refuge for some 2000 people, including several hundred
warriors (Hendricks 2002:192). In spite of their overwhelming numbers,
however, the mesa surrendered on the eighth of September (Espinoza
1988:46). Soon afterwards the Puebloans at Embudo also sued for peace
(Barrett 2002:110).

The following year the Spaniards continued their policy of
reduction (concentration of Indians in a few key villages to facilitate
military control and religious indoctrination). The Towa were induced to
come down from the mountains to resettle the pueblo at Walatowa
(present-day Jemez) (Dodge 1982:22; Sando 1992:74). The Cochiti (and
possibly the San Marcans) returned to Cochiti, and the Santo Domingans
to their pueblo, although some appear to have remained on San Juan
Mesa with a remnant of Towa groups (Barrett 2002:102-103). The Tanos

of San Lazaro and San Cristobal initially returned to their own pueblos,
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but were soon ousted by Vargas in favor of Spanish colonists, and were
ordered to move to Chimay6 in the Santa Cruz valley. They objected and
apparently fled to the sierra, where they likely took part in the instigation
of the 1696 rebellion (Barrett 2002:104-106). The Tewa survivors of
Black Mesa gradually returned to their pueblos, as did the Tewa from
San Juan, Tesuque and Nambe who had taken refuge at Embudo, in
company with some Tanos from San Lazaro and San Cristobal (Barrett
2002:109). The people of Taos and Picuris, who had fled to nearby
mountains when Vargas had moved northward, likewise returned to their
own pueblos (Barrett 2002:112).

This year of relative peace permitted the Puebloans to regroup and
resupply. The winter of 1695-1696 was particularly harsh, and by
spring the Puebloans determined that the Spanish settlers were in
sufficiently dire straits that the Indians might again be successful in
driving them out of New Mexico (Barrett 2002:88-89; Espinoza 1988:47).
Accordingly, on the fourth of June of 1696 another revolt was launched,
with Pecos, San Felipe, Santa Ana, and Zia remaining loyal to the
Spaniards, this time joined by the Tewa pueblo of Tesuque (Espinoza
1988:50). Tesuque, perhaps wary of its geographical position and
proximity to Santa Fe and Spanish reprisals, warned the Spanish of the
impending uprising, and participated in campaigns against Puebloan

rebel groups (Barrett 1998:110).
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The Puebloans again retreated to the mountains and mesa tops
with Cochiti on Horn Mesa and the Tewa of Nambe, Cuyamunge,
Pojoaque and Jacona joining the Tano in the mountains north of
Chimayo6 (Barrett 2002:110; Espinoza 1988:51). San Ildefonsans and
Santa Clarans retreated to the mountains. The Towa (with the exception
of Pecos, which had remained loyal to the Spaniards throughout)
retreated again to their mesa tops, where they were joined by allies from
Acoma, Zuni, Hopi, Cochiti, and the Navajo (Barrett 2002:98; Sando
1992:74). The Towa may have also occupied numerous small sites in the
Jemez mountains (Elliott 2002:48). The Zia and Santa Ana fled to a
mesa-top site on Cerro Colorado (Barrett 2002:95).

The revolt of 1696 was short-lived and ended with a battle at El
Embudo on the 23 of July. Significant contributing factors included a
severe drought, which reduced Rio Grande tributaries to a mere trickle,
making access to water difficult for besieged defenders on the mesas
(Barrett 2002:90). The drought also affected crops, a situation
exacerbated by Vargas adoption of a policy of the destruction of fields of
rebel groups, creating a severe shortage of food (Barrett 2002:89). With
the end of the second revolt, the final major population dislocations to

affect the Rio Grande area began.
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Population Movements

After the defeat of the Towa near Patokwa and Walatowa at the end
of June, both of these pueblos were abandoned, and indeed the entire
Jemez region appears to have been virtually vacated for a time (Barrett
2002:98-99). Some retreated to Acoma, others to Zuni and Hopi (Barrett
2002:99). Joe S. Sando (1992:75), a historian from Jemez, notes that

while some Jemez went to Hopi:

Some of the Jemez returned to their ancestral homeland in the
northwest, in Canyon Largo and Stone Canyon (Gy’a-wahmu).
Others went to An-yu-kwi-nu (Lion Standing Place), to the west of
Jemez in the Navajo country. These people lived among the

Navajos for a considerable number of years.

By 1706, however, three hundred Towa had returned to Walatowa,
and more were trickling in, although what percentage of the total
population this represented is unclear (Barrett 2002:99).

Acoma served as a refuge for several groups. Vargas was evidently
aware of this, as he led an expedition there in August of 1696, after the
end of the revolt (Barrett 2002:100), perhaps to forestall further
rebellion. At that time, in addition to Acomans, the “sky city” hosted
Towa, Keres from Santo Domingo, Cochiti, La Cieneguilla, and San

Marcos, Tanos, and Santa Clarans, although some of these groups soon
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moved on to Zuni. Some discord apparently resulted from this polyglot
group living in close quarters, for by the following year a new settlement,
La Laguna, was established by the Towa, Keres, and some Acomans
(Barrett 2002:100).

Although some Keres participated in the founding of La Laguna,
others remained in the Santo Domingo Basin, returning to repopulate
two of the original pueblos: Cochiti and Santo Domingo (Barrett
2002:103).

Many Tano migrated westward to Acoma, Zuni, and Hopi. Some
were reported headed into the mountains to the west of Santa Clara
(Barrett 2002:106). Others joined some Tewa and the people of Picuris in
an eastward flight toward the Great Plains (Barrett 2002:106). This
exodus was intercepted, however, by Vargas, who took numerous
prisoners, although others continued on to Cuartalejo in western Kansas
(Barrett 2002: 106; Sando 1992:75).

The remnant of the Tanos from San Lazaro and San Cristobal
could not be returned to their pueblos, which had been taken over by
Spanish colonists. Instead, Vargas resettled them at Galisteo, an
experiment which proved short-lived, and they soon migrated to Hopi. It
was these refugees who formed the Tewa community of Hano, still extant
on First Mesa at Hopi (Barrett 2002:106; Dozier 1996:3).

The Tewa of Nambe, Cuyamunge, Pojoaque, and Jacona initially

joined the Tano in the mountains near Chimayo, but were pursued
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unsuccessfully by Vargas. A prisoner from Cuyamunge reported that his
people, with a few from Nambe, had fled to Taos. The majority of the
people of Nambe remained in the Sierra de Chimayo, while those from
Jacona “left to join the Navajo” (Barrett 2002:110). The people of
Pojoaque, likewise, had left, but the prisoner did not specify their
destination (Barrett 2002:110).

The Tewa of San Ildefonso, as with those of Santa Clara, had fled
to the mountains west of their pueblos, although in August of 1696 some
were reportedly with the Hopi, and others with the Navajo (Barrett
2002:110-111). “The Navajos mentioned may have been the band living
in the area called Los Pedernales, possibly the one to which the people of
Jacona had also retreated.” (Barrett 2002:111). Although the precise
location of Los Pedernales is unknown, it may be located in the vicinity of
Cerro Pedernal (Pedernal Peak), south or west of the Rio Chama, near
Abiquiu (Barrett 2002:111; Schaafsma 2002:292). However, due to
continued pressure from Vargas, the Santa Clarans (and perhaps the
Jaconans) abandoned this area and by the fall attempted to join the
Tanos and Picuris in their flight to the plains (Barrett 2002:111). The
people of San Juan returned to Embudo, where they had taken refuge
during the revolt, although a few of them fled north to Taos. However,
Vargas’ expedition to Taos led the Tewa there to join the eastward exodus
to the Great Plains (Barrett 2002:111). Some were successful in reaching

Cuartalejo, but others were intercepted by Vargas, and further scattered
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among Acoma, Zuni, Hopi, the Apaches in the Embudo area and the
Navajo of the Sierra de Pedernales (Barrett 2002:111). By November
twenty-nine people had returned to Jacona, but they soon moved on to
other Tewa pueblos, while many of the people of Cuyamunge moved to
Tesuque (Barrett 2002:111).

The Tiwa pueblo of Taos was temporarily abandoned when Vargas
mounted an expedition north in the early fall of 1696, in a continued
attempt to assert Spanish dominance, but the residents soon returned
from the nearby mountains to repopulate the pueblo (Barrett 2002:113).
Many of the Picuris were among those who fled to the Plains, and in the
early winter of 1696 only eight families remained at the pueblo. Their
numbers were augmented ten years later, when an expedition was
mounted by the Spanish to Cuartalejo, and many of the Puebloans living
there were returned to their pueblos (Barrett 2002:113).

By the end of the seventeenth century, most of the major
population movements in the Rio Grande area had already occurred,
although in some cases refugees, such as the Towa and Picuris,
continued to return in small numbers to their pueblos through the first
half of the eighteenth century.

Thus, although considerable population dislocations did occur
during the course of the Pueblo Revolt and its aftermath, it appears from
contemporary Spanish historical records that the majority of the pueblos

affected either stayed in the Rio Grande area, or fled to the Western
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Pueblos of Zuni and Hopi. There is very little evidence for Puebloan
immigration to the Navajos (see also Chapter 10 for an examination of

oral history in this regard).
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4 Overview of Pueblito Studies

Early Work

The existence of pueblito structures was first brought to the
attention of archaeologists by Victor Mindeleff, who visited Kinnazinde
(Kin Naazini—Lone Towering House) in 1883. Mindeleff, however,
interpreted the structure as a field house of nearby Kin Tiel, a Chacoan
outlier (Gilpin 1996:179, Mindeleff 1891:92-93). Although seven years
later Victor’s brother, Cosmos, dedicated an extensive article to Navajo
architecture (Mindeleff 1898), no reference to pueblitos was made.

It was not until early in the second decade of the twentieth century
that additional archaeological consideration was given to pueblito sites.
In 1912, the noted archaeologist Alfred V. Kidder visited what would later
come to be known as Three Corn Ruin (LA1871), Old Fort Ruin (LA1869)
and another, unidentified pueblito (Powers and Johnson 1987:5). He
was followed in quick succession by Earl Morris in 1915, and Nels
Nelson, who in Kidder’s words, “incidentally traversed” the region in
1916 (Kidder 1920:329).

Although Kidder first presented his findings in a brief report at the
general meeting of the Archaeological Institute at the close of 1912
(Kidder 1913), it was Kidder’s (1920) seven-page exposition “Ruins of the

Historic Period in the Upper San Juan Valley” which appeared in
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American Anthropologist eight years later that shaped archaeological and
historic interpretations of the pueblitos and the entire protohistoric
period of the area for another seventy years. Kidder’s interpretation was
influenced by the statement by Adolf Bandelier (1892:216) regarding

Southwestern history to the effect that:

[In Junel696] the last important insurrection of the Pueblos broke
out...A fierce conflict took place,...in which the Jemez and their
allies were routed. This defeat broke up the confederacy with
Acoma and Zuni, and caused the Jemez to flee to the Navajo
country...For several years the Jemez remained among the
Navajos, until they finally returned to their old range, establishing

themselves at or near the site of their present village.

Kidder speculated that the pueblito structures might represent
structures built by the refugees from Jemez, and proposed that his
hypothesis be tested via ceramic analysis of pottery from the pueblito
sites and comparison with contemporary ceramics from abandoned
Jemez villages (Hogan 1991:1; Kidder 1920:328). Such a comparison,
however, was never made.

As early as 1932, Kidder’s “refugee hypothesis” was being cited not
as a hypothesis, but as fact. Hogan notes that, “Kidder’s suggestion that
the Gobernador sites might have been built by the Jemez refugees
became an assumption that the sites were built by refuges from several

Rio Grande pueblos” (Hogan 1991:3; emphasis in original).
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The results of Earl Morris’s extensive excavation and survey at
pueblito sites, which might have helped cast light on the issue, were not
published until half a century after they took place. In the interim,
Pueblito research, though sporadic, did not languish.

In the latter part of the 1920s, Stanley Stubbs was dispatched by
the School of American Research to explore Blanco, La Jara, Frances and
Gobernador Canyons, where he noted the presence of house ruins
located high on boulders and mesas (Roessel 1983:9). In 1934 C.O.
Erwin and M.W. Kelly surveyed portions of Frances and Gobernador
Canyons, where numerous pueblitos are located (Carlson 1965:1), and in
1937, Elizabeth Murphy of the School of American Research undertook
the excavation of a tower pueblito, the results of which, unfortunately,
were not published (Keur 1941:44). Harry P. Mera surveyed of the Largo
area in 1938, and he took several tree-ring samples for dating. He also
noted the presence of a new type of pottery at the sites—later to be called
Gobernador Polychrome—and attributed its appearance to the influence
of an influx of Pueblo potters to the region, in keeping with the “refugee

hypothesis” already in vogue (Mera 1938:237).

The Florescence of Navajo Archaeology

In 1941, Dorothy L. Keur published the first monograph on Navajo

archaeology based on her 1939 research on Big Bead Mesa on the
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southern fringes of Dinétah. Although Big Bead Mesa is not noted for
the presence of pueblitos, it does feature a massive 3.7 meter high
masonry wall extending for a distance of some 8 meters, which cut off
the northern spur of the mesa from the remainder of the mesa top. Her
interpretation of this wall as a defensive structure was strengthened by
the presence of boulders strategically placed above access routes to the
mesa, where they could be rolled down upon approaching attackers, and
other defensive measures (Keur 1941:40-43). Keur’s work is also
significant for the magnitude of the undertaking, which included the
excavation of 95 hogans as well as numerous lean-tos, sweatlodges, and
caches (Keur 1941:69) making it by far the most ambitious examination
of Navajo archaeology until that time. In 1957, Lee H. Marmon and
George C. Pearl returned to Big Bead Mesa to further examine the
fortifications there (Marmon and Pearl 1958).

The year 1941 also saw a visit to Tapacito Ruin (LA2298) by
Edward T. Hall, Jr., and W.S. Stallings in order to obtain
dendrochronological samples. The results of their expedition remained
unpublished until 1974, when they were combined with work by John
Wilson and Helene Warren (Wilson and Warren 1974:8, 10).

Malcolm Farmer authored a 1942 article in American Antiquity
based on a 1938 survey of some 250 square miles of the Dinétah area
(Farmer 1942:67), and appears to be the only archaeologist of the time to

swim against the tide. Citing a 1788 letter from Ugarte y Loyola which
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referred to the Navajo construction of “ten rock towers within their
encampment,” Farmer (1942:70) suggested that perhaps the Navajo had
“taken over” what he termed the “tower-building complex” (Figure 4.1).
He also emphasized that the “complex” was previously widespread over
areas of Utah, Colorado, and New Mexico (Farmer 1942:70). Farmer,
however, leaves somewhat open the question of whether or not the tower-
building complex was adopted from Pueblo refugees at the time of the
Spanish re-conquest, or if it was an adaptation of earlier Anasazi sites in

the area (Farmer 1942: 70).

Figure 4.1 Frances Canyon Pueblito.
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Three years after the publication of the Big Bead Mesa excavation
report, Dorothy Keur published a brief article in American Antiquity
summarizing the results of a 1940 survey of approximately 50 sites in
the Upper San Juan drainage. Two pueblitos and 19 hogans were
excavated during the course of that project (Keur 1944:84-85). In
keeping with Kidder’s refugee hypothesis, Keur concluded that the
pueblitos represented “a rather concentrated and fairly brief Pueblo
overlay on a Navajo pattern” (1944:86) in a “refuge area” (1944:85). In
1940, Deric O’Bryan returned to some of the sites investigated by Keur to
collect tree-ring samples (Carlson 1965:1)

The 1950s witnessed an explosion of research into Navajo
archaeology spearheaded by the Navajo Land Claim (NLC) project, which
still remains the largest single exploration of Navajo prehistory to date.
The NLC survey was the first systematic survey of Navajo sites over a
considerable range of territory (Towner and Dean 1996:8) and covered 35
million acres, resulting in the recording of some 2300 sites and the
collection of 3647 tree-ring samples (Roessel 1983:31), including those
from numerous pueblitos. Unfortunately, much of the information
gleaned by the NLC project remains inaccessible to the archaeological
community due to legal restrictions (Towner and Dean 1996:8).

One product of the vast scale of the NLC survey was the
determination that pueblito construction was not a phenomenon limited

to the confines of Dinétah (Gilpin 1996:181-182) but that pueblitos
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could be found as far west as Black Mesa in Arizona (Towner 1996:164).
The westerly pueblitos all date to the post-1750 period, suggesting the
continuation of a defensive strategy as the Navajo encountered potential
hostility from their new neighbors, the Hopi, as well as continuing
conflict with the Ute (Towner 1996:166).

The expansion of oil and gas exploitation in New Mexico in the
1950s proved both a boon and a bane to Navajo archaeology. The
construction of access roads to pipelines and well-heads made it possible
for such groups as the San Juan Archaeological Society to visit and
record many of the newly-accessible pueblitos (Powers and Johnson
1987:6). This same accessibility has greatly accelerated the loss of
information and structures to casual visitors as well as to vandalism

(Powers and Johnson 1987:135).

The late 1950s saw another large-scale survey and mitigation
project connected with the construction of the Navajo Reservoir,
including the excavation of both hogan and masonry-walled sites (Hester
and Shiner 1963). It also led to the definition of a pre-Revolt, pre-
pueblito Navajo occupation of the area, termed the Dinétah phase (Dittert
et al. 1961). The definition of this phase, however, rested on the absence
of traits such as pueblitos and Gobernador Polychrome ceramics, rather
than on their presence (Brown 1996:51; Schaafsma 1996:25; Towner and
Dean 1996:9), and it was not for another two decades that additional

research supported the validity of the Dinétah phase.
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The Navajo Reservoir project also served as the basis for James
Hester’s doctoral dissertation (Roessel 1983:23). Hester used these data
to define a series of Navajo archaeological phases. He deemed the1690s
a critical period in the establishment of the Gobernador phase and its

successors, indicating that:

After 1700, the period of intense acculturation began to draw to a
close...In the space of a few years the Navajo adopted the Puebloan
styles of architecture, manufacturing techniques, and religious
paraphernalia, plus many elements of non-material culture such
as clans, matrilineal descent, matrilocal residence, origin myth and

ritual. (Hester 1962:91)

In spite of the extremely short temporal window this left for such
radical cultural changes (a period of approximately eight years between
1692 and 1700), Hester clearly considered all of these aspects of Navajo

culture to be directly attributable to the influence of Puebloan refugees.

R. Gwinn Vivian (1960) examined Navajo sites on Chacra Mesa,
including several pueblitos, and enumerated the architectural and
artifactual traits he encountered (Vivian 1960, cited in Roessel 1983:21).
Vivian also took several tree-ring samples from both hogans and

pueblitos (Towner 1996b:161).

In 1962, Roy Carlson returned to the sites examined by Earl
Morris in 1915. Combining Morris’s field notes with his own

observations, Carlson (1965) produced the first monograph dedicated to
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pueblitos. Carlson, however, appears torn between the weight of the
archaeological evidence that he himself presents and the force of forty

years of archaeological writing on the subject. He notes:

The problem encountered in accepting Kidder’s hypothesis
completely is that data now available, particularly tree-ring dates
and ceramic associations, indicate that the large masonry sites
were not built and occupied until some 20 years after the revolt of
1696. This information does not invalidate Kidder’s
interpretation...but simply indicates that we must look elsewhere
for a slightly earlier occupation by a mixed Pueblo and Navajo

group. (Carlson 1965:98)

Carlson maintained this position in spite of observing the
“decidedly non-Puebloan” layouts of the pueblito communities, the
absence of kivas on the sites, and the lack of Puebloan oral traditions
regarding the return of refugees from the Navajo country (Carlson
1965:103-104), in addition to the chronological discrepancy noted above.
A valuable contribution of Carlson’s work—in addition to providing
information now lost to vandals or to time—was his suggestion that, in
view of the early-to-mid eighteenth century tree-ring dates for the
pueblito sites, the pueblitos may have been constructed as a defense
against Ute and Comanche raiding (Carlson 1965:100). This was the first
intimation that the pueblitos may be indicative of inter-tribal aggression,
rather than having been built as protection against the Spaniards with

whom the Navajo enjoyed a tenuous peace during the period 1720-1770.
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David Brugge’s 1968 article, “Pueblo Influence on Navajo
Architecture,” concluded that pueblitos were constructed by Puebloans,
and the surrounding hogans by their Navajo hosts. The article went still
further, to conclude that the hogans themselves provided numerous
examples of Puebloan influence in the manner of their construction and

use.

David Stahle (1973) authored a still-unpublished paper on Navajo
tree-ring dates, and re-analyzed many of the dates that suggested
Tapacito Ruin (LA2298) represented the earliest Navajo site to be found
in the Southwest (Stahle 1973, cited in Roessel 1983:26).

Tapacito Ruin was again visited and remapped by John Wilson and
Helene Warren, who collected dendrochronological specimens. The
results of their research were combined with those of Hall and Stallings
from 1941, concluding that the structure dated to 1694—precisely
coinciding with de Vargas’s re-conquest after the Pueblo revolt. In spite
of these dates, however, Wilson and Warren’s article represents the first
serious challenge to the assumption that pueblito structures were built
by Puebloan refugees. They acknowledge the unique nature of Tapacito
Ruin (LA2298) among pueblitos, and note that historical documents
indicate the Navajo were also associated with the building and
occupation of pueblitos. Whereas Kidder proposed that the pueblitos
represented an influx of Puebloan refugees—specifically from Jemez—

Wilson and Warren point out that the destruction of the pueblo of Jemez
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did not take place until 1696—two years after Tapacito Ruin was
constructed. Instead, they proposed that refugees from the Keresan
villages of Zia and Santa Ana, who had already felt the shattering impact
of the Spaniard’s wrath, could have been responsible for the construction
of Tapacito Ruin (Wilson and Warren 1974:20). They also note the
complete absence of Jemez Black-on-white sherds at the site, in contrast
to the ceramic assemblages of numerous other pueblitos, however,
Keresan sherds are present (Wilson and Warren 1974:22). They
conclude that although it is likely that Tapacito may be a genuine
refugee structure, they do not rule out the possibility of it—and the other
pueblitos— being an indigenous Navajo development (Wilson and Warren
1974:24). In spite of their assertions, the refugee hypothesis remained

the dominant pueblito paradigm (Towner 1996b:153)

Between the years 1973 to 1975, the United States Bureau of Land
Management initiated stabilization measures at eight of the more notable
and popular pueblitos. This was in an attempt to mitigate the impact of

increased tourist visitation.

In 1975, J. Loring Haskell (1975) excavated Adolfo Canyon pueblito
(LA 5665) and mapped three more. He also excavated eight pueblito-
associated hogans in an attempt to trace continuities in Navajo social

structure from the Gobernador phase and the ethnographic present.
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Focus on Pueblitos

A ten-year hiatus in pueblito studies followed Haskell’s work, with
the exception of their occasional appearance in oil and gas survey reports
(Powers and Johnson 1987:6). In 1985, Margaret Powers and Byron
Johnson undertook a year-long field research project that involved
visiting 76 pueblito sites, intensively recording 49 of them, and
nominating 48 to the National Register of Historic Places (Powers and
Johnson 1987:6-7). They also discovered several previously-unknown
sites. They classified pueblito sites into five “types,” based on both
architecture and location, in the first attempt to analyze pueblitos as
more than discrete sites. Type One featured rectangular structures with
square corners on wide benches and canyon bottoms that were not easily
defended, Type Two were rectangular structures with rounded corners
built on the edges of mesas, upper benches, or the tops of boulders and
Type Three were similar to Type Two, but with round or irregular
outlines. The last two types cannot properly considered “pueblitos,” but
rather “defensive sites.” Type Four consisted of irregular walls along the
fronts of rock shelters, and Type Five of wall segments strategically
placed to block access to mesa tops. Some of the Type Five walls are
associate with “small, poorly constructed rooms” (Powers and Johnson
1987:125-127,131) Powers and Johnson suggested that these types
represented both an evolution through time and a reflection of the

intensity of Puebloan influence at a given site (Powers and Johnson
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1987:125-126); as well as variation in the level of threat of Spanish
incursions. Development and testing of their hypothesis, however, was
hindered by a paucity of dendrochronological data; only 17 of the 48
nominated sites had been dated, and in some cases the proveniences of
the samples is somewhat unclear (Powers and Johnson 1987:127).
Perhaps the greatest contribution made by Powers and Johnson’s work,
however, is the wealth of data they provide in the form of descriptions
and detailed maps of the structures, the ceramics found on the sites, and

their settings.

The decade of the 1990s witnessed a virtual explosion in pueblito
research. In 1990, Towner and Dean returned to Tapacito Pueblito to
collect more tree-ring data and compared their results to the previous
work done by Hall and Stallings (1941) and later by Wilson and Warren
(1974). They concluded that the pueblito itself was constructed in late
summer or autumn of 1694 (Towner and Dean 1992:322). Such a date
correlates intriguingly with Spanish incursions into the Rio Grande area,
which resulted in the destruction of the Keres pueblo of Old Kotyiti in
April, and of the Jemez pueblo of Astialakwa on 24 July of that year
(Sando 1979:420; Wilson and Warren 1974:18; Elliot 2002:47). Towner
and Dean further conclude that the unprovenienced timbers collected by
Hall and Stallings, which date to June or July of 1690, probably
originated from one or more of the forked-pole hogans at the site. The

hogans, unfortunately, no longer contain any dateable specimens
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(Towner and Dean 1992:321,327). They suggest that a small group of
Puebloan refugees arrived in the Dinétah and joined an established

Navajo settlement at the site (Towner and Dean 1992:327).

A multi-year co-operative project between the Bureau of Land
Management and the Laboratory for Tree Ring Research at the University
of Arizona was undertaken in 1990 to establish a database of tree-ring
dates for the pueblitos (Towner 1992:58). The “Dinétah Dating Project”
resulted in a database of some 808 tree-ring dates (including those
collected by earlier researchers) (Towner 1996b:155); of these, 374 were
cutting dates (Towner 1996b:157.) They established that, with the
exception of Tapacito Ruin, all of the Dinétah pueblitos were constructed
between 1709 and approximately 1760, and most were constructed
between 1720 and 1755, during the “Navajo-Spanish Peace” (Towner

1996b:162-163).

The 1991 publication of the Bureau of Land Management’s
Cultural Resource volume entitled Rethinking Navajo Pueblitos, with
contributions by Patrick Hogan and Michael Marshall, was a critical
contribution to pueblito research. In a brief article, Hogan (1991) argued
forcefully against the refugee hypothesis on the basis of historical
records, indicating the paucity of historical documentation that large

numbers of pueblo refugees sought asylum with the Navajo. He proposed
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instead that the vast majority of Puebloans fled the Rio Grande for Hopi,

Zuni, or other distant pueblos (Hogan 1991).

Marshall’s (1991) more lengthy contribution built upon the
prodigious work by Powers and Johnson (1987). He revisited nine of the
sites they recorded and demonstrated that the pueblitos, rather than
being rather isolated structures, were parts of extensive “site complexes”
consisting of hogans, middens, sweatlodges, hearths, ramadas, rock
shelters, petroglyph panels, and extramural slab-lined boxes, extending

over a roughly half-kilometer square area (Marshall 1991).

Lori and Paul Reed re-examined the assumption that the
production of polychrome pottery among the Navajo resulted from the
influence of and introduction of technology by Puebloan Refugees. They
noted that the advent of Gobernador Polychrome in the archaeological
record appears to pre-date the Pueblo Revolt by at least several decades
(Reed and Reed 1992:99,102). They also indicate that Gobernador
Polychrome represents a combination of techniques and motifs from Hopi
ceramics and Rio Grande glazewares. In either case, they point out the
unlikelihood that Tewa refugees—which the majority are assumed to
have been—with a strong black-on-white ceramic tradition would
suddenly switch to the production of polychrome vessels and teach their
Navajo protéges likewise (Reed and Reed 1992:102). Reed and Reed

(1992:98) also noted that the percentage of Rio Grande Pueblo ceramics
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at 63 pueblito sites is roughly equal to the percentage of western
Puebloan ceramics, in spite of the fact that the postulated refugees would
have been entirely from the eastern pueblos. Despite these observations,
however, they still advocate the Refugee Hypothesis, indicating that the
pre-Revolt existence of Gobernador Polychrome provided evidence of the
strong social ties between the Navajo and Pueblo that encouraged later
Puebloan refugees to seek safe haven amongst the Navajo, which they

might not have otherwise done (Reed and Reed 1992:103).

The “Great Pueblito Flareup” (Jacobson et al. 1992) also took place
in 1992, which tested proposed line-of-sight communications between
pueblitos that would have provided advance warning of enemy approach.
The study’s authors concluded that individual pueblitos were linked in
complex visual communication networks. The longest tested line of sight
(using smoke signals), between Three Corn Pueblito and Cabresto Mesa,
was a distance of some twelve miles (Jacobson et al. 1992:125). They
also noted architectural and location variation between pueblitos that
appeared to be correlated with the number of other pueblitos visible from
a particular site (Jacobson et al. 1992:112-113,124). Jacobsen et al.
(1992:110) also argue cogently that the pueblitos were constructed in
response to Ute hit-and-run attack tactics rather than the more

prolonged siege and scorched-earth practices of the Spaniards.
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In 1995, the Office of Contract Archaeology (OCA) at the University
of New Mexico published the results of the 1992-1993 Pueblito Data
Recovery Project (Marshall 1995) conducted under the auspices of the
Bureau of Land Management. The project examined the ceramic, lithic,
faunal, botanical and historic artifacts from surface collections from
seven pueblito sites, and from excavation of middens at Split Rock Ruin
(LAS664), a hearth near Shaft House (LA71580), and a bell-shaped pit
near Crow Canyon Pueblito (LA 77871). The project attempted to
address issues of chronology, subsistence, and cultural interaction with
other groups. In terms of chronology, Marshall suggests that pueblito
structures were constructed near extant forked-pole hogan communities.
Attempts were also made to correlate obsidian hydration thicknesses
with the dendrochronological dates from the pueblito sites, so that the
information might be applied to other Navajo sites lacking suitable dating
sources. Marshall (1995) also proposed a three-stage ceramic
assemblage sequence, again with the aim of establishing of a sequence
useful in cross-dating non-pueblito Navajo sites in the Dinétah area
(Marshall 1995:206). Attempts were also made to estimate the duration
of occupation of the pueblito sites, based on the volume of midden

accumulated (Marshall 1995:211-212).

The results of the Pueblito Data Recovery Project bore out the
previously-accepted picture of the Gobernador-phase Navajo as a culture

practicing a mixed subsistence strategy combining horticulture,
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pastoralism, and hunting and gathering. Pinyon, maize, and beans were
exploited, as were animals attracted to the cultivated fields (notably deer
and lagomorphs) (Marshall 1995) in what has been termed the “garden

hunting model” (Brown and Brown 1995:190). Churro sheep (Ovis aries)
were eaten, and evidence of the consumption of Equus sp. (horse and/or

burro) was also encountered (Marshall 1995).

Numerous types of European trade goods were recovered from
pueblito sites, including ornaments, horse tack, metal tools, portions of
firearms, glass mirrors, and one fragment of Chinese porcelain.

Puebloan ceramics from Jemez, Puname, Acoma, and Tewa groups, as
well as small amounts of Zuni and Hopi wares have been recorded.

Lithic materials from the Jemez Mountains, the Farmington area, and
the Chuska mountains also indicate wide-ranging trading and/or raiding

relationships (Marshall 1995:222-224).

A year after Marshall’s work, the landmark volume The
Archaeology of Navajo Origins (Towner 1996a) was published. It was the
first synthesis of the “state of the field” (Towner, 1996c¢:xii) of research in
Navajo archaeology since Hester’s (1962) work. Although only one of the
contributions (Towner 1996b) addressed pueblitos directly, many of them
address issues—such as ceramics, lithics, rock art, and other aspects of
material culture—that are integral to the broader understanding of the

artifactual remains encountered at pueblito sites.
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In 1997, The Dendrochronology of the Navajo Pueblitos of Dinétah
(Towner) presented a synthesis of all of the 827 tree-ring dates obtained
from 62 pueblito sites and utilized the data to elicit numerous
conclusions regarding the nature and extent of pueblito occupations,
some of which were at odds with the accepted canon of pueblito theory.
Towner inferred that the pueblitos were neither continuously nor
simultaneously occupied but were generally used for a period of up to ten
years, although in some instances they were repaired and reoccupied
after initial abandonment. He suggested that this pattern may be similar
to the intersite mobility documented ethnographically among the Navajo
(Towner 1997:345, 406-407.) Towner did, however, conclude that
although the pueblitos were not all contemporary, a given pueblito and
its surrounding hogans generally were occupied at the same time
(Towner 1997:407). This contemporaneity contradicts the pattern
expected if groups of Puebloan refugees had joined previously-
established Navajo communities. Towner’s conclusions also ran contrary
to the conclusions postulated by Marshall in this regard, just two years

previously (Marshall 1995).

Towner established that only two masonry structures were
constructed in the Dinétah region prior to 1709—the Buffalo Mask site (a
rockshelter structure built in 1680) and Tapacito Ruin (1694). Pueblito
construction “spurts” occurred between 1710-14, during the 1720s, and

again in the 1740s and 1750s. Rather than being correlated with the
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Pueblito revolt, these increases in construction appear to have been

precipitated by increased Ute raiding (Towner 1997:331-335, 352, 390).

Early pueblitos (built 1709-1720) appear to have been large sites,
loosely linked in a widely-spaced network. Subsequent pueblitos appear
to have formed smaller, local “communities,” again perhaps related to a

transhumant lifestyle (Towner 1997:366-367).

Towner also noted a distinct preference for pinyon for the vigas
(roof primaries) of the pueblitos, with some use of ponderosa pine,
Douglas fir, and cottonwood, where available. Juniper was used almost
exclusively for latillas (roof secondaries), for shelf poles and lintels

(Towner 1997:303).

A significant conclusion from Towner’s work is the assertion that
by the late 1500s, Navajo culture constituted, “a well-developed culture,
distinct from that of other Athapaskans”—nearly a century prior to the
Pueblo Revolt. Although Towner does not discount the probability of the
integration of some Puebloans into the Navajo over time, he rejects the
likelihood that large numbers of individuals were involved, or that such
immigration was the result of a single, dramatic historical event (Towner
1997:410-413). The bulk of Towner’s dissertation was later published as

Defending the Dinétah (Towner 2003).
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A year after the publication of Towner’s dissertation, Towner and
Johnson (1998) published the results of a 100 percent pedestrian survey
of a section of San Rafael Canyon. The first survey of its type, it revealed
that the three known pueblitos in the area were likely part of a network
of independent hogan/pueblito complexes, in addition to those located
within direct proximity to the pueblitos. Many of these more distant
hogan complexes were within line-of-sight of one or more pueblitos,
perhaps allowing their residents to be warned in time to retreat to the
comparative safety of the masonry structures in the event of a threat.
Towner and Johnson’s research also suggested that Navajo construction
of water-control features was more common than previously believed
(1998:144). They also raise the possibility that large pueblitos were
inhabited for a relatively short period of time, and that smaller pueblitos
may not have been habitations at all, but short-term refuges from raiders
(Towner and Johnson 1998:175). Finally, they propose that the temporal
shift to smaller, more numerous structures may have reflected a shift in

the perceived threat (Towner and Johnson 1998:173).

Dendrochronological analysis of four pueblito sites in and around
Palluche Canyon was carried out by Ababneh et al. (2000). They
concluded that Palluche Canyon may have seen initial occupation in the
1720s, followed by a hiatus of some 15 years spanning the 1730s, and
then reoccupation in the mid-to-late 1740s. They proposed that this

may reflect the abandonment of the area due to drought and its
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reoccupation by the same extended kin group, or “Navajo outfit,” at a

later time (Ababneh et al. 2000:285).

Work at McKean Pueblito (LA112641), overlooking Largo Canyon,
indicates that it was constructed in two episodes, with the addition of
one room five years after the initial construction (Towner et al. 2001:83).
More interesting, however, is the analysis Towner et al. (2001) provide of
McKean Pueblito within the context of surrounding sites, including the
pueblitos in and around Palluche Canyon. They note that the majority of
the mesa-top pueblitos overlooking Largo Canyon were built between
1708 and 1715, possibly to monitor the likely route of large, slow-moving
Spanish military forces intent on reprisals. With the advent of a truce
between the Navajo and the Spaniards in the late 1710s, however, the
threat shifted to smaller, swifter mounted raiding parties of Utes. After
1720 the majority of pueblitos in the area were built on boulder tops in
the valley bottoms or overlooking a tributary canyon. Although such
boulder-top pueblitos appear less ideal defensively than their highland
counterparts, such boulders were completely inaccessible by a mounted
force, thus evening the odds between opponent groups, because
attackers would have to dismount (Towner et al. 2001:85-86). Placement
of the structures in the horticulturally suited valley bottoms also allowed

for more rapid retreat from a swifter attack.
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This analysis by Towner et al. builds upon previous work by Ron
Towner, Hugh Rogers, and James Copeland presented at a 1998
symposium, but not published until 2001, in which the authors identify
three different periods in pueblito construction, based on the
architecture of the sites. The earliest sites (pre-1720) are either large,
intervisible structures of more than twenty rooms, or small fortified rock
shelters in remote canyons. Towner, Rogers and Copeland suggest that
these represent two different responses to Spanish aggression—retreat
from a large, slow-moving army into nucleated, defensible sites, or
retreat by small family groups into hiding (2001:120-122). Between
1720 and 1745, the Navajo were at peace with the Spaniards, but came
under pressure from small Ute raiding parties, likely in quest of slaves
for sale to the Spaniards. With little or no warning of impending attack,
the Navajo did not have time to congregate at the larger pueblitos, and
pueblitos built during this period tended to be small (one to five rooms)
located on the tops of monoliths or at mesa rims, and all are surrounded
by evidence of Navajo habitation in the form of forked-pole hogans and
other domestic features. Most of these sites are not visible from other
pueblitos (Towner, Rogers and Copeland 2001:122-123). The final period
of pueblito construction, just before the Navajo abandonment of Dinétah,
sees greater variation in architecture, but share a common location
factor: they all provide extensive visibility in one or more directions.

This may have been a result of the escalation of Navajo-Ute aggressions,
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from slave raids to what Towner, Rogers, and Copeland term, “total

war’—attempts to exterminate the enemy group (2002:124-125).

Towner, Rogers, and Copeland also compared the dates of pueblito
construction to the dendrochronological record of local climate, and
conclude that the years of greatest pueblito construction were correlated
with periods of higher rainfall. They propose that this is attributable to
two factors—in the pre-1720 period of Spanish military expeditions, the
Spaniards, with their forces of several hundred men and numerous pack
animals, would have been hesitant to venture into the Dinétah in years
when they knew water sources would be meager. Later, when Ute slave
raids were a threat, the Ute would have been more likely to engage in
raids when their subsistence base was sufficient to support, not only
time lost in raiding, but also the additional nutritional requirements of
any slaves they obtained (Towner, Rogers and Copeland 2001:125-127).
The final, brief period of pueblito construction prior to the abandonment
of Dinétah appears not to have been conditioned by rainfall (Towner,
Copeland and Rogers 2001:128), and it is possible that the Ute threat
which ultimately led to the vacating of the area was sufficiently severe to
prompt pueblito construction even in years when attack was not

necessarily imminent.

The publication of a condensed version of Towner’s (1997)

dissertation as “Defending the Dinétah” (Towner 2003), will doubtless
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spur more research into the pueblitos of Dinétah. In spite of over eight
decades of publications on the subject, however, the question of the
identity of the pueblito builders has never been directly addressed using

the archaeological remains at the sites themselves—until now.

www.manharaa.com




65

5 Survey Methodology

In order to gather data to provide the basis for analysis, four weeks
of intensive surface survey were devoted to three pueblito sites during
September and October of 2002, the extended period of time necessitated
by adverse weather conditions. Two of these pueblitos—Foothold Ruin
and 42 Pueblito—are located within Palluche Canyon, Rio Arriba County,
New Mexico. The third—the Overlook Site—is located on the south rim of
Palluche Canyon. These pueblitos were selected for a number of
reasons: they have all been dendrochronologically dated (Ababneh et al
2001); neither the structures themselves nor their surrounding site
complexes have previously been systematically surveyed; and they are
located within the heart of the pueblito system, which reduces the
likelihood of their being anomalous outliers.

The survey encompassed the pueblitos and their immediate
surroundings, in order to clarify the ethnic identity of their inhabitants.
It involved the systematic and detailed mapping of the entire site
complex, both to determine the site layout and to provide a base-line for
evaluation and future monitoring of deterioration and destruction by
natural and/or human forces.

A one-hundred percent pedestrian survey was conducted of the
area surrounding the pueblito structures themselves, in order to locate

such extramural features as hogans, sweatlodges, ash pits, garbage
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middens, and lithic and ceramic scatters. This was carried out for a
radius of approximately 250 meters around the structures, a distance
which previous research has indicated encompassed most of the
components of the site complex (Marshall 1991:1). The survey was
accomplished by two researchers walking pedestrian transects some 5-
10 meters in width, depending upon the topography and vegetation.
Tissue paper was used to flag finished transects, a technique found
useful by past researchers in this rugged and often densely-vegetated
terrain (Marshall 1991:4; James Copeland, personal communication
2001). Areas requiring technical climbing equipment for access were not
included in the survey. All structures and features within the survey
boundaries were mapped and are described herein. Distances were
measured with either a metal tape or via GPS, depending upon the
distance involved.

Each of the pueblitos was subjected to architectural analysis in
order to determine the masonry techniques employed in its construction.
Detailed maps of the Overlook Site and Foothold Ruin pueblitos have
already been generated by Powers and Johnson (1987:62, 64), and these
maps were employed in the final analyses of the sites. No detailed map of
42 Pueblito structure existed, and therefore one was created during the
fieldwork.

Due to the generally light artifact scatters at pueblito sites, and at

the request of the Bureau of Land Management Archaeologist (James
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Copeland, personal communication 2001), all of the surface ceramics
and other artifacts in middens and other features were recorded. No
excavation or collection was undertaken.

The purpose of this survey was to systematically map and record
all of the artifacts, features, and structures within the complexes
surrounding the pueblitos, as well as to examine the pueblito structures
themselves. This was done in order to provide data for further analysis,
and to determine whether the pueblito communities were composed
strictly of Navajos, of Puebloan refugees, or of a mixed group of Navajos
and Puebloans.

Three primary factors were given consideration in this analysis:
architecture, site layout, and artifact assemblages, especially ceramics.

Architectural analysis included an examination of the floor-plans
of both the pueblitos and non-masonry structures, as well as a careful
evaluation of the construction techniques used in both, where possible.
Special attention was given to masonry techniques at the pueblitos, as
such aspects as wall construction and coursing techniques vary both
temporally and culturally. Structure types, particularly ritual structures
such as kivas or sweatlodges, present at a site are also cultural
indicators. The architectural attributes determined to exist at the
pueblito sites were then compared with those evident at Dinétah phase
and non-pueblito Gobernador phase sites, as well as with Pueblo V sites

along the Rio Grande, where the postulated Puebloan refugees are
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believed to have originated (Barrett 2002:97, 110; Marshall 1991:21) (see
Chapter 12.

Community spatial organization, as evident in the site layout, is
another important cultural indicator, and the patterning of structures
and features within the site, as determined by the survey, was an
important aspect in the analysis of these sites. Given the considerable
difference in the traditional organization of community space between the
two groups (Navajo living in closely-related family groups dispersed upon
the landscape, and Puebloans living in close proximity around a central
public area), community organization was deemed a significant cultural
indicator. As with architecture, the community and spatial organization
patterns evident at the pueblito sites were then compared with
contemporary Navajo and Pueblo sites (see Chapter 13).

The artifact assemblages within the pueblito complexes were also
carefully examined. Although considerable archaeological attention has
been paid to ceramics at pueblito sites (e.g. Marshall 1995; Reed and
Reed 1992; Reed and Reed 1996), such attention has focused on Pueblo
decorated wares and Gobernador Polychrome, a Navajo ceramic type.
Little attention has been focused upon the type(s) of utility wares at the
sites. However, more illumination can be cast on the question of Navajo-
Pueblo co-residency through an examination of utility wares than of
decorated wares. Painted wares and glaze wares are common trade

goods, and their presence on a site is not indicative of the presence of the
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people who produced them. In addition, many pueblito sites have been
subjected to both authorized and unauthorized collection over the years.
Both types of collections have focused on the highly decorated wares
found on the sites, thus skewing the sample to an unknown degree.
However, all groups at this time produced their own utility wares, and
these prove a more sensitive index of what group or groups actually
occupied the sites. Therefore, while consideration was given to the
presence and types of trade wares, greater emphasis was placed upon
utilitarian wares (see Chapter 11).

Unlike ceramics, lithic artifacts from this period are generally non-
diagnostic. This is partly true due to the gradual introduction of
European metal goods, and due to the tendency of the Navajo to “recycle”
lithic and groundstone artifacts from abandoned sites, including those of
the Puebloans and Anasazi (Kearns 1996:135). Therefore, the presence
of such artifacts at pueblito sites cannot be considered indicative of the
presence of Puebloan groups. Likewise, the occurrence of obsidian and
Pedernal chert, both from the Jemez mountains (Kearns 1996:123),
cannot be considered definitive, because these materials were easily and
commonly traded.

Data from the Palluche Canyon surveys were then combined with
data from a similar one-hundred percent surface survey of nine pueblitos
conducted by Michael Marshall in 1989 and 1990 (Marshall 1991; 1995),

and plan maps of the same pueblitos produced by Powers and Johnson
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(1987), in order to increase the sample size. However, neither Powers
and Johnson nor Marshall recorded details of the architecture and
construction of the pueblitos. Where possible, detailed photographs, as
well as maps, were used to determine construction technique. Marshall’s
artifact samples from middens and ceramic scatters (Marshall 1995) were
also employed to increase the sample size.

Data from Tapacito Ruin, however, were not combined with those
of the other pueblitos, due to its uniqueness, both chronologically and
archaeologically. This is in keeping with Towner and Dean’s observation
that, “several lines of evidence indicate that the Tapacito pueblito is a
unique structure in post-Revolt Dinétah,” (1992:326) and Towner’s
caveat that, “Tapacito Ruin is not related to the other pueblitos and
should be viewed as a separate entity,” (1996:166). Analysis of Tapacito
ruin, and its implications, are considered in a separate chapter.

Fieldwork was preceded by considerable research into the nature
of both eighteenth-century Navajo and Pueblo sites and the
archaeological remains typical of such sites. Theoretical models were
then constructed comprising three categories of data: ceramics,
architecture and construction techniques, and settlement and
community organization. In each case, models were constructed
reflecting the anticipated nature of the site had it been constructed and

inhabited entirely by Navajos; a second reflecting an entirely Puebloan
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occupation; and the third projecting the attributes of a site constructed
and simultaneously occupied by members of both groups.

The results of the Palluche Canyon survey appear in Chapters 7
through 9. These, along with those of eight pueblito complexes surveyed
by Marshall were then compared against the models which had been
formulated, and conclusions drawn (see Chapters 11 through 13). The

separate consideration of Tapacito Ruin appears in Chapter 14.
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6 Palluche Canyon

Environmental Setting

The project area is located in Palluche Canyon, in northwestern
New Mexico. The canyon extends southwestward from Largo Canyon
between Superior Mesa on the south and Smouse Mesa on the north
(Figure 6.1). Both Palluche and Largo Canyons harbor ephemeral

washes that flow northward into the San Juan River.

The floor of the 16 kilometer long canyon is typically level, and is
approximately 3 kilometers wide at its widest point. The soil is loose and
sandy, and canyon-floor vegetation consists largely of big sagebrush
(Artemisia tridentata), saltbrush (Atriplex canescens) and greasewood
(Sarcobatus vermiculatus), interspersed with abundant blue grama grass
(Bouteloua gracilis) and purslane (Portulaca oleracea). Rabbitbrush
(Chrysothamnus nauseosus) is found in dense stands along Palluche
Wash and its numerous small tributaries. Prickly pear and cholla cactus
(Opuntia sp.), Rocky Mountain bee plant (Cleome serrulata), birdcage
primrose (Oenothera deltoides), alkali sacaton (Sporobulus airoides),
desert paintbrush (Castilleja angustifolia chromosa) and tansy aster

(Machaeranthera tanacetifolia) may also be found.
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Palluche Canyon has dissected the surrounding sandstone mesas
to a depth of up to 600 feet (200 meters). The canyon is flanked by talus
slopes marked by occasional outcrops of gray clay along the base of the
steep mesa sides, which are covered in dense stands of Colorado pinyon
(Pinus edulis) and juniper (Juniperus sp.), with a sparse understory of
blue grama grass. Yucca (Yucca glauca), big sagebrush, scarlet gilia
(Ipomopsis aggregata), and beehive cactus (Escobaria vivipara) are also

scattered through the understory.

The mesa-top vegetation consists largely of somewhat more
stunted examples of big sagebrush and greasewood, interspersed with
blue grama grass. Areas nearer the mesa edge and on the benches
framing the mesa top, however, are more densely vegetated, with
scattered stands of pinyon and the occasional juniper. Large open areas
on the more sizeable benches exhibit stands of big sagebrush and
greasewood, which is somewhat less stunted than that found on the
mesa tops. Blue grama grass appears in the understory of both the
pinyon-juniper and brushy areas, and yucca (both Yucca filamentosa and
Yucca glauca), prickly pear (Opuntia sp.), Mormon tea (Ephedra viridis)

and beehive cactus are common.

Both elk (Cervus elaphus) and mule deer (Odocoileus hemionus) are
common, with elk being particularly numerous. Large predators consist

of coyotes (Canis latrans) and mountain lion (Felis concolor). Most
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smaller desert mammals are nocturnal, but evidence of lagomorphs—
likely jackrabbits (Lepus sp.)—and woodrats (Neotoma sp.), was noted, as
well as the tracks of many smaller rodents. Reptiles are numerous, with
short-horned lizards (Phrynosoma douglassi), gopher snakes, (Pituophis
catenifer), western rattlesnakes (Crotalus viridis), eastern fence lizards
(Sceloporus undulatus), and sagebrush lizards (Secoloporus graciosus)
identified in the field. Bird species consist of a variety of buteos (due to
the wide variety of color phases, no attempt was made to identify these
as to species), northern flickers (Colaptes auratus), western scrub jays
(Aphelocoma californica), American crows (Corvus brachyrhynchos), and

dark-eyed juncos (Junco hymalis—gray-headed race).

Archaeological Setting

No intensive systematic archaeological survey of Palluche Canyon
has been conducted, although the area was included in the Navajo Land
Claims project, and has seen sporadic surveys associated with the
construction of various oil and gas development projects. In spite of this,
the area has proved rich in archaeological resources of a variety of types

(New Mexico Cultural Resources Information System, 2002).

Although the bulk of the archaeological resources recorded in the

canyon are Navajo, there is also evidence of Anasazi use of the area.
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Archaic and Paleo-Indian groups may well also have made use of the
canyon’s resources, but no evidence of their activities has been recorded.
Anasazi sites, although uncommon in the canyon, consist of pithouses,
middens, petroglyphs, and at least one roasting pit (New Mexico Cultural

Resources Information System, 2002).

Navajo sites, in contrast, are quite common. Forked-pole hogans,
stone circles (likely the only remains of now-vanished forked-pole
structures), sweatlodges, a lithic quarry, and both pictographs and
petroglyphs have been identified in the canyon (New Mexico Cultural

Resources Information System, 2002).

Most prominent among the archaeological resources in Palluche
Canyon are the three known pueblitos found on the canyon floor: 42
Pueblito, Foothold Ruin, and Twine House (LA 86895, LA 9073 and
LA127737, respectively) (New Mexico Cultural Resources Information
System, 2002). All three are located on the east side of the canyon, and
the likelihood is high that additional exploration would reveal
undiscovered pueblitos nestled in the rincons (small side-canyons) on the
west side of the canyon, especially given that the existence of Twine
House remained unknown to archaeologists until 1998 (Ababneh et al.

2000:273).

The mesas which overlook the canyon also feature a considerable

number of pueblitos. The Pork Chop Pass site (LA 5661) is located on
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Smouse Mesa, to the north, and the Overlook Site (LA 10732),
Compressor Station Ruin (LA 5858), Largo School Pueblito (LA 5657),
and Hooded Fireplace Ruin (LA 5662) all located on Superior Mesa (New

Mexico Cultural Resources Information System, 2002).

Also notable among the Navajo sites in Palluche Canyon are the
large number of Navajo rock art panels. Copeland and Rogers (1996:224)
indicate the presence of five humpbacked ye’i figures, 19 unidentified
ye’i, one queue (the “hour-glass” symbol indicating the Hero Twin Born-
for-Water), and one corn plant, although they indicate that this list is not
exhaustive. They observe the absence of the following themes in
Palluche Canyon: fringe-mouth ye’i, twin ye’i, triangular horned ye’i,
hunting people, snakes, shield figures, bats, or the bow symbol that
indicates the other Hero Twin, Monster Slayer. Navajo rock art is
generally located away from pueblitos and is unassociated with
habitation sites, although it may co-occur with Anasazi petroglyphs
(Copeland and Rogers 1996:219), as occurs at one site near the mouth of
Palluche Canyon (LA 80995) (New Mexico Cultural Resources

Information System, 2002).

The presence of the Born-for-Water queue, and the as-yet-apparent
absence of the symbol for the other Twin, Monster Slayer, as well as the
comparatively large number of humpback ye’i figures may provide insight

into the ways in which the Navajo used Palluche Canyon. Copeland and
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Rogers state that, “variation [in the frequency of various images between
canyons| may reflect some as yet not completely understood significance
the specific places held in the ceremonial structure of Dinétah...the
differences between canyons may reflect different types of ritual
performed at those places” (1996:225). They observe that the
humpbacked ye’i is a major character in the Nightway chant, and that
there is a continuity between rock art themes and sand paintings

(Copeland and Rogers 1996:225,227).

Perhaps the most significant archaeological discovery in Palluche
Canyon to date is a remarkably complete and well-preserved ceremonial
cache discovered by an El Paso Natural Gas employee in 1967. The 96
pieces were found in a small rock shelter approximately 30 feet up from
the lower bench in small rincon on the left side of the main canyon
(Roessel 1983:135). Many of the items are similar to those still in use in
Navajo ceremonials, including basketry head dresses, gourd rattles,
beaks for masks, and circles made of twigs (Roessel 1983:135, 157).
Numerous tablitas, or dance paddles, were also included in the cache
(Roessel 1983:137, 140-141, 150-154). Although such tablitas are no
longer in use among the Navajo (Roessel 1983:135), Navajo rock art does
portray figures holding what appear to be dance paddles (Copeland and

Rogers, 1996:219).
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Although the departure of the Navajo from Palluche Canyon likely
marked the end of its intensive use for habitation, the area did not
remain completely deserted. At least one instance of Hispanic graffiti has
been recorded in association with Anasazi and Navajo petroglyphs, and
the remains of two Hispanic or Anglo-American stone residential
structures can be seen on the floor of the main canyon. At present, the
canyon proper remains uninhabited and is primarily used for grazing,

although a working ranch is located at the mouth of the canyon.
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7 42 Pueblito Survey Area

The 42 Pueblito Survey Area is centered on 42 Pueblito (LA 86895),
a considerably eroded masonry structure topping a large boulder at the
base of a talus slope (Figure 7.1). The pueblito is located on the east side
of Palluche Canyon, at the mouth of a rincon. The survey area

encompassed portions of both the canyon and the southwest edge of the

rincon.

Figure 7.1 42 Pueblito.

A single ephemeral stream drains the rincon, although several
ephemeral washes channel drainage down the talus slope. The area

varies in altitude from 6200 feet above sea level to 6400 feet above sea

—
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level. A large portion of the survey area encompassed relatively flat,
sandy canyon bottom populated with sagebrush, greasewood, and
rabbitbrush, with an understory of blue grama grass and purslane. The
remainder of the survey area consisted of steep north- and west-facing
sandstone talus slopes with up to a 40 percent grade. A large sandstone
cliff dominates the site, and dictated the boundaries of the survey area
on portions of the south and east sides. Typical of the canyon as a
whole, the talus slopes are cloaked in mixed pinyon-juniper forest, with
an understory of grasses, with scattered narrow-leaf yucca and other

herbaceous annuals and perennials.

The pueblito was re-recorded and mapped as part of the project.
The survey of the area around the pueblito resulted in the recording of
one new archaeological site (LA 137967), (Figure 7.2) and ten isolated

occurrences (Table 7.1).
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Figure 7.2 42 Pueblito survey area.
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42 Pueblito: LA 86895

Originally recorded by Navajo Land Claims archaeologists in the
1950s (Ababneh et al. 2000:278), 42 Pueblito was reviewed again by
Bureau of Land Management researchers in 1989 (New Mexico Cultural
Resource Information System, 2002). In the 1950s the pueblito included
two rooms with a sealed door between them, a notched pole ladder and
an associated hogan (Ababneh et al. 2000:278-279), but by 1989 the site
had been badly degraded by erosion, illegal excavation and vandalism,
and only a few courses of the walls remained. Likewise, by 1989 the
hogan was no longer detectable (New Mexico Cultural Resource
Information System, 2002). However, there were sufficient intact beams
at the pueblito for the University of Arizona Tree Ring Laboratory to date
the original construction of the site to the late 1720s and a repair

episode during or after 1741 (Ababneh et al. 2000:282).

The map of the site originally produced by the Navajo Land Claims
researchers is no longer available (Ababneh et al. 2000:278), and only a
rough sketch map was produced of the site in 1989. In order to provide
a more accurate record, and to aid in architectural analysis, the site was

re-mapped in 2002 using a metal tape and a compass (Figure 7.3).

The original 1959 description of the site is as follows (from
Ababneh et al. 2000:278-279, spelling and typographical errors

corrected. After Correll and Brugge 1959):
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Fortified Crag #1: Atop a sandstone formation averaging 10’ in
height and about 25’ E-W x 10’ N-S are the remains of a fortified
crag consisting of two one-storey rooms. There is little evidence of
a second storey to the structure. Room 1: A room 11’ E-W x 6-5’
N-S. The base rock has a slight tapering at the middle where wall
between rooms is located (see sketch) [not available]. Walls of
Room #1 stand 5’ high from present fill. Four rafters in place at
east end of room—no other portions of roof remain. Three lookout
holes #1—3” diameter at northeast corner 1.5’ above fill, #2—3”
diameter at fill level, #3—1.5" above fill about 1/3 way from wall
between room to northeast corner, #4 is 6” wide, 4” high. Door is
in east wall next to south wall. A rock wall extends along rock rim
from south wall in a northeast curve around ramp up sandstone
formation to entrance. In the west wall between the two rooms is
a sealed door. Two lintels are in wall above sealed door. Split
poles form sides of entrance to Room 1. Some plaster on walls. A
stone wall 6’ long, now 1.5’ high extends from south wall Room 1
around the rim of rock along ramp. Room 2: An irregularly-
shaped room (see sketch) [not available] with a diameter of 11’ x 8’.
A drain hole (?) 5” and 6” is in northwest corner at fill level. A
lookout hole is in south wall 1.5’ above fill and 2’ from southeast
corner, 3” high, 5” wide. Walls of Room 2 stand 3’ to 6’ high in
northwest corner above fill. There is no evidence of rafters having
been in this 6’ wall. Fill is estimated to be 1.5’ deep. No firepit
located. Notched pole ladder 4.5’ long with three steps at
southwest base of crag. Masonry is of sandstone slabs with mud

and small stone chinking.
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Hogan #2. 40’ NE of crag are the remains of a forked-pole (?)
hogan. Only a few small juniper and pinyon timbers remain as
evidence of the structure, all of the large timbers are missing.
These timbers are scattered but sufficient remain in wheel-spoke
pattern to indicate a forked pole structure. Circular floor
depression measures 7.5’ in diameter. Entrance not determinable.
Firepit or door slabs not located. Ash dump not located—probably
washed down slope to Palluche Wash. Ash dump southwest of
structure 15’. Another notched pole ladder 6.5’ long with four

steps lying at northwest base of crag.

Pottery:

Dinétah Utility 420 sherds
Refugee Utility 4 sherds
Gobernador Polychrome 47 sherds
Zia 6 sherds

Tewa Polychrome 4 sherds
Zuni-Acoma 4 sherds

Hopi 1 sherd
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Figure 7.3 Map of 42 Pueblito (LA 86895).

LA 137967

Site Type: Burned forked stick hogan and associated artifact scatter

Cultural-Temporal Affinity: Navajo, Gobernador Phase

Location: LA 137967 is located on a small bench approximately 30
meters above the canyon floor at the mouth of a small rincon on the east
side of Palluche Canyon, and approximately 150 meters east of 42
Pueblito. The site exposure is northward, and provides a view of the
rincon and portions of Palluche Canyon to the east and north. Mixed
pinyon and juniper, with an understory of blue grama grass, big

sagebrush, and yucca surround the site.
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Description: This site consists of a charcoal stain and a few burned
stubs of timbers, and represents the remains of a burned forked-pole
hogan. Two small unburned, axe-cut timbers are located nearby. A
large, diffuse ash stain to the north-east appears to result from the
burning of the hogan. A scatter of Gobernador Polychrome and Dinétah

Gray sherds, as well as a few flakes, are scattered over the site.

Interpretation: LA 137967 is a single-component protohistoric site
consisting of a burned, forked-pole hogan and an associated artifact
scatter. It has been dated to the Navajo Gobernador Phase on the basis
of Gobernador Polychrome ceramics present on the site. This fairly
typical habitation site appears to be related to the nearby pueblito and
may represent seasonal exploitation of canyon-bottom fields, with the
pueblito providing refuge from Ute attacks for the hogan’s inhabitants.
Tree-ring dating may be possible at the site, and would establish

contemporaneity, or lack thereof, with the pueblito.

Maps: See Figure 7.4.
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42 Pueblito Survey Area Isolated Occurrences

Isolated occurrences encountered in the 42 Pueblito Survey area

are presented in Table 7.1.

Table 7.1 Isolated Occurrences in the 42 Pueblito Survey Area.

Isolated Occurrence | Description:

#:

42-10-1 1 Gobernador Polychrome sherd and 1 tertiary
grey chert flake

42-10-2 Gobernador Polychrome sherd

42-10-3 Gobernador Polychrome sherd

42-10-4 2 Gobernador Polychrome sherds

42-10-5 4 Gobernador Polychrome sherds and 1 Dinétah
Gray sherd over 7 x 2 meter area

42-10-6 Probable Gobernador Polychrome pot drop—8
sherds, all appearing to belong to same vessel

42-10-7 Tertiary white chert flake

42-10-8 Gobernador Polychrome sherd

42-10-9 Dinétah Gray pot drop c. 40 sherds (probably
restorable)

42-10-10 Gobernador Polychrome sherd
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Discussion

The complex surrounding 42 Pueblito appears to have been very
limited in extent and likely only consisted of a single nuclear family, or at
the most two related families, living at the site during the duration of the
pueblito’s use. This limitation of extent may be illusory, however, and
more reflective of preservation and depositional conditions at the site,
rather than of habitation patterns.

Few grounds for comparison of the size and composition of the 42
Pueblito complex exist, as Marshall’s (1991) survey only encompassed
one canyon-bottom pueblito (Simon Canyon Pueblito—LA 5047), Towner
and Johnson’s (1998) survey was all upper-elevation, and the current
project evaluated only one other (Foothold Ruin—LA 9073). The size of
these canyon-bottom pueblito complexes, however, stands in sharps
contrast to those of found at higher elevations.

The 42 Pueblito complex has two hogans, the Foothold Ruin
Complex three, and the Simon Canyon complex none (Marshall
1991:132). In contrast, only one of the higher-elevation pueblito
complexes, Shaft House (LA 5660), which is built on the face of a high
cliff, is lacking in hogans, and the other higher-elevation complexes have
an average of five hogans, with quantities ranging from two to ten

(Marshall 1991).
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Number of hogans is not the sole indicator of complex size,
however. If the number of elements comprising the complexes is
considered, it further illustrates the pattern. For the purpose of this
examination, a complex element was taken to mean a feature, such as a
hogan, hearth, sweatlodge, or rock art panel. Certain features—
middens, artifact scatters, isolated occurrences, pueblitos or masonry
rooms, undated features and those pre- and post-dating the Navajo
occupations such as Anasazi and Euro-American or Hispanic
components—were excluded from the total. Pueblitos were excluded
because, by definition, each of the complexes houses a pueblito, and the
number of rooms in the pueblito may not be reflective of the total size of
the surrounding complex. Taking the specified elements into
consideration, the canyon-bottom sites average just three per complex,
whereas the higher-elevation sites consisted of ten to nineteen elements,
with an average of fifteen (Marshall 1991). Such a discrepancy between
canyon-bottom and higher-elevation sites cannot be attributed solely to
differential preservation, or the potential burial of sites under alluvium.

The limited extent of the complex surrounding 42 Pueblito—and by
extension, the other lower-elevation complexes--may, however, be
indicative of the season in which they were used. The deteriorated
condition of the hogans in the 42 Pueblito survey area preclude
seasonality determinations based on orientation of the structure

entrance—hogan entrances were oriented toward the location of the first
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appearance of the rising sun at the time of construction in order to permit
the performance of certain critical morning rituals (Jett and Spencer
1981:17). Thus a northeast-oriented doorway would suggest summer
construction, whereas a southeast-oriented doorway would suggest
winter construction. In spite of the lack of data of this nature, however,
archaeological and ethnographic evidence suggest that the 42 Pueblito
complex was occupied during the summer months.

Jett and Spencer indicate, based on ethnographic patterns, that
most Navajo “outfits” (extended family groups consisting of a living
matriarch and her daughters and granddaughters and their husbands)
had two camps where they built permanent structures—one used in
summer and the other in winter, with some or all of the family migrating
between the two sites. In outfits for whom agriculture was the primary
means of subsistence, the summer camp was located near farmland, and
winter sites located at higher elevations, where firewood was available.
Those outfits whose primary reliance was on pastoral resources,
however, would spend the summer in mountain meadows and the winter
in pastures at lower altitudes (Jett and Spencer 1981:10).

This pattern appears to have been borne out in earlier times
through data from the Canyon del Muerto survey. That survey indicated
that the Navajo made limited, seasonal use of the canyon bottoms, and
more extensive, year-round use of the canyon rim (James 1976:1). In

spring and summer, habitations were located near arable land in the
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canyons, with hogans in adjacent cliff, talus, and rim locations, whereas
in winter the habitations were moved to treed areas on the plateaus,
where wood, pasture, and camouflage were abundant (Magers 1981:228).

The 42 Pueblito complex would have been well-suited for use as an
agricultural area, given the deep layer of fine alluvium and the proximity
both of the ephemeral stream in the rincon and the larger Palluche Wash
located immediately west of the survey area. The pueblito and the two
hogans are ideally situated to provide advance warning of the approach
of hostile parties up Palluche Canyon from Largo Canyon, allowing
complex residents tending the fields near the mouth of the rincon or
working at activity areas near the hogan sufficient time to retreat to the
safety of the pueblito before attackers reached the settlement. The hogan
adjacent to the pueblito, however, would have been somewhat exposed to
winter winds gusting down the canyon, and cold-air drainage from the
mesa above would have made both hogan sites uncomfortable locations
for habitation in mid-winter.

Only one date was obtained from the hogan adjacent to the
pueblito by the Navajo Land Claims researchers, a non-cutting date
(1699vv) (Ababneh et al. 2000:279). Thus, even if the newly-discovered
hogan at LA 137967 can be successfully dated, the question of potential
contemporaneity of the two hogans would remain open. It is worthy of
note that the average use-life of a hogan, based on archaeological and

ethnographic data, is generally on the order of ten years (Towner and
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Johnson 1998:153). It is possible that both hogans may have been used
during the use-life of the pueblito, which Ababneh et al. (2002:282)
estimate was originally constructed in the late 1720s, and remodeled in
the early 1740s.

Causes for abandonment of a structure include a death occurring
within the structure, lightning strike, a bear rubbing against the hogan,
insect infestation, or bad luck or the quarreling of the occupants (Jett
and Spencer 1981:28). In the case of a death in the hogan, a new hogan
must be constructed at least 150 feet from the “death hogan,” and other
hogans may be moved as much as a half a mile away. Even under
normal circumstances of simultaneously, rather than consecutively,
occupied structures, however, hogans are located some distance apart
and out of line-of-sight of one another, providing each nuclear family
with a degree of privacy (Jett and Spencer 1981:7, 9). The relative
locations of the two hogans, therefore, do not provide clarification of the
matter, and the question of their chronological relationship to one

another, and to 42 Pueblito, remains unresolved.

www.manaraa.com



96

8 Overlook Survey Area

The Overlook Survey Area is centered on the pueblito at the
Overlook Site (LA 10732) (Figure 8.1), a five-room masonry structure
located on a slickrock projection at the edge of Superior Mesa. It
overlooks much of the bench that was included in the Overlook Survey
Area as well as Foothold Ruin 500 feet below. The pueblito originally had

five ground-floor rooms, and at least two on the upper storey.

The Overlook Survey Area is located on a west-facing bench on the

mesa rim above Palluche Canyon, on the east side of the canyon. One
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ephemeral stream drains the area, creating a tortuous channel through
the slickrock that drains the rim of the mesa to the canyon floor almost
500 feet below. The bench varies in altitude, from 6820’ asl in the
bedrock channel of the stream to 6880’ where the bench intersects with
the cliff dividing it from the mesa top some 40 feet above. Slope varies
considerably over the survey area, with large, relatively level (4 percent
grade) expanses, and up to a 20 percent grade in the vicinity of the
ephemeral stream. The area is predominantly pinyon-juniper forest, with
some open areas of mixed desert scrub, and patches of exposed bedrock
near the mesa rim. The vegetation community is much the same as that
noted in the canyon below, with an increased prevalence of cacti and a

reduction in the overall size of scrub plants such as big sagebrush.

The area surrounding the Overlook Site was re-recorded and
mapped as part of the project, although due to the extensive mapping of
the structure itself done by Powers and Johnson (1987) for the National
Register nomination, mapping of the pueblito structure proper was not
undertaken. The survey of the area around the pueblito resulted in the
recording of nine new archaeological sites (LA 137968 to LA 137975 and
LA 139975), including three forked-pole hogans, five sweatlodges, two

petroglyph panels (Figure 8.2) and five isolated occurrences (Table 8.1).
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Overlook Site: LA10732

The Overlook Site was initially recorded by Navajo Land Claims
researchers in 1957, and was documented by Margaret Powers and
Byron Johnson for inclusion in the National Register of Historic Places in
1985-86 (Powers and Johnson 1987:63). Tree-ring samples were
collected by the Navajo Land Claims researchers and again by Ronald
Towner of the University of Arizona. Towner concluded that the suite of
dates, in conjunction with architectural analysis, indicated the pueblito
was built in at least three separate construction episodes, beginning in

1727 (Towner 1997:242-245).

The Overlook Site pueblito consists of five ground-floor rooms, two
of which appear originally to have had a second storey. A rock alignment
near the pueblito suggests that initial work may have begun on another

free-standing room.

Four collapsed hogans and a stone circle, possibly representing the
remains of a fifth hogan, were recorded at the site (Figures 8.3 and 8.8),
along with a large sweatlodge discard pile in the wash below and some
distance from the pueblito, and a possible windbreak structure (Powers
and Johnson 1987:63). Neither Powers and Johnson (New Mexico
Cultural Resource Information System), nor the 2002 survey crew were
able to relocate the windbreak. The rock alignment near the pueblito

was originally recorded as a stone circle, and interpreted as the base to a
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now-vanished D-shaped hogan (New Mexico Cultural Resource
Information System, 2002). Powers and Johnson, however, provide the
first map of the site, and interpret the rock alignment next as the
beginning of another possible pueblito room (New Mexico Cultural
Resource Information System), a postulation concurred with by the 2002
survey team. A small, loosely-defined circle of stones located in close
proximity to the other hogans, which Powers and Johnson (1987:64)
interpret as “wall fall,” although there is no wall in the vicinity, and no
apparent reason for a short section of wall to have been constructed at
that location on the site. Nor is there any indication of adobe mortar, as
would be expected with a wall section, and this circle may in fact

represent the base of a now-vanished forked-pole hogan.

The 2002 team re-mapped the site (with the exception of the
pueblito itself, which was fully recorded for the National Register
nomination), including detailed mapping of each of the hogans and the
stone circle (Figure 8.3 and Figure 8.8). The sweatlodge discard pile
included in the site is located some distance from the pueblito and
surrounding structures, and was re-located in the field and appears
Figure 8.2 but is not included on Figure 8.3 due to scale. Three tools: a
shaft straightener (Figure 8.4), a sharpening stone (Figure 8.5), and a
hammerstone (Figure 8.6) were encountered in the course of the mapping
project, in addition to a large anomalous groundstone object (Figure 8.7).

Sherd and lithic counts were taken of the three middens (four were
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recorded by Powers and Johnson on the site form in 1985, but erosion
has led to the junction of the two middens they recorded on either side of

Hogan 1) (New Mexico Cultural Resource Information System, 2002).

Maps: See Figure 8.3 for general site overview, and Figure 8.8 for hogan

and stone circle layouts.
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Figure 8.4 Shaft straightener at LA 10732. Actual size:19.8 cm x 12 x
6.5 cm.

Figure 8.6 Hammerstone
at LA 10732. Actual size:
2.6x1.8x0.7 cm.

Figure 8.5 Sharpening tool at LA
10732. Actual size: 17.0 x 16.0 x
3.3 cm.
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Figure 8.7 Anomalous groundstone artifact at LA 10732.
Actual size: 50 x 17 x 15 cm.
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LA 137968

Site Type: Burned forked-pole hogan

Cultural-Temporal Affinity: Navajo, Gobernador Phase

Location: LA 137968 is located in the middle of a wide bench on
Superior Mesa, some 150 meters above the floor of Palluche Canyon, and
approximately 150 meters from the Overlook Site pueblito. The area is
sparsely vegetated with juniper and pinyon, and an understory of

sagebrush, blue grama grass, ephedra, and opuntia.

Description: The site consists of a partial stone circle, a large charcoal
stain, two unburned timbers, and a light scatter of lithics, debitage and
ceramics, which are largely confined within the boundaries of the circle.
Artifacts consisted of two lithic tools: a projectile point of white chert
(Figure 8.10) and a partial gray chert tool (probably a bifacial scraper
fragment—Figure 8.11), three flakes, three Gobernador Polychrome
sherds, one Dinétah Gray sherd, and one white-slipped tradeware sherd.
No trace of decoration, other than traces of a heavy, crazed white slip

remained on the sherd-tempered gray paste tradeware.

Interpretation: LA 137968 is a single-component protohistoric
habitation site consisting of a stone circle and a few collapsed timbers
from a forked-pole hogan. The site has been dated to the Navajo Dinétah

or Gobernador Phase on the basis of Dinétah Gray ceramics on the site,
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but the timbers appear to be too eroded to provide more accurate dating.

The site is likely associated with the nearby pueblito, and may represent

one of the hogans occupied by the “outfit” (extended matrilineal group)

that made use of the pueblito as a refuge from Ute raiders.

Maps: See Figure 8.9.
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Figure 8.10 Projectile point at Figure 8.11 Partial tool at LA
LA 137968. Actual size: 3.5 x 137968. Actual size: 2.7 x 1.8 x
0.8 x 0.5 centimeters. 0.7 centimeters.

LA 137969

Site Type: Petroglyph panels

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137969 is located among a jumble of large boulders at the
base of a talus slope adjoining the top of Superior Mesa, and is on the
same bench as the Overlook Site pueblito. The site is approximately 350
meters from the pueblito and is located at one of the two areas in the
vicinity where access from the mesa top to the bench is relatively easy. It
is located in close proximity to three sweatlodge sites, which are also
located along the base of the talus slope. Panel 1 faces roughly east, and

the adjacent Panel 2 faces roughly southeast. The panels are located
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adjacent to a sparse pinyon and juniper woodland at the base of the

talus slope, with an understory of sagebrush and blue grama grass.

Description: Each pecked panel contains similar elements: one standing
anthropomorph and one mounted rider on horseback (Figures 10.13,
10.14 and 10.15). Panel 1 features a stick-figure anthropomorph with
raised arms bent at the elbows, and a two pecked dots to the right of and
slightly above the head. The mounted figure in Panel 1 likewise has its
arms raised, and bent at the elbow. This figure features an elaborate
head-dress or hairstyle. A number of pecked dots are located to the right
of the rider. Panel 2 is very similar, with the anthropomorph located to
the left, rather than the right of the mounted figure. The arms are
raised, the elbows are bent, and a line appears to the left, near the hand.
The mounted figure holds what appears to be the horse’s rein in one
raised hand, the other hand may or may not be meant to be holding a
line symbol which appears above it. An additional line extends back

from the riders body, the significance of which is unclear.

Interpretation: LA 137968 is a single-component petroglyph site,
consisting of two panels, each featuring an anthropomorph and a rider
mounted on horseback. The site has been assigned to the proto-historic
or historic period based on the portrayal of equines, and is believed to be
Navajo on the basis of stylistic attributes. The virtual abandonment of

the Dinétah area at the close of the Gobernador period allows the site to
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be dated to the Dinétah or Gobernador Phases. The site is not
remarkable in itself, but may be part of a larger ceremonial complex
which includes LA 137970, LA 137971, and LA 137972. The location of
this site, in conjunction with the other three sites, may be significant, as
it is located at one of the two areas in the vicinity of the Overlook Site
that allow relatively easy access down from the mesa top, and may reflect
the performance of ritual purification ceremonies after returning from
hunts or combat (Jett and Spencer 1981:196), before returning to the
habitation area. The nature of the portrayals of head-dresses or hair-
styles on the mounted figures should be given further consideration in
this context, as they are not consistent with those worn by the Navajo,
and may instead represent those worn by Ute raiders, and be connected
with attempted, and possibly repulsed, raids on Navajo settlements in

the area.

Maps: See Figure 8.12.
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Figure 8.14 Petroglyph Panel 1 at LA 137969 Actual size of
anthropomorph: 20 cm high.

-gve

Figure 8.15 Petroglyph Panel 2 at LA 137969 Actual size of
anthropomorph: 25 cm high.
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LA 137970

Site Type: Sweatlodge discard pile and nearby pot drop

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137970 is located at the base of a talus slope that adjoins
the top of Superior Mesa, and is located on the same bench as the
Overlook Site. It is close to both LA 137969 and LA 137971, and is
likewise in one of the two areas affording easy access to the mesa top. A
sparse pinyon-juniper woodland with an understory of blue grama grass,

sage brush, and Opuntia surrounds the site.

Description: The site consists of a very small burned sandstone
midden, and a nearby concentration of eighteen Dinétah Gray sherds.

All of the sherds seem to be from the same vessel, and appear to
represent a pot drop. Vessel rim diameter is approximately 27 cm, based

on sherd curvature.

Interpretation: LA 137970 is a single-component Navajo sweatlodge
site and nearby pot drop. Based on the presence of the sweatlodge and
the Dinétah Gray pot drop, the site has been dated to the protohistoric
Dinétah or Gobernador Phase. This typical sweatlodge discard pile is
quite small, consisting of only nine stones, and likely represents a one-
time or short-term use of the site. In conjunction with LA 137969, LA

137971 and LA 137972, this may represent a ceremonial complex
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associated with returning from expeditions to hunt, trade, or to battle, as
noted in the remarks for LA 137969. The practice of engaging in ritual
purification through sweats was one commonly followed by the Navajo

after returning from such expeditions (Jett and Spencer 1981:196).

Maps: See Figure 8.16.
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LA 137971

Site Type: Sweatlodge discard piles and charcoal stain

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 13971 is located at the base of a talus slope that adjoins
the top of Superior Mesa, and is situated between LA 137970 and LA
137972. It is at the interface between the pinyon-juniper woodland with
an understory of sagebrush and blue grama grass and the relatively

barren talus slope.

Description: The site consists of two distinct burned sandstone
middens flanking a small depression filled with sand and fine charcoal
deposits. It appears to represent a sweatlodge, from which rocks were
discarded in two different directions. The pattern of deposition of the
burned rock, with deeper deposits immediately adjacent to the sandy
depression, indicates that the stones were disposed of from the
depression in two different directions, rather than representing discard

piles from two adjacent sweatlodges.

Interpretation: LA 137971 is a single-component Navajo sweatlodge
site, which varies from those typically encountered by having two large
discard piles, one to the east, and another to the west, flanking a small,
sandy depression containing charcoal-stained soil. Jett and Spencer

(1981:196) note that in some instances, rocks that could not be re-used
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were piled to one side of the entrance to the sweatlodge, whereas rocks
which could be re-used in future sweats were piled to the other side.
Such a practice may explain the presence of the two separate burned
rock middens at LA137971. The extent of the discard piles suggests
repeated use of the same site. The sandy depression between the two
middens is also consistent with the practice of excavating the floor of a

sweatlodge to some extent (Jett and Spencer 1981:193).

Like LA 137970 and LA 137972, LA 137971 is located at a point
where access to and from the mesa top is relatively easy, and like the
others, may represent ceremonial purification carried out before
returning to the habitation areas located closer to the pueblito. No
artifacts indicative of a date were encountered at the site, but given the
dates for the surrounding sweatlodge sites, it appears likely that it dates
to the Dinétah or Gobernador phase, and is in all probability

contemporary with the other sites located on the same bench.

Maps: See Figure 8.17.
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LA137972

Site Type: Sweatlodge discard pile and associated ceramic scatter

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137972 is located at the base of a talus slope that adjoins
the top of Superior Mesa. It is located close to LA 137971, and
approximately 250 meters from the Overlook Site pueblito. The
vegetation in the area consists of sparse pinyon and juniper and an

understory of blue grama grass and sagebrush.
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Description: The site consists of a burned sandstone midden typical of
a sweatlodge discard pile, and a scatter of Dinétah Gray ceramic sherds,

most of which are spread over a 4 x 5 meter area.

Interpretation: LA 137972 is a single-component Navajo sweatlodge
site and associated ceramic scatter, consisting of 36 Dinétah Gray
sherds. It is located not far from LA 137979, LA 137970 and LA 137971,
and is likewise considered to be connected with ritual purification
activities by individuals returning to the habitation areas from abroad.
Based on the presence of Dinétah Gray sherds, the site is dated to the

Dinétah or Gobernador Phase of Navajo occupation.

Maps: See Figure 8.18.
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LA 137973

Site Type: Burned forked-pole hogan and associated artifact scatter

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase
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Location: LA137973 is located in the middle of a wide section of the
bench that contains the Overlook Site pueblito, is 200 meters from the
pueblito itself, and approximately 100 meters from LA 137968. It is
located in an area of pinyon-juniper woodland with an understory of
grama grass and sage brush that characterizes the majority of the bench.
The area is relatively level, loose sand. A small ephemeral wash runs
along the southeast corner of the site and some erosion of artifacts into

this wash has occurred.

Description: The site consists of a number of burned wooden stubs set
in a roughly hemispherical pattern encompassing a charcoal stain. A
light scatter of ceramics and flakes were also encountered on the site, as
was a small (40 cm diameter) cluster of nine pieces of burned sandstone,
that may represent a small extramural hearth. An artifact concentration
containing twenty-three Dinétah Gray sherds, two flakes and a piece of
angular shatter in an area 6 x 7 meters is located slightly to the south
and downslope of the charcoal concentration. The absence of bone or
charcoal in this area suggests that these artifacts may have been
dispersed through erosion and sheet wash, rather than representing a

deliberately-created midden.

Interpretation: LA 137973 is a single-component protohistoric
habitation site consisting of a single burned forked-pole hogan and

associated artifact scatter. The presence of Dinétah Gray sherds on the
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site suggest that it dates to the Navajo Dinétah or Gobernador Phases.
Like LA 137968, it was likely occupied by members of the same Navajo
“outfit” which made use of the pueblito. An alternative interpretation
suggests that the site, which is located farther back on the bench than
some of the other hogan sites, may have been used during the winter

when the additional shelter from winter winds would have been welcome.

Maps: See Figure 8.19.
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LA 137974

Site Type: Collapsed sweatlodge and associated discard pile

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137974 is located near the base of a talus slope abutting
the top of Superior Mesa, and is located in one of the two areas where
access from the top of the mesa to the bench is relatively easy. The site
is approximately 75 meters from LA 137975, and about 250 meters from
the Overlook Site pueblito. The vegetation in the area is primarily

sagebrush and blue grama grass, with associated pinyon and juniper.

Description: The site consists of a radiating pattern of poles covering an
area approximately 2.5 meters in diameter—the remains of a collapsed
Navajo sweatlodge—and a midden of burned sandstone representing the

associated discard pile.

Interpretation: LA 137974 is a single-component protohistoric site
consisting of a collapsed, but still extant, Navajo sweatlodge, associated
discard pile, and a light artifact scatter. On the basis of the four Dinétah
Gray sherds found on the site, it is dated to the Dinétah or Gobernador
Phases. Like LA 137970, LA 137971, LA 137972, and LA 137975, it is
located in an area where access to and from the top of Superior Mesa is
relatively easy, and is believed to have been similarly employed by

residents returning residents to the habitation areas located more
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centrally on the bench. The remaining timbers in the sweatlodge are too
eroded for dendrochronology, but a species determination may still be
possible. As the type of wood used was dictated in some instances by the
type of ceremony a sweatlodge was to have been used for (Jett and
Spencer 1981:194-196), species determination may provide an indication
not only of the ceremony type, but also an indication of seasonality,
because performance of some ceremonies was limited to specific times of

the year.

Maps: See Figure 8.20.
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LA 137975

Site Type: Sweatlodge discard pile

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: Like nearby LA 137974, LA 137975 is located at the base of a

talus slope leading to the top of Superior Mesa, and near one of the two
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areas where access to the top of the mesa is relatively easy. The site is

located about 250 meters from the Overlook Site pueblito.

Description: The site consists of a burned sandstone midden flanked by

a charcoal concentration and two scattered flakes.

Interpretation: LA 137975 is located not far from LA 137974 and is
likewise a single-component sweatlodge site. Only the discard pile and a
charcoal stain remain. Like the other sweatlodge sites found in the
Overlook Site Survey Area during the 2002 survey, it is located where
access to and from the mesa top is relatively easy. This site, along with
LA 137974, may have been used by residents returning to the apparent
habitation site at LA 139975, a short distance away. No direct evidence
for a date for this site exists, although it is believed to date to the
protohistoric Navajo Dinétah or Gobernador Phases. Although this site
is located in quite close proximity to LA 139975, it is screened from the
habitation site by a bend in the cliff face, the presence of several large
sandstone monoliths providing the privacy dictated by Navajo tradition

for sweats (Russell 1983:43).

Maps: See Figure 8.21.

www.manaraa.com



127

N

Scale

2 4
meters

F Flake

\ ) Sweat Lodge Discard Pile
( \) Charcoal Conentration

-

@ Site Datum

Figure 8.21 Map of LA 137975.

LA 139975

Site Type: Artifact concentration and charcoal stains, probable burned

forked-pole hogan

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 139975 is located in a small alcove along the cliff leading
to the top of Superior Mesa, at the bottom of the talus slope. Itisin a
more heavily-wooded spot than is evident in the surrounding area, and

which is fed by a small ephemeral stream. The vegetation consists of
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pinyon and juniper, with an understory of blue grama grass and a few
stunted sagebrush. In spite of its proximity to LA 137975 (a sweatlodge
discard pile), the two sites are concealed from each other by the curve of

the cliff wall and a series of large sandstone monoliths.

Description: The site consists of one large (4 x 7 meter) charcoal stain,
through which are scattered a large number of sherds, a smaller number
of flakes, and a single broken white chert scraper. An unmodified grey
chert nodule was also found at the site. Two other, smaller charcoal
concentrations are located nearby, one approximately 30 cm in diameter,
the other ca. 1 meter. A few flakes and a sherd were found outside of the

confines of the largest charcoal stain.

Interpretation: LA 139975 is a single-component artifact scatter and
associated charcoal stains (one large and two more of very limited
extent). Given the high concentration of artifacts in the largest charcoal
stain, it appears probable that this represents a burned forked-pole
hogan, with the smaller (1 meter diameter) charcoal stain perhaps
marking the location of an extramural hearth. The interruption in the
line of sight between the nearby sweatlodge (LA 137975) and this site
would have permitted both to have been used at the same time, and still
be in keeping with Navajo traditional proscriptions about intervisibility

between sweatlodges and habitation areas (Jett and Spencer 1981:196).
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The presence of Dinétah Gray sherds on the site clearly indicate that it is
protohistoric Navajo, and dates to either the Dinétah or Gobernador
Phase. It is likely that this habitation site is related to the others in the
area, and may represent another member of the same Navajo “outfit”
which made use of the pueblito. Alternatively, its location in a
constricted alcove in the cliff face suggests that it may represent a more
sheltered winter location for one of the families occupying the more

exposed hogans during the summer.

Maps: See Figure 8.22.
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Overlook Survey Isolated Occurrences

Five isolated occurrences were encountered in the Overlook Survey

Area. The are presented in Table 8.1.
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Table 8.1 Isolated Occurrences in the Overlook Survey Area.

Isolated Occurrence | Description:

#:

OV-1O-1 White chert flake

OV-IO-2 Gray chert flake

OV-10-3 Gray chert flake

OV-10-4 1 Gray chert flake and 1 white chert flake

OV-1IO-5 Broken bifacial scraper of white chert
Discussion

The extent of the pueblito complex surrounding the Overlook Site,
with its seven (possibly eight) hogans, six sweatlodges, and petroglyph
panels, is comparable to that found at other high-elevation pueblito sites
(see discussion in preceding chapter).

The mesa location and the extent of the complex suggest that the
Overlook complex served as a year-round habitation area for a Navajo
“outfit.” The same group may have also made limited use of the canyon
bottom below, possibly including the Foothold Ruin Pueblito Complex,
which is visible from the Overlook Site pueblito. Both sites could
therefore have been in use contemporaneously—the Overlook Site
pueblito was built in the late 1720s, and Foothold Ruin in the early

1740s. It is worth noting that the only cutting date from Foothold Ruin
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dates from the 1720s (NLC-1357:1720 comp), and that the Navajo Land
Claims researchers collected one sample dating to the 1740s from a
windbreak at the Overlook Site (1741+G) (Ababneh et al. 2000:282;
Towner 1997:191, 245). Simultaneous occupation is therefore entirely
possible, and may represent occupation by members of the same, or
related, outfits, as postulated by Ababneh et al. (2000:284). If this were
the case, it would have allowed residents at one complex to be
immediately alerted to the plight of residents of the other complex, in the
event of attack.

Such a conclusion is not entirely at odds with Towner et al.’s
(2001:85-86) postulation that mesa top sites, such as the Overlook Site,
and others in the area were constructed in response to Spanish
incursions, and later canyon bottom sites such as 42 Pueblito and
Foothold Ruin were built in response to a change of threat and alteration
in enemy tactics, as the canyon bottom sites could have formed an
adjunct to, rather than a replacement of, the defenses provided by the
mesa top pueblitos. Continued use of the mesa top pueblito complexes,
in conjunction with the smaller, canyon bottom defensive sites would be
entirely in keeping with the documented pattern of Navajo land use in
Canyon del Muerto (James 1976:1—See discussion in Chapter 7).
Winter and Hogan (1992:310) indicate that “the historic Navajo dual-
residence pattern of lowland summer camps and highland winter hogan

clusters has considerable antiquity in the region.”
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The four (or possibly five) hogans adjacent to the Overlook Site
pueblito are quite closely spaced, a pattern which initially would appear
to be somewhat at odds with traditional Navajo practice (Jett and
Spencer 1981:7). Jett and Spencer, however, describe homesteads
belonging to a single Navajo outfit as forming a “straggling
agglomeration” (1981:9). Nor do all of the hogans at the site necessarily
represent contemporaneously occupied structures—old hogans were
often converted to storage structures by plugging up the smoke hole, or
used to shelter livestock (Jett and Spencer 1981:21, 155). Hogans were
also occasionally built specifically for storage (Jett and Spencer 1981:21).
(The eroded condition of some of the hogans at the Overlook site
precludes determination of whether they were specifically built as storage
structures, based on the presence or absence of charcoal.) In either case
the proximity of the abandoned hogan to the occupied one would be an
advantage. In some instances, hogans were built for the performance of
specific ceremonies, such as the Mountaintop Way (Jett and Spencer
1981:59). As Magers indicates, “a major problem in discussing Navajo
habitation sites and social structure is the problem of distinguishing true
multi-hogan sites from instances of sequential site occupation,” (Magers
1981:247).

This same pattern of closely-spaced hogans has been encountered

by Marshall (1991) at the Hooded Fireplace Complex (LA 5662), the Split
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Rock Complex (LA 5664), the Frances Canyon Complex (LA 2135), the
Crow Canyon Complex (LA 77871, LA 7783, and LA 77880) and at
Hadlock’s Crow Canyon Complex (LA 77877 and LA 77878). The close
spacing of the hogans at these pueblito complex sites could be
attributable to the same defensive considerations which prompted the
construction of the pueblitos themselves, allowing the hogan residents to
flee to the pueblitos when danger threatened, as is suggested by the
Navajo name for pueblito, yah a’na honidzo , “people repeatedly take
refuge inside” (Jett and Spencer 1981:204).

Given the relatively short use-life of the typical Navajo hogan—
which, based on historical and ethnographic evidence, is estimated at
approximately ten years (Dykeman 2003:393; Russell 1983:41)—it is
possible that the hogans at the Overlook Site (LA10732) may represent
serial occupations by a single nuclear family. Although determination of
hogan diameter from the collapsed remains found at the site is somewhat
equivocal, there does appear to be a tendency toward increased diameter,
with Hogan 3 being the smallest, and Hogan 4 the largest. This trend is
particularly pronounced if the stone circle at the Overlook Site also
represents the remains of a forked-pole hogan. This postulated pattern
of increasing diameter could be accounted for by the needs of a growing
family, as more floor space was required for sleeping as children grew in
both number and stature. (Bullard [1962:123] indicates that the average

adult requires 1.5 square meters of floor space for sleeping.)
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The advanced deterioration of possible timbers associated with the
stone circle—if it does in fact represent the first hogan built at the site—
could be accounted for in part by re-use of timbers from the abandoned
hogan in the construction of later structures (Jett and Spencer 1981:15).

The Dinétah Dating Project did not take tree-ring samples from the
hogans at the Overlook site (Towner 1997:244), and only four of the eight
samples taken by the Navajo Land Claims researchers were datable, with
only one yielding a cutting date of 1727G (NLC-1386). The remaining
dated samples (NLC-1380, NLC-1381, and NLC-1384) dated to 1726inc,
1723inc, and 1682inc, respectively (Towner 1997:244). Unfortunately, it
is unclear which of the hogans these dates refer to, and therefore re-
sampling of the hogans at the site will be necessary in order to determine
their order of construction.

In the discussions of LA 137969, LA 137970, LA 137971, LA
137972, LA 137974 and LA 137975, reference has been made to their
locations in areas of “relatively easy access” from the mesa top. This
statement requires some clarification, however, as “ease of access” is
relative, and refers only to pedestrian access. The areas in which these
sites are located are at the bases of talus slopes strewn with very large
sandstone boulders, the slopes of which have a grade of some 65
percent, elsewhere, the grade is less, approaching 30 percent. In neither
location would access on horseback, or even by mule, be possible. There

are areas within a few hundred meters to the northwest and southeast of
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the study area, along the mesa rim, where mounted access could be
possible.

Towner et al. (2001:112-113) indicate that the Navajo, in contrast
with their Ute enemies, did not have large numbers of horses, which may
cast light on the symbolism of the unmounted and mounted, apparently
non-Navajo, figures in the petroglyphs at LA 137969.

The possible “ceremonial complexes” alluded to, consisting of LA
137969, LA 137970, LA 137971, and LA 137972, as well as the similar,
smaller, two unit complex to the north, consisting of LA 137974 and LA
137975, are believed to have developed through repeated use of the area
for ceremonies. They should be considered in this light, rather than
being construed as deliberately established as a network of sites. This
pattern of sweatlodge concentration at the base of the cliff leading to the
mesa above has likewise been observed by other surveys (Dykeman

2003:398-400; Sesler, Hovezack and Wilshusen 2000:192-193)
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9 Foothold Ruin Survey Area

The Foothold Ruin Survey Area was centered on the Foothold Ruin
pueblito (LA 9073), a two-room masonry structure that is located on a
large sandstone boulder near the base of Superior Mesa, on the north
side of a rincon (Figure 9.1). The pueblito originally had two ground-floor
rooms at the base of the boulder, and one on the boulder top.

The Foothold
Ruin Survey Area is
located on the canyon
floor at the mouth of
the second major
rincon on the east side
of Palluche Canyon.
The setting is quite
similar to that in the
42 Pueblito Survey
Area. The single
ephemeral stream that

drained the Overlook

Survey Area on the Figure 9.1 Foothold Ruin
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mesa above also flows through the middle of the Foothold Ruin Survey
Area. As at 42 Pueblito, the majority of the survey area encompasses a
relatively level portion of the canyon floor, flanked on the east and north
by steep talus deposits and the cliff face, providing the site with a south
and west aspect. The talus slopes at Foothold Ruin are considerably
narrower, steeper, and more sparsely vegetated than at 42 Pueblito, and
the talus boulders are considerably larger, many being more than 10
meters square. As a consequence, the pinyon-juniper woodland is
largely constrained to a narrow band near the interface between the talus

and the more level canyon floor.

The Foothold Ruin site was re-recorded and mapped as part of the
project. The survey of the area around the pueblito resulted in the
recording of five new archaeological sites (LA 137976 to LA 137979 and
LA 139976--Figure 9.2). In addition to these sites, the survey also located
an isolated axe-cut tree and one small boulder-top rock alignment that is
believed to be modern, and which was recorded as an isolated occurrence

(Table 9.1).
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Figure 9.1 Map of Foothold Ruin survey area.
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Foothold Ruin: LA 9073

Foothold Ruin was initially recorded by Navajo Land Claims
researchers in 1957, and again by David Snow of the Museum of New
Mexico in 1969. It was documented by Margaret Powers and Byron
Johnson for inclusion in the National Register of Historic Places in 1985-
86 (Powers and Johnson 1987:61). Tree-ring samples were taken for
dating by the Navajo Land Claims researchers and again by Ronald
Towner of the University of Arizona (Powers and Johnson 1987:61;

Towner 1997:190).

The pueblito consists of a single masonry room atop a large
sandstone boulder 3-5 meters high, near the base of a talus slope below
Superior Mesa. Some of the roof vigas remain in place, and the remains
of a hearth are evident in the south end of the room. An additional two
ground-floor rooms are located at the base of the boulder, and a wall
section extending south from the boulder may be the remains of a third
ground-floor room, but its purpose is unclear (Towner 1997:190; New
Mexico Cultural Resources Information System, 2002). The boulder-top
room is accessed by means of a series of hand- and toe-holds pecked into

the side of the boulder, from whence the site draws its name.

Towner concluded that the suite of tree-ring dates, in conjunction
with architectural analysis, indicated that the pueblito was built in at

least two construction episodes, beginning in approximately 1739. He
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indicated that the boulder-top structure was built first, with work on the
lower rooms conducted a year or more later, in the 1740s (Towner

1997:190-191).

One collapsed forked-pole hogan and a stone circle—believed to
represent the remains of a second hogan--were originally recorded by the
Navajo Land Claims researchers, and tree-ring samples taken from the
former (New Mexico Cultural Resources Information System). Neither
Powers and Johnson (New Mexico Cultural Resource Information System,
2002), Towner (1997:191) nor the 2002 survey crew were able to relocate
the hogan or the stone circle, and they are presumed to have been

destroyed or buried in the intervening years.

The Foothold Ruin pueblito was extensively mapped by Powers and
Johnson for the National Register nomination, and so the structure itself
was not re-mapped during the present field work. The 2002 team
mapped the boundaries of the artifact scatter around the pueblito (the
original site boundaries established in 1987 were approximate, and
based on soils) in order to provide a more accurate delineation of the

site’s extent (Figure 9.3).
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Figure 9.2 Map of Foothold Ruin (LA 9073).
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LA 137976

Site Type: Rock cairns

Cultural-Temporal Affinity: Unknown

Location: LA 137976 is located near the mouth of the rincon which
houses Foothold Ruin, on the north side of the rincon, near the base of a
talus slope. Vegetation consisted of very sparse pinyon and juniper,
sagebrush, blue grama grass, Indian rice grass, prickly pear cactus, and

purslane.

Description: The site consists of two rock cairns, the larger
approximately 2.5 meters in diameter and 25 cm high, and the smaller,
located a few meters to the southwest, approximately 0.9 x 0.6 meters in

diameter, and consisting of just a few stones.

Interpretation: LA 137976 is a simple, single-component site consisting
of two rock cairns, one larger, separated by a few meters from another
smaller cairn to the southeast. Due to the lack of distinguishing
features, it is impossible to assign a date or a cultural affiliation to this
site. The general lack of accumulated alluvium over the site suggests
that it may not be Anasazi or earlier in date, although this cannot be
considered definitive, and the likelihood is that it dates from the Navajo,

Hispanic, or Euro-American occupation of the area.
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Maps: See Figure 9.4.
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Figure 9.3 Map of LA 137976.

LA 137977

Site Type: Collapsed forked-pole hogan and two (possibly associated)

axe-cut trees

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137977 is located near the base of a talus slope and next
to a small ephemeral wash, in a sparse pinyon and juniper woodland.
Sagebrush, blue grama grass, purslane and Indian rice grass also grow

on the site.
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Description: The site consists of a collapsed forked-pole hogan with
radiating poles still evident (Figure 9.6). Two axe-cut stumps, possibly

dating from the construction of the hogan, are also located nearby.

Interpretation: LA 137977 is a single-component protohistoric site,
consisting of a single typical collapsed Navajo forked pole-hogan and two
axe-cut stumps, which may date the construction of the hogan. No
artifacts were found in association with this site, which is believed to
date to the Dinétah or Gobernador Phase of the Navajo occupation of the
canyon. The potential exists for dendrochronology to further narrow this
time frame, as well as establishing the contemporaneity, or lack thereof
of this structure with the nearby Foothold Ruin, as well as determining
whether the axe-cut stumps on the site relate to the construction of the
structure. It is likely that this site was occupied by the same Navajos
who used of the pueblito as a refuge; it may have been a seasonal
habitation associated with the cultivation of agricultural fields in deep

alluvium of the rincon.

Maps: See Figures 9.5 and 9.6.
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LA 137978

Site Type: Sweatlodge discard pile

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA 137978 is located at the base of a talus slope, well-hidden
among a dense stand of pinyon and juniper, and camouflaged by a

number of large boulders.

Description: The site consists of a burned sandstone midden near the

confluence of two small ephemeral washes.
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Interpretation: LA 137978 is a single-component Navajo sweatlodge, of

which only the discard pile remains. No artifacts were located in

association with this site, which is believed to date from the protohistoric

Dinétah or Gobernador Phases. It is likely that this site was utilized by

the inhabitants of the pueblito complex, as it is located in an area

intermediate between the hogan at LA 137977 and the pueblito, but is

screened from the view of both by a slope, a jumble of large boulders,

and a thick growth of trees.

Maps: See Figure 9.7
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LA 137979

Site Type: Artifact Scatter

Cultural-Temporal Affinity: Navajo, Gobernador Phase

Location: LA 137979 is located on the floor of the rincon in which
Foothold Ruin is located, and unlike other sites in the area, is somewhat
removed from the canyon walls. The surrounding vegetation consists of

greasewood, sagebrush, blue grama grass, and purslane.

Description: The site consists of a loose scatter of artifacts over an area
some 11 by 15 meters. Artifacts on the site consisted of two gray chert
flakes, twelve Dinétah Gray sherds, and four Gobernador Polychrome

sherds.

Interpretation: LA 137979 is a single-component protohistoric Navajo
artifact scatter, and based on the presence of Gobernador Polychrome
sherds, dates to the Gobernador Phase. No evidence of any structures
were found in the vicinity, but it is possible that all traces of an
ephemeral structure, such as a ramada, have been obliterated. The site
is located at some remove from the other sites nestled along the base of
the cliff, and is in a relatively level area, and located between two
ephemeral streams flowing down from the mesa top. Such a location

would be ideal for agriculture, and LA 137979 is interpreted as an
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activity area, perhaps associated with agricultural undertakings in the

rincon.

Maps: See Figure 9.8.

DD

Fp D

}

N
Scale

1 2
meters

D Dinetah Gray Sherd

G Gobernador Polychrome Sherd
F Flake

@ Site Datum
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LA 139976

Site Type: Sweatlodge discard pile

Cultural-Temporal Affinity: Navajo, Dinétah or Gobernador Phase

Location: LA139976 is located on a small knoll at the base of a talus
slope, near the confluence of three ephemeral washes, and in close
proximity to Foothold Ruin. Vegetation in the area consists of sparse
pinyon and juniper, with an understory of sagebrush, blue grama grass,

and purslane.

Description: The site consists of a pile of burned sandstone typical of a

sweatlodge discard pile.

Interpretation: LA 139976 is a single-component Navajo site consisting
of a sweatlodge discard pile. No artifacts were found in conjunction with
the site, although it is likely to date to the protohistoric period. The
location of this site is somewhat unusual, as it is in close proximity to
the pueblito, and to the adjacent and now-obliterated hogans recorded by
the Navajo Land Claims researchers. If the two sites were
contemporaneous, an individual conducting a sweat would likely have
been visible to those in the habitation area, a circumstance generally
proscribed by Navajo tradition. The possibility exists, of course, that the
sweatlodge either pre- or post-dates the use of the pueblito-area

habitations, and their lack of preservation, in contrast with that at LA
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137977, may suggest that the hogans adjacent to the pueblito were

abandoned, and a new residence established at LA 137977 (although

differential preservation may be a factor as well.) The pueblito and

associated hogans date to the late Gobernador Phase (Towner

1997:1991), and the sweatlodge site may date to either the Dinétah or

Gobernador Phase occupation of the canyon, but is unlikely to have been

in use contemporaneously with the pueblito and nearby hogans.

Maps: See Figure 9.9.
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Foothold Pueblito Isolated Occurrences

Two isolated occurrences were encountered in the Foothold Ruin Survey

Area. They are presented in Table 9.1.

Table 9.1 Foothold Ruin Survey Isolated Occurrences.

Isolated Occurrence Description:

#:

FH-IO-1 Small, loose pile of rocks along margin of low
boulder. No evidence of mortar. This appears
to be a modern juvenile effort to erect a
“pueblito,” and is not believed to be
archaeological.

FH-10-2 Axe-cut stump

Discussion

Many of the remarks in the discussion of the 42 Pueblito Complex
are applicable to the Foothold Ruin Complex. The ostensibly limited
extent of the complexes may be a function of more limited, possibly
seasonal (summer), use, or alternatively may be a product of taphonomic
processes resulting in the burial of sites by alluvium and colluvium. As
noted previously, in total only three canyon-bottom pueblito complexes
(42 Pueblito, Foothold Ruin and Simon Canyon) have been subjected to
extensive survey. Until further surveys of such sites are carried out, the

sample remains too small to draw any definitive conclusions.
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The presence of a datable hogan at the site, as well as three
standing axe-cut trees, may help resolve questions still surrounding the
dating and seasonality of the Foothold Ruin Complex, depending upon
the degree of preservation and the extent of seasonal ring formation in
the samples. Dendrochronological studies of this site also have the
potential to provide further insight into the question of contemporaneity
of use of the Foothold Ruin Complex and the Overlook Site Complex,
which is visible on the mesa above. Although thirty-nine tree-ring
samples were taken at Foothold Ruin by the Navajo Land Claims and
Dinétah Dating Project researchers, only one cutting date (NLC-1357:
1720comp) was obtained. Of the remaining dates, only a few were near-
cutting dates, and only weak date clusters were observed (Towner
1997:190-191). It does appear, however, that one of the now-vanished
hogans adjacent to the pueblito may have been constructed much
earlier, although probably not as early as the 1710+ date (NLC-1350)
would suggest. Towner indicates that the Foothold Ruin Pueblito was
likely constructed in the late 1730s or early 1740s (Towner 1997:191),
but use may have been made of the complex area for habitation, with the
pueblito being built later, in response to the changing enemy aggression
(Towner et al. 2001), as alluded to in the discussion of the Overlook Site
Complex.

In a different vein, a small number of the Navajo ceramics (both

Dinétah Gray and Gobernador Polychrome) encountered in the Foothold
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Ruin Survey Area exhibited a peculiar pattern of spalling, which appears
to have resulted from the expansion of minute white inclusions in the
paste or temper. This spalling appears to be very similar to that which
results from the presence of calcium carbonate in the vessel body, and
which is caused by a post-firing chemical reaction with atmospheric
moisture that forces minute spalls from the vessel surface (Shepard
1954:22). The presence of this phenomenon in a number of the sherds
in the area may cast light on the ceramic construction practices of the
inhabitants at the site, including the specific clay (or less likely, temper)
source employed, as such spalling often results from the presence of
minute fossiliferous inclusions in the clay body (Arnold 1985:24-26;
Shepard 1954:22). (A number of clay veins are visible eroding from the
canyon walls in Palluche Canyon.) No mention of this phenomena has
been made in previous studies of Navajo ceramics, and it may be

incidental, and specific to this site.
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10 Ethnographic Evidence of Navajo-Puebloan Co-Residence

Close scrutiny has been made of the Spanish historical accounts
regarding population movements among the Puebloans and the Navajo in
the aftermath of the Pueblo Revolt and reconquest (Hogan 1991;
Schaafsma 2002). Little or no consideration, however, has been given to
the oral historical accounts of those cultures directly involved. Reasons
for omission may be multiple, including hesitancy among archaeologists
to accept the historicity of oral accounts.

The Navajo in particular were located on the perimeter of Hispanic
influence, and their resistance to missionization contributed to the spotty
nature of historic Hispanic records of their activities. This, combined
with marked bias on the part of Spanish recorders, deliberate distortion
of the contemporary records (Brown 1996:55; Schaafsma
2002:226,253,277-278), and simply erroneous accounts may render the
written Hispanic “histories,” in spite of their appeal to the Euro-American
archaeologists’ instincts, little more reliable than indigenous oral
histories.

Admittedly, Native American oral histories lack the calendrical
precision that Euro-American researchers are accustomed to thinking of
as “histories.” None the less, the accuracy of the events which they
portray—although sometimes couched in legendary language—is often

quite remarkable.
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Written histories, oral histories, and archaeologically-constructed
“histories,” each suffer from their own inherent limitations, and the
greatest accuracy in reconstructing proto-historic events may result from
recourse to all three.

As noted above, a review of the Hispanic historical records
pertaining to possible Puebloan population movements into the Dinétah
area after the Spanish reconquest of New Mexico has already been
undertaken (see Hogan 1991). The bulk of this thesis addresses the
archaeological evidence regarding the arrival of Puebloan refugees in
Dinétah. This chapter, however, focuses upon the oral historical record.

Given that a thorough review of the oral histories of all Puebloan
groups, in addition to the Navajo, is beyond the scope of this thesis,
some use was made of historical records in narrowing the field of study.
Hispanic records indicate that the western Pueblos (Zuni, Acoma, and
the Hopi Mesas) were sufficiently distant from the Rio Grande to remain
largely unaffected by the Pueblo Revolt and subsequent reconquest,
other than by serving as destinations for refugees from the eastern
pueblos. Hogan’s (1991:21) review of population movements between
and from the eastern pueblos suggests that the groups most likely to
have contributed refugees to the Dinétah area were members of the Towa

and Tewa linguistic groups. Accordingly, it is the oral histories of the
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peoples of Jemez and the Tewa pueblos, in addition to the Navajo, which
were selected for review.

As previously noted, archaeologists have been notably reluctant to
make use of the information provided by oral histories. In spite of this

hesitancy, Dorothy Keur (1941:11) has observed that:

If used cautiously, backed by historical records and ethnological
and archaeological data, mythology may be useful in shedding
some light on the location of points in Navajo cosmography, their
migrations, and mingling and intermarriage with the Puebloans

and other peoples.

A. V. Kidder’s initial suggestion that the pueblitos may have been
constructed by Puebloan refugees had its genesis in an observation by

Adolf Bandelier (1892:216):

This [1696] defeat...caused the Jemez to flee to the Navajo
Country...for several years the Jemez remained among the Navajos
until they finally returned to their old range, establishing

themselves at or near the site of their present village.

Although the above quotation from Bandelier is from a Euro-
American historian, and it is unclear who or what Bandelier’s original
source(s) may have been, the possibility exists that he was reporting oral

history which existed among the Jemez in the late nineteenth century.
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Towa and Tewa Oral Histories

Due to the paucity of ethnohistorical studies among the Jemez and
Tewa (in spite of the fact that both groups have produced noted
anthropologists), it is difficult to ascertain precisely the meaning of the
original information Bandelier may have been given. The phrases
“Navajo Country” or “among the Navajos,” however, should not
necessarily be construed to mean that the Jemez were living within
Navajo communities, as Kidder (1920:328) indicates, “Gobernador
Canyon is in the old Navajo Country.” Even the presence of hogans at
the pueblito sites was not deemed by Kidder (1920:328) to be conclusive
evidence of co-residence, as he remarks, “the presence of the hogan-like
structures at the ruins...seem surely to point to contact with the Navajo.”
He refrains, however, from specifying the nature of such contact.

The characterization of the San Juan drainage as “Navajo Country”
appears to have been standard practice, as Frank Wozniak observes, that
the Abiquiu reservoir “appears to have been within what was loosely
known as Navajo country in the early seventeenth century” (Wozniak
1992b:52). The phrase “Navajo country” appears again in oral history
from among the Jemez, recorded by Albert Reagan (1927:726) in the

1920s:
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Against the place on the mesa [Astialakwa] both in 1694 and 1696
they [the Spaniards] came with their cannon, and after a many
days battle each time they captured it, reducing it, finally, to the
mass of ruins it is to this day. Furthermore, at each of these times
some of our people escaped to the Navajo country, but the greater

part of them were captured and reduced to a state of servitude.

Frank Wozniak (1992b:10) observed that “it does not necessarily
have to have been in the heart of their country, merely in the area they
claimed for traditional use.”

The question of the nature of the inter-ethnic contact between the
Jemez and the Navajo has been somewhat confounded by a statement by
anthropologist E. C. Parsons in which she recounts that “Hemes [Jemez]
became Navajo in Long Canyon [Largo Canyon]” (Parsons 1925:3), a
statement repeated by Paul Reiter (1938:38).

The anthropologist and historian Joe Sando, himself a Jemez

Indian, provides this clarification of Parson’s statement:

At this time [1696], some of the Jemez returned to their ancestral
homeland in the northwest, in Canyon Largo and Stone Canyon
(Gy’a-wahmu). Others went to An-yu-kwi-nu (Lion Standing
Place), to the west of Jemez in the Navajo country. These people
lived among the Navajo for a considerable number of years. Many

also escaped to Hopi. (Sando 1992:75).
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Adolf Bandelier placed the location of An-yu-kwi-nu between the
Rio Salado and the Rio Jemez (Hogan 1991:13), which therefore located
the Jemez who sought refuge there east of the continental divide, and
some considerable distance from contemporary Navajo population
centers. The use of the term “among the Navajo” in Sando’s account is
notable, as the term “Dinétah,” the Navajo word for the area
encompassing the Largo and Gobernador drainages means, “among the
(Navajo) people” (Brugge 1968:16). Thus the reference to living “among
the Navajo” may be an indication that they were living “in Dinétah” or in
the Largo and Gobernador drainages, precisely as indicated by Sando.

Sando (1982:121) notes elsewhere:

[T]he defeated Hemish [Jemez| and their allies scattered into the
mountains...the Hemish fled with their families to their ancestral
homeland in the northwest, Canon Largo, or Gy’ a-wahmu (“stone
canyon”). Others went to Anyu-kwi-nu (“lion standing place”) to

the west, in Navajo country...

Many of the people who fled evidently lived among the Navajos for
many years before they returned, others never returned, but
became a part of the Dinéh [Navajo], with Hemish traditions.
These descendants are identifiable today as being of the “Maii
Deesh-giiz-nii” clan, this and the Navajo name for Jemez today
come from the name of the Coyote Clan, whose members remained

in the Navajo country.
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In spite of Sando’s credentials as a Jemez and as a historian, the
source for the above quotation appears to be drawn, not solely from oral
tradition, but from a variety of sources, including Spanish historical
documents, an erroneous understanding of Navajo ethnohistory, and
conceivably from knowledge of Bandelier’s own statement. Sando’s most
significant argument for the presence of Jemez refugees among the
Navajo is the presence of the “Maii Deesh-giiz-nii” or Coyote Clan, which
has its roots in a Jemez ancestor. (There are two Navajo clans that could
be referred to as the “Coyote Clan.” The Maii Deesh-giiz-nii, the actual
name of which is the “Coyote Pass” clan, should not be confused with the
“MaitoDiné,” or “Coyote Spring people,” a clan with a completely different
origin, unrelated to the Jemez) (Matthews 1994:151-152).

Sando is correct regarding the existence of the “Maii Deesh-giiz-nii”
among the Navajo, and its Jemez derivation, but may be incorrect
regarding its origin, about which Navajo oral history is very specific.
Sando is not alone, however, as archaeologists have hypothesized that
the Coyote Pass Clan originated from Jemez Indians who fled the Hopi
village of Sichomovi to join the Navajo in Canyon de Chelly (James

1976:14).
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Navajo Oral History

Washington Matthews, the early anthropologist and ethnohistorian
who recorded the origin legend and early tribal history of the Navajo as
told by a number of respected Navajo informants in the 1880s, gives the

origin of the Coyote Pass Clan as follows:

Then a war party was gotten up to attack the people of Jemez
pueblo. On this raid one of the Tlastsini [Red Flat Ground People]
captured a Jemez girl, but sold her to one of the Tse’dzinki’ni
[House of Black Cliffs People]. She was the progenitor of the gens
[clan] of Maidéski’zni, People of Wolf Pass (i.e. Jemez). (Matthews
1994:158)

Elsewhere Matthews translates “Maidéski’zni” as “Coyote Pass”
people (Matthews 1994:30). Because of the matrilineal nature of Navajo
society, the origin of an entire clan can easily be accounted for by a
single clan ancestress (Hogan 1991:17).

One other Navajo clan, added many years before the Coyote Pass
clan, is mentioned as coming from the Jemez area. This is the Klogi
clan. Once again, however, Navajo oral history is very specific as to the

circumstances surrounding the addition of this clan:

[Tlhere was a great famine in Zuni, and some people from this

pueblo came to the San Juan to dwell with the Navahoes...The

www.manaraa.com



164

famine prevailed also at other pueblos, and some starving people
came to the Navahoes from an old pueblo named Klogi, which was
near where the pueblo of Jemez now stands. These formed the
gens [clan] of Klogi, and made special friends of the Tha’paha
[Among the Waters Clan|. (Matthews 1994:145).

This description of Klogi as being near the location of the present
Jemez pueblo does not necessarily indicate that the inhabitants of the
pueblo were Towa. The pueblo of Jemez is located near the confluence of
the Jemez and Guadalupe Rivers, at the extreme south end (and indeed,
somewhat out of) the traditional Towa range, as it was originally
established by the Spanish in an attempt to pacify and indoctrinate the
Towa (Elliott 2002:46). The area around the pueblo of Jemez is near the
junction of the Keresan and northern Tiwa traditional territories, and
therefore the people of the Klogi clan could have originated from any one
of these ethnic groups. The likelihood is high, however, that they may
have been Keresan, as Espejo recorded a pueblo in 1582 which he called
“Gigue.” Onate referred to the same pueblo in 1598 as “Quigui,” and
which was later known as Santo Domingo, and which was abandoned in
1886 (Schroeder 1979:239-244). There is no other reason for postulating
that the Klogi refugees came from Santo Domingo, other than the
geographical proximity to the area specified (Santo Domingo is located
approximately 25 miles east southeast of Jemez) and the similarity of the

names. Whatever the case, the famine which prompted the exodus from
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Klogi appears to be unrelated to the Pueblo Revolt, as it is specified that
this same famine effected a similar emigration from Zuni (Matthews
1994:145). Although famine was certainly a factor in the experiences of
the Rio Grande pueblos during 1695-1696, it was in large part a
consequence of systematic destruction of crops and food stores by the
Spaniards (Barrett 2002:88-89). Zuni, which was largely insulated from
Spanish predations by distance, was not similarly impacted, but rather
served as a refuge for Puebloans fleeing the Rio Grande valley (Hogan
1991:17).

Richard Van Valkenburgh and John McPhee indicate that
ancestors of the Tipezhiini, or Black Sheep clan, “came to the Navajo
from the Pueblo of San Felipe after the Pueblo Rebellion of 1680” (Van
Valkenburgh and McPhee 1938:4), although they do not indicate if this
addition to the tribe was triggered by the revolt, or if their informants
merely indicated that the time period involved was subsequent to the
Revolt period. It should be noted that San Felipe, a Keresan pueblo
located approximately 15 miles southeast of Jemez, may be an
alternative location for “Klogi,” as it is certainly located “near where

”»

Jemez now stands.” Several of the Navajo clans have multiple clan
designations (Matthews 1994:29-31), a factor which is further
complicated by variations in English orthography of the names. It is

possible that the clan Matthew’s informants referred to as “Klogi” was the

same one referred to by Van Valkenburgh and McPhee’s informant(s)—
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whom they do not specify—as “Tipezhiini.” This likelihood is increased
by the fact that a Tipezhiini clan is not included in Matthews’s
exhaustive review of the Navajo clans and their origins (Matthews
1994:138-159).

Such a massive influx of people as postulated by the theory of
Puebloan refugees fleeing to the Navajo—even the relatively low number
of a few hundred postulated by Hogan (1991:16) certainly would not have
gone unremarked in Navajo oral history, yet no mention is made of them.
Nor can it be argued that the clan origin histories relate to a time deep in
prehistory, as the origin of the Nakaidine’ (White Stranger People, or

Mexican Clan) indicates:

About the time they were incorporated by the Navahoes, or soon
after, a party of the Utes [Navajo Ute clan] made a raid on a
Mexican settlement, somewhere near where Socorro now is, and
captured a Spanish woman. She was their slave; but her
descendants became free among the Navahoes and formed the
Nakaidine’ (White Stranger People) or Mexican gens. (Matthews
1994:146).

Clearly, the time period covered by the Navajo clan origin histories
does extend into the protohistoric. (The above citation also illustrates
another example in which a single woman accounted for the formation of
a new clan.) It should also be noted that the sequence of clan accessions

is clearly spelled out, and that the addition of the Nakaidine’ (White
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Stranger People) preceded that of the Maidéski’zni (Coyote Pass Clan) by
at least several years, and probably much longer. Seven years passed
between the accession of the Overhanging Rocks People and the Walked-
Around or Place of Walking People. Four more clans—Two Come for
Water, Zuni, Dildzéhi, and Salt--were added between the addition of the
Walked Around People and the Coyote Pass clan, and during this time
the Navajo were also joined by three groups of Apaches and one of
Paiutes, all of whom were adopted into extant clans (Matthews 1994:146-
158). The oral history, as told to Matthews, also specifies that “some
years passed” (Matthews 1994:158) between the arrival of the last group
of Apaches and the accession of the Zuni clan. Frederick Hodge
(1895:238) has observed that, “the Creation and Migration tradition of
the Navajo is remarkably accurate regarding the chronologic sequence of
events,” and has estimated that the accession of the Nakaidine’ at
approximately AD1650 (Hodge 1895:225).

Additionally, Navajo history indicates that the members of the
Taachii’nii clan were survivors of the destruction of Awatovi who settled
at Black Mesa in Arizona (Begay and Roberts 1996:204; Gilpin
1996:171). Matthews (1994:145-146) records that the members of this
clan (Tha’tsini, in his orthography) came from the west to the San Juan
area, having “escaped in some way the alien gods,” and that their
accession predated even that of the Nakaidine’ (White Stranger People).

This would place the accession of the Maidéski’zni (Coyote Pass Clan)
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after the turn of the eighteenth century, when the destruction of Awatovi
occurred (Plog 1997:193). This date appears to be at odds with Van
Valkenburgh and McPhee’s (1938:5) assertion that the Maidé€ski’zni
(“Miidiisgizhni,” in their orthography) “tell of the killing of the priests in
the kiva and wanderings in their clan tradition.” The accuracy of this
assertion is considerably in doubt, however, as contemporary historical
records indicate that both martyred missionaries to Jemez, Fray Juan de
Jesus in 1680 and Fray Francisco de Jesus in 1696, were killed in the
cemetery near the convento (Espinosa 1988:35, 250), and not in the kiva,
as indicated by Van Valkenburgh and McPhee.

The pueblos of Jemez, Klogi, and Zuni were not the only ones to
contribute clans to the Navajo, although the affinities of the other
pueblos mentioned are not so easily determined. A young woman
captured in a raid on Kinlitsi was the ancestress of the Red House clan.
Two girls were captured in a raid on Saibehogan (House Made of Sand),
and became the progenitors of the Salt clan (Matthews 1994:146).

Although it is not possible to determine precisely when the Coyote
Pass clan came into being among the Navajo, one thing is entirely
clear...it did not come about as a consequence of the Pueblo Revolt. Nor
is there any indication in Navajo oral history of the accession of refugees

from other Rio Grande pueblos.
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Conclusion

Thus there appears to be no concrete ethnohistoric evidence
among the Towa and the Tewa of ethnic co-residence of members of their
tribes with Navajo groups. Nor is there any mention in the precise and
detailed oral history of the gathering of the Navajo clans regarding the
accession of Puebloan refugees to the Navajo, though other non-Revolt
related additions are specified in considerable detail. It appears that, as

Copeland and Rogers (1996:218) have observed:

As far as the Diné are concerned, there were no great and sudden
influxes of aliens into the Diné world. Rather, after Changing
Woman created the Diné, there was a slow but steady joining and

assimilation by various outside groups with them.

Thus, the ethnographic evidence, although it apparently once
formed the basis for Kidder’s “refugee hypothesis,” under further

examination, appears to refute that very hypothesis.
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11 Ceramic Evidence

Ceramic assemblages, due to their durability and their nature as highly
sensitive indices of cultural change, have long been utilized by
archaeologists as evidence of a variety of types of cultural contact,
including migration. Although decorative elements of style—such as
motifs, surface finishes, etc—can be, and are, consciously manipulated
in order to signal affiliation with, or distance from, various social groups,
“technological style” or “isochrestic styles” is less consciously
manipulated. It involves the basic construction techniques involved in
the production of an artifact, and is often linked to learned motor habits
(Arnold 1985:235). This, in turn, affects such vessel characteristics as
shape, temper orientation, variations in wall thickness, and surface
finish (Rye 1981:58-95). Vessel form is a particularly strong indicator of
ethnicity, as it is both readily apparent in the whole pot—and therefore a
means of social signaling—but also heavily influenced by production
technique, and therefore also a form of isochrestic style (Arnold
1985:234-235; Rye 1981:62). For instance, round-bottomed ollas such
as those produced by the Towa, require a specialized support during
vessel formation in order to prevent the bottom from deforming while the
clay is still plastic. Such a practice also results in very standardized
vessel forms, as the support is repeatedly used, and the bases of broken

pots may be used as supports for subsequent pots (Rye 1981:63). By
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contrast, pointed-bottom pots, such as the utility jars produced by the
Navajo, are often the result of supporting the vessel in the potter’s lap
during formation, and the resultant deformation of the still-plastic clay
(K.D. Vitelli, personal communication 1994). Greater variation in vessel
shape is seen in these types of vessels, as the potter’s personal
dimensions and even seated position will vary slightly from vessel to
vessel. Such a practice may well account for the wide variation in Navajo

vessel forms.

Other practices, such as finishing techniques, can also serve to
distinguish vessels created by potters from different ceramic traditions.
A prime example of this is the case of Gobernador Indented, a rare
variant of Dinétah Gray. While this type superficially bears some
resemblance to the partially-obliterated corrugations evident on some
Towa pottery, closer examination indicates that the production
sequences are quite different. Whereas the corrugation on Towa vessels
results from the incomplete obliteration of finger-tip impressions made
when joining the coils together, in Gobernador indented, the finger-tip
impressions are made after the vessels have been thoroughly smoothed,
and are a strictly decorative measure (Hill 1995:101; Reed and Horn
1998:64). Thus although the decorative style evident on the two ceramic
types is quite similar, the technological styles are widely variant.

From the early stages of pueblito research, the presence of

Puebloan decorated wares at pueblito sites has been deemed indicative of
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the presence of Puebloan refugees (Kidder 1920; Mera 1938:237), in spite
of the extremely small quantities of these wares at any given site, and the

fact that:

Southwestern archaeologists have rarely accepted the presence of
small percentages of intrusive pottery as evidence that the people
who manufactured that pottery actually resided with the local
group. Minor amounts of intrusive ceramics almost always are

interpreted as evidence of exchange relations. (Hogan 1991:7)

Thus the problem becomes separating Puebloan ceramics present
at a site due to trade from Puebloan ceramics present at a site because
Puebloans themselves were present at the site.

The occurrence of Gobernador Polychrome (Figure 11.1) at pueblito
sites has, until recently, also been considered evidence for an influx of
Puebloan immigrants to Dinétah (Mera 1938:237). Gobernador
Polychrome, a very highly-fired orange-to-buff ware used to produce
bowls—and rarely jars—was lightly polished and decorated with red and
black, sometimes white, geometric designs and some figurative elements
(Brugge 1963:13-18; Brugge 1981:7-8; Hill 1995:114-115; Marshall
1995:85-90). Because the Navajo were not known to have previously
produced a decorated ware, the development of Gobernador Polychrome
was deemed a product of the influence of Puebloan potters. More recent

research, however, has pushed the initial production of Gobernador
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Polychrome back to approximately AD 1650 (Reed and Reed 1992:99;
Reed and Reed 1996:103), a date which precludes its development as a
result of contact with refugees from the Pueblo Revolt. Gobernador
Polychrome motifs also appear to have been equally influenced by Hopi
and Rio Grande ceramics (Reed and Reed 1992:102), although the
western pueblos were insulated by distance from most of the impact of
the Pueblo Revolt. Clearly, then, the development of Gobernador
Polychrome occurred completely independent of the events of the revolt
and its aftermath.

The problem of detection of immigrant (or refugee) groups from the
archaeological record is not one that is unique to the study of the

southwestern pueblitos:

The recognition of sites or archaeological assemblages formed by
migration and colonization and their differentiation from those
produced by exploration, trade, exchange, invasion, or other forms
of culture contact constitutes a classic archaeological problem.

(Berman and Gnevicki 1995:421)

The same authors caution that, “the application of poorly-
formulated models obscures our interpretation of the archaeological

record” (Berman and Gnevicki 1995:421).
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Figure 11.1 Examples of Gobernador Polychrome sherds from the
42 Pueblito survey area.

Maria Nieves Zedeno has formulated a model of ceramic
assemblages that attempts to distinguish those produced as a result of
trade in goods and exchange of ideas from those created by the
immigration of new cultural groups to a site or region. She envisions a
three-stage progression in the integration of a new ethnic group, which
would be evident in the archaeological record. In this model, newly-
arrived immigrants would bring with them pottery manufactured in their

home region, with the native pastes and tempers of their previous locale.
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At this stage, the ceramic assemblage is likely indistinguishable from one
produced through other forms of culture contact. Once established in
their new area, however, the immigrants would begin to manufacture
pottery using the same techniques as they had always used, but utilizing
pastes and tempers native to the new region. Finally, as a gradual
consequence of co-residence with a new group and exposure to new
techniques, new forms reflecting an amalgamation of the two groups and
the sharing of knowledge would develop (Zedeno1995:132). Anthony

(1990:903) envisages a similar pattern:

Migration will carry regionally defined artifacts from a
circumscribed home region to a specified destination. Innovation
in the new home might then lead to a sort of “founders’ effect”
resulting in rapid stylistic change from what was in any case a

narrowly-defined pool of variability.

Zedeno (1995:132) also notes that:

Because ceramic technology in the American Southwest was not as
readily transferred as design style, visible changes in the
technological characteristics of ceramic assemblage may signal
changes in the ethnic or social makeup of a pottery-making

community.

Although Zedeno’s model was formulated to address decorated

wares in the Mogollon region, it is equally applicable to the question of
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the arrival of a postulated influx of Puebloan refugees into Navajo
communities in the wake of the Pueblo Revolt.

As a refinement of Zedeno’s model, utility wares, rather than
decorated wares, were selected as the focus of study at the pueblito sites.

The rationale behind this was three-fold:

1) Utility wares are less likely to have been subjects of inter-
ethnic exchange (Stark 1995:333), therefore obviating the risk of
mistaking a trade-derived assemblage for one produced by the
arrival of an immigrant group.

2) Utility wares are less obtrusive and less attractive,
reducing the risk of the archaeological record having been skewed
by unauthorized sherd collection at pueblito sites.

3) In keeping with Zedeno’s observation that technological
aspects of pottery manufacture (temper, construction technique,
choice of mineral vs. vegetal paint sources, etc.) are less likely to be
transferred than changes in design style, the same is true of utility
wares, which have generally proven themselves to be remarkably
stable over long periods of time (Stark 1995:333, 336), even when
decorated wares produced by the same ethnic group underwent

rapid innovation and change.

www.manaraa.com



177

Therefore, Zedenio’s model adapted to the current problem of
ceramic evidence of ethnic co-residence at pueblito sites would involve
the appearance of small quantities of foreign utility wares which had
been manufactured in the Rio Grande region and brought by the
immigrants. This would be followed by the appearance of Rio Grande-
style utility wares, produced by immigrant potters, using their traditional
techniques and local materials, and possibly with some concessions to
local conditions, such as the absence of tuff for temper or mica for
inclusion in the slip if those ingredients were not locally available. Given
the relatively short time intervening between the arrival of postulated
Puebloan refugees in the Dinétah region, and the abandonment of the
area—approximately half a century—the likelihood of Zedenio’s third
stage, the development of new hybrid ceramic forms, is low, and does not
form a factor in this iteration of the model.

A functional necessity for the use of this model is the presence of
utility ware types that are sufficiently distinct from one another to make
the determination of cultural affiliation possible. This condition prevails
with Navajo and northern Rio Grande utility wares, as demonstrated
below (see descriptions and Table 11.1). As previously noted (see
Chapter 10), the most likely pueblos to have served as population
sources for refugees emigrating into Dinétah were the Towa and Tewa
pueblos (Hogan 1991:21), and it is the culinary wares from these regions

which were selected for comparison.
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Dinétah Gray (Navajo)

Dinétah Gray (also variously called Dinétah Scored, Dinétah
Utility) generally occurs in jar form, although some bowls have been
found. The jars are elongate, wide-mouthed ollas with an elevated
maximum diameter, with the rim and sometimes the lower body
recurved. The vessels are coiled and scraped, and fired in an
uncontrolled atmosphere, resulting in a core that is light gray or black,
or sometimes buff, brown or red. Similar colors appear on the exterior,
often varying over the surface of the same vessel, as a consequence of the
firing method. The paste is tempered abundantly with quartz sand. Wall
thickness ranges from two to eight millimeters, with the majority in the
three to five millimeter range. The exterior surface is treated by scraping
with a corn cob or wiping with juniper bark, grass, or corn husks,
resulting in distinct striae, usually oriented on the diagonal.
Alternatively, the surface may be left poorly smoothed, or (rarely) lightly
polished. Scattered small mica glints may be visible on the surface, due
to inclusions in the paste. The interior surface is generally wiped with
corn husks or shredded juniper bark, sometimes smoothed or scraped
with a corn cob (Brugge 1981:3; Brugge 1963:5-6; Gerow and Hogan

2000:66; Hill 1995:111; Keur 1941:55; Marshall 1985:183).
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Dinétah Gray is recognized as the earliest form of Navajo pottery
yet found in the Southwest, and appears coincident with the first arrival
of the Navajo in the area. It continued virtually unchanged between the
Dinétah and Gobernador phases, and exhibits only minor stylistic
changes (such as the addition of fillets to the neck of vessels) as it segued

into Navajo Gray, a type still produced by the Navajo (Brugge 1981; Hill
1995).

\) U |

Figure 11.2 Dinétah Gray pottery, typical vessel shapes and
detail of sherds.
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Jemez Utility (Towa)

Jemez utility wares (which have not been assigned a formal type
name) occur in both jar and bowl forms, with the jars generally globular,
wide-mouthed ollas. Vessels are coiled, and incompletely scraped. Coil
thickness is quite fine, even on large vessels, range from 0.9 to 2.5
centimeters. Wall thickness is highly variable, with up to a 2.5
millimeter variation in thickness encountered on a single 7.5 centimeter
sherd. Paste color varies from light gray through reddish-brown to dense
black. It may also be light mustard yellow. Firing effects (such as fire
clouds) vary. The ware is usually notable for its crudeness. Although the
exterior surface is characterized as “plain,” this more accurately reflects
the absence of corrugation, indentation, and blind corrugation—in
contrast to earlier wares—than the surface of the actual ware type. Even
“plain” sherd exteriors are noted for a “muffled” or partially camouflaged
structural coil. The presence of visible coil junctions appears not to have
been deliberate, but rather a result of carelessness, and coils are rarely
completely smoothed. On some sherds scratches may be visible, the
result of imperfections in the clay being caught by a finishing implement
and dragged along the surface of the vessel. Some larger particles may
protrude from the vessel surface. The interior surface is usually black,
and has been scraped and often burnished with a polishing stone,
although never to a high sheen. Ground rock, in the form of vitreous

andesite, was used as temper, and was evenly distributed throughout the
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paste. In some instances during the protohistoric period, traditional
paste and tempers were utilized in the construction of Spanish-
influenced vessel forms, such as soup plates and cups (Lambert

1981:220, 224; Reiter 1938b:103-106, 125).

One researcher has remarked that, “Jemez pottery is inconsistent
in almost every element of workmanship...variety of workmanship is
truly Jemez!” (Reiter 1938b:105-106). Early Jemez utility ware was
decorated with finger-tip indentations, but had been largely superceded
by plain-surfaced wares by the early seventeenth century (Elliott
1986:20; Reiter 1938b; Reiter, Mulloy, and Blumenthal 1940:18). This
would suggest that if the indented utility wares found on Navajo sites
are, as Marshall (1985:183) suggests, not Navajo culinary wares, but

Jemez, that they would pre-date the Pueblo Revolt period.

Tewa Utility

Remarkably little archaeological work has been done in the
ancestral Tewa area. This combined with the propensity of
archaeologists to give little attention to utility wares, has resulted in a
paucity of information regarding the culinary wares from this area. The
bulk of the information available is for the pueblo of Nambe, although
some authors indicate that the production of similar wares was

widespread (Warren 1981:154).
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The Tewa of Nambe produced smooth, plain utility wares with a

brilliant mica slip. Vessel walls are quite thin, between 3.5 and 5.5

millimeters. The exterior is generally smooth, although some striations

may be present, and partially-obliterated coils may be visible. A slip

consisting of gold or silver mica flakes up to two millimeters in diameter

was thickly applied to the exterior, although the slip sometimes became

worn thin through use. The interior surface was polished and smudged.

Small amounts of mica fleck inclusions are commonly found in the paste

of vessels from both Nambe and Pojoaque. Crushed rock or sand was

used as a temper (Dodge 1982:89; Ellis 1964:34-38; Warren 1981:154.

Table 11.1 Comparison of Utility Ware Attributes.

Navajo Towa Tewa
Vessel Elongate oval Globular ollas,
Shape ollas, elevated recurved rim
central diameter,
recurved rim
Wall 2-8 mm, average | Highly variable 3.5-5.5 mm
Thickness 3-5 mm even within a
single sherd
Surface Gray, black, Light gray, Gold or silver,
Color buff, brown, or reddish-brown, metallic
red black, mustard
yellow
Surface Distinct parallel | Partially Thick micaceous
Treatment | striations, or camouflaged slip
smoothed. structural coils,
incompletely
smoothed
Temper Quartz sand Crushed rock Crushed rock or

(vitreous andesite)

sand
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Comparison Against the Model

In contrast to the expectations formulated above if the pueblito
complexes were the sites of ethnic co-residence only very small quantities
of Puebloan decorated wares were encountered at those covered in the
2002 Palluche Canyon Survey (see Chapters 7, 8, and 9). This is in
keeping with the results of Marshall’s pueblito complex surveys, in which
the maximum percentage of Puebloan decorated wares encountered at
any given site (Hooded Fireplace, LA 5662) was 2.7 percent (Marshall
1995:A3-4). Of 6508 ceramic artifacts analyzed by Marshall, only eight
sherds, representing five vessels, were from Puebloan utility wares. All of
the Puebloan utility ware sherds were from the Southern Tiwa pueblo of
Zia (Figure 3.1). These were a basalt-tempered plain gray ware called by
Marshall “Zia Plain Gray” (Marshall 1995:93). Four sherds occurred at
Hooded Fireplace (LA 5662), and the remainder at Tapacito Ruin (LA
2298) (Marshall 1995:71, 93). The 2002 Survey encountered no
Puebloan utility wares in any of the three survey areas examined, and a
total of only seven decorated trade-ware sherds were encountered in the
three survey areas. (No attempt was made, given the expertise and
comparative collection required, to assign ware types to these sherds.)

This very low incidence of any Puebloan wares (Tables 11.2 and
11.3), and the virtual absence of Puebloan or Puebloan-style utility wares

at the pueblito sites suggests that the Puebloan wares present are there
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as a consequence of trade. Even the eight sherds of Zia Plain Gray may
represent trade in a substance which would, of necessity, have been

transported in a pottery vessel.

Table 11.2 Tradeware Sherds Encountered During 2002 Survey.

Site Tradeware Description

LA 86895 White slip, black organic paint. (1)

LA 137968 | Heavy white slip. No decoration on sherd. (1)

LA 9073 White slip, black mineral paint. (2)

Polychrome. (2)

White slip, black organic paint or mineral with organic
binder (1)

Table 11.3 Tradeware Percentages at Pueblito Sites (after Marshall
1995).

Frances | Crow Hooded | Tapacito | Split | Largo | Shaft
Canyon | Canyon | Fireplace Rock | School | House

Puname
Series 0.5 1.7 0.4 0.5
Acoma 0.5 0.5 0.5 0.2
Series
Rio
Grande 0.3 0.3
Glaze
Tewa 0.2
Series
Santa
Ana 0.1 0.2
Series
Jemez 0.1
Series
Cochiti 0.2
Series
Zuni
Series
Ocate 0.7
Series
Total 1.3 None 2.7 0.5 1.8 0.5 None
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It is worthwhile to note, in view of the third component of Zedeno’s
model—the sharing of techniques and development of hybrid forms—the

observation by Hall (1944:98) that:

Navajo cooking ware...shows little obvious deviation in its general
character from early to late. While the shapes of Navajo pottery
show a great deal of variation for any given time or place, this

variation may be found throughout the known range of the culture.

Similarly, Winter and Hogan (1992:311) have remarked that the
“Dinétah and Gobernador components of sites are only distinguishable
by the presence of a few sherds of Gobernador polychrome and other late
pottery types.” This diachronic consistency of Navajo utility wares,
combined with the recognition that the development of Gobernador
Polychrome significantly predated the Pueblo Revolt, indicates that
Navajo pottery was not significantly influenced by Puebloan immigrants.

It is quite evident that the wide variety and small quantities of
Puebloan decorated wares at pueblito sites are precisely the type of
assemblage that one would anticipate would be present on Navajo sites
as a consequence of trade, and quite unlike that which would be
anticipated on a mixed Navajo-Puebloan co-resident site. The absence of
virtually any Puebloan utility wares at pueblito sites also argues strongly
for the absence of Puebloans, and Puebloan potters, at those sites.

Gobernador Polychrome, the Navajo decorated ware which was originally
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attributed to the influence of Puebloan potters, was developed well in
advance of the postulated influx of refugees, and Dinétah Gray appears
to have remained unchanged throughout the Gobernador period, and
uninfluenced by Puebloan utility wares. The sensitive indices of the
ceramic assemblages at the pueblito sites makes quite clear who the
residents were—Navajos, who had some contact with numerous

surrounding Puebloan groups.
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12 Architectural and Construction Evidence

Much of the basis for Kidder’s (1920) hypothesis that pueblitos
were of Puebloan construction, and subsequent presumptions regarding
their genesis, was based on their apparent similarity to pueblo
structures. As Towner (1996:164) has observed, “pueblitos and the
architectural features they contain have always been one of the criteria
for the refugee hypothesis.”

This similarity, however, may in truth be more superficial than
actual. There can be no argument that architecture and construction
techniques can be, and are, effective cultural indicators. Michelle

Hegmon (1989:5, 7) has remarked that:

The most mundane and the most grandiose architecture can be
related to cultural conceptions of the universe...Social order can be
reinforced in the spatial order defined by the
architecture...Architecture constitutes the built environment; it is
constructed by people in response to their needs and their
conception of both how their community and the universe are
ordered. Furthermore, once constructed, the built environment
can contribute to maintaining and reinforcing social order, or if

modified, the built environment can help to transform that order.

Bell (2000:116-117) has also observed that:
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Architecture is an active component of a society. [It] carries and
projects a multitude of meanings. Architecture [can become]
politicized as a marker of identity and social
allegiance...Architecture, as lived space [has] shown to have been a
critical means by which [different cultural groups] promoted,
obscured, and realized their goals during...intercultural

negotiations.

Architecture and construction techniques can be particularly
sensitive indices in instances where the cultural norms and values, and
their means of architectural expression, are as widely divergent as they
are between the Navajo and the Pueblo peoples. Additionally, both
groups have employed architecture to reflect and reinforce their
worldviews. The Navajo hogan is specifically constructed to represent
the universe in microcosm (Hegmon 1989:8; Jett and Spencer 1981:22-
23, 239). Likewise, the organization of the Tewa village mirrors their
understanding of the cosmos (Hegmon 1989:10; Ortiz 1969:18-24.)
Matthew Liebman (2002:133) has observed, with specific reference to

Revolt-period Puebloan architecture:

Many new refugee villages were built on or adjacent to ancient
pueblo sites, denoting a return by the people to the ways of their
ancestors...The form and plan of some of the Revolt period plaza
pueblos has been interpreted as an architectural assertion of these

traditions.

www.manaraa.com



189

In addition to architecture’s role in reflecting cosmology and
structuring societies, its nature as “isochrestic” or “technological” style is
an important consideration. These aspects of style are less subject to
change (Stark 1995:333) due to their low visibility, they often include
factors which are invisible, other than to their builders, as illustrated in
the wall construction example in Chapter 1. Additionally, as
demonstrated by Arnold (1985:229-230), the likelihood of innovation is
in inverse proportion to the degree of risk involved, and with
architecture, and particularly construction techniques, the risks are
high. Arnold was directly addressing innovation in pottery-making, but
his principles are applicable to architecture, as well. The collapse of the
wall of a pottery vessel caused by innovation in construction technique is
minor in contrast to the collapse of a building wall due to the same
causes. This is particularly true where no other option for shelter would
be immediately available, as would be the case with refugees moving into
a new area, who did not have kin or affinal relations with whom they
could move in until repairs could be made. These factors would mitigate
against any experimentation with new architectural or construction
techniques in their adopted home, and would ensure that archaeological
and construction styles served as an effective index of the ethnic affinity
of a structure’s builders.

With regard to the determination of the ethnic affiliation of

archaeological remains, Curtis Schaafsma (1996:21) has advised that:
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The best methodology is to construct hypothetical models of what
to expect of various ethnic groups that might have been in the
area, systematically compare the expectations with the observed
archaeological materials, and reject the ones that clearly do not

match. One might retain the one with the best fit, or reject it too.

Hoggett and Chorley (1967:22, cited in Magers 1981:218) have
described a model as “a simplified structuring of reality which presents
significant features or relationships in a generalized form.”

In the instance of the ethnic identity of the creators of the
pueblitos, the hypothetical models of construction techniques and
architectural features are relatively easy to construct, based upon the
patterns established by the proposed source communities for the
postulated immigrant populations. As was the case in the previous
chapters on oral history and ceramic assemblages, the analysis has been
confined to the characteristics of the Towa and Tewa pueblos, as these
have been determined to have been the most likely source populations
for refugees from the pueblo revolt (Hogan 1991:21). In order to facilitate
comparison, the characteristics of the pueblito structures are presented
first, followed by those of the Towa and Tewa pueblos, and finally a
consideration of some applicable aspects of Navajo architecture and
construction. Larger issues of settlement patterns, including religious

structures, are reserved for the following chapter.
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Kidder’s refugee hypothesis specified that the inhabitants and
builders of the pueblitos were Puebloan, and that the surrounding
hogans were evidence of Navajo occupation at the sites. As alluded to
previously, it would be anticipated that the architecture and construction
of the pueblitos would be reflective of the ethnic affiliations of their
builders, whether they were Towa or Tewa. If, however, the builders were
Navajo, it would be anticipated a) that pueblito architecture and
construction would be decidedly non-Puebloan, and b) that some aspects
of Navajo construction and architectural practices would be evident at

the sites.

Pueblito Construction and Architecture

The defensive characteristics of the pueblitos have long been
noted. These characteristics are not limited solely to their locations, but
also to many defensive architectural details, such as the use of dead
ends, serpentine passageways, narrow, often single entries, and the use
of log bridges and ladders, which could be pulled up or in by a defending
group. The walls of the structures often conform to the shape of the
landform on which they occur, such as a promontory or boulder (Powers
and Johnson 1987:9), thus denying attackers a “staging area” from
which to assault the walls, and effectively raising the height of the

boulder or cliff face to be scaled by another three to six meters.
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Perimeter walls of the pueblitos were generally constructed first,
with the enclosed space then sub-divided. The practice of conforming
pueblito walls to the surrounding landforms often yielded irregular rooms
with some rounded corners. All of the sandstone slabs used in pueblito
construction are wet-laid in varying quantities of adobe mortar. With the
exception of Tapacito Ruin (LA 2298), which will be examined separately
in another chapter, the masonry consists of unshaped, single courses of
sandstone slabs laid parallel to the wall, in which there is minimal
overlap of the slabs of one course over the slabs of the course below, a
technique which has been termed “columnar masonry” (Powers and
Johnson 1987:9). Wall thickness averages approximately 30
centimeters.

After construction, pueblito wall interiors were plastered with
adobe, and sometimes smoothed with a tool that left a scored surface,
then “whitewashed” (Powers and Johnson 1987:9). The similarity
between the scored surface of the interior walls and that of the surfaces
of Dinétah Gray ceramics is worthy of note, although whether the same
type of tool (corn cob or juniper bark in the case of Dinétah Gray) was
employed in the creation of this surface finish remains undetermined.

Pueblito ceilings--and second storey floors in multiple-storey
structures—were constructed using the viga-and-latilla construction
method common in the American southwest. Large primary beams, or

vigas, consisting of pinyon, Ponderosa pine, Douglas fir or juniper trunks
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up to 30 cm in diameter were socketed into the walls of the structure,
and covered with split juniper or pinion slats and smaller-diameter
branches or saplings (the latillas, or secondary beams). In some
instances the latillas were covered in turn with a layer of shredded
juniper bark covered with adobe, in others the adobe was laid directly
over the latillas. In some instances, the spans of the vigas were
supported by an additional post in the middle of the room, and the
underside of most vigas had been flattened with an adze (Powers and
Johnson 1987:9).

Entrance to the pueblitos was by means of ground-level doorways
with pinyon or juniper lintels which had frequently been squared by use
of an adze. The thresholds, if present, are generally masonry. The sides
of the entryways are occasionally rounded by the use of adobe, but more
commonly are flanked by masonry pillars which were added after the
doorway was completed (Powers and Johnson 1987:10). In some
instances a jacal wall protrudes a short distance into the room at one
side of the doorway (Powers and Johnson 1987:10). This may be an
additional defensive measure, allowing a defender to attack intruders
from behind the shelter of the jacal wall (Figure 12.1, LA 5659).
Alternatively, such a wall may have served to block the wind.

Access to an upper storey was via a hatchway in the ceiling of the
room below, or via a doorway built in to the second storey wall. In the

instance of boulder-top pueblitos, access to the boulder-top structure
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was in some cases via a hatch in the roof of a room constructed at the
base of the boulder (Powers and Johnson 1987:10).

Other architectural features common at pueblitos are the presence of
diagonally-oriented shelves in the corners of rooms, constructed of
parallel secondary beams socketed into adjoining walls, and holes in the
walls originally for pegs to hang objects on (Powers and Johnson
1987:10). “Hooded fireplaces,” or their variants, are encountered at
some sites (Figure 12.3). These consist of a curved beam as much as 10
cm in diameter, socketed into adjoining walls at a height of 60-80 cm
above the floor, forming a diagonal cross-piece. The upper surface of this
cross-piece was fitted with a groove, and the ends of wooden slats were
fitted into the groove, with the opposite ends leaning against the corner
of the room. This served to channel the smoke from the fireplace up
through a hole in the ceiling that served as a chimney. A variant on this
pattern consisted of the use of an ungrooved crosspiece, set
approximately one meter above the floor (Powers and Johnson 1987:130).
Hooded fireplaces are a Spanish phenomenon, and do not appear at pre-

contact sites in the southwest (Carlson 1965:103).
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Figure 12.1 Plan views of pueblitos (after Powers and Johnson 1987).
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Figure 12.2 Plan views of pueblitos (after Carlson 1965; Powers and
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Figure 12.3 Hooded fireplace at Frances Canyon Pueblito. Viga-and-
latilla roof construction also visible.

So-called “loopholes”™—small holes in exterior walls, suitable for
viewing attackers or aiming weapons—are also a characteristic of
pueblito construction (Powers and Johnson 1987:9), although some care
must be taken in interpreting them. In some cases they are clearly
deliberately-constructed, but in other cases may be a consequence of the
uneven deterioration of the adobe walls (Figure 8.1).

In spite of Powers and Johnson’s (1987:125-127) attempt to create
a pueblito typology, there is little consistency, other than those factors

noted above, in pueblito architecture and construction, and no “typical”
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pueblito floor plan (Figures 12.1 and 12.2) Powers and Johnson had to
rely primarily on site location and the presence or absence of hooded
fireplaces or modified hooded fireplaces as criteria for their typology.
They did observe some variation in room size, but as the smaller rooms
were generally located in more constricted sites (promontories and

boulder tops) this cannot be considered an entirely independent variable.

Towa Construction and Architecture

Remarkably little archaeology has been done at Towa sites, in spite
of the fact that there are there are more than forty large pueblos
exceeding 50 rooms, some of which are considerably larger than Chaco
Canyon’s Pueblo Bonito (Elliott 1982:13-25; Elliott 1986:175). Enough
has been done, however, to provide a general overview of the nature of
the architecture and construction techniques employed at these sites.
Excavations have been carried out at the sites of Unshagi (LA 123),
Nanishagi (LA 541), Giusewa (LA 679), and Amoxiumqua (LA 481) (Reiter
1938; Reiter, Mulloy, and Blumenthal 1940). Although only Giusewa
was occupied at the time of the Pueblo Revolt (Elliott 2002:48), Unshagi,
a pueblo of some three hundred rooms, was constructed beginning in
1405, and occupied until 1628, and Nanishagi was constructed in the
mid-thirteenth century and occupied until the mid-sixteenth century.

Amoxiumqua was constructed beginning in 1502 and abandoned before
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the beginning of the Pueblo Revolt. It seems likely that little evolution in
Towa architectural styles or construction techniques would likely have
occurred between the construction of Nanishagi and the construction of
revolt-era sites such as Boletsakwa (LA 136) and Astialakwa (LA 1825)
(Elliott 1982:11,37; Stallings 1938:99).

The shape of Towa pueblos is prescribed by tradition, and many of
the structures conform to this ideal. In some instances tradition
necessarily bowed to the demands of topography, as at Unshagi (Reiter
1938:43). The legendary Jemez figure Pest-ya-sode instructed the Towa
in the construction of pueblos designed for defense (Reagan 1917:49), as

recorded in Jemez oral history:

At this time [the Sun] placed among them a “knowing man” whose
name was Pest-ya-sode. Pest-ya-sode defeated the enemies, raised
the siege of the cliffs and caves and drove the savages out of the
narrow canyons. He trained the people in the arts of war...He then
instructed the Indians to build villages in horseshoe shape with
continuous outer walls, so that they served both as places of

residence and as fortifications. (Reagan 1927:724)

In many instances, the original horseshoe shaped pueblo has
grown through accretion, but the repeated shape, with its defensive
capabilities, has been retained (Figure 12.4). Walatowa, with three
parallel room blocks on either side of open-ended plazas, evinces a

departure from this pattern (Simpson 1852:16; Elliott 2002:51).
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Walatowa, however, was constructed as a reduction village under the
direction of the Spaniards (Sando 1982:74). The Jemez had already
proven themselves capable of rising in rebellion in 1623 (Wilcox
2002:174). Therefore, the Spaniards, who may have had considerable
influence on the layout of the pueblo, may have had their own reasons
for reducing the defensive capabilities of the village.

Towa pueblos were constructed of simple wet-laid masonry, which
one excavator has described as “no more than it needed to be” and
“mediocre in the extreme” (Reiter 1938:43,47; Reiter, Mulloy, and
Blumenthal 1940:6). Walls were a single stone thick, with uncoursed
and unmatched stone slabs laid perpendicular to the wall direction.
Adobe mortar was used in abundance, with “surprisingly few stones per
square yard” (Reiter 1938:45,46; Reiter, Mulloy, and Blumenthal
1940:6). Building stone reflected whatever was locally available, with
more than one type employed at some sites. Foundation preparation was
rare, and where present were generally 35 cm deep. Wall thickness
ranged from 17-35 cm, with the average being 27 cm. Limited
interlocking of stone was employed at the intersections of two walls.
Very little chinking was used to fill the gaps between stone slabs at
Unshagi, but was more common at Nanishagi, where stone slabs
occasionally evinced some simple shaping (Reiter 1938:43-47,85; Reiter,
Mulloy, and Blumenthal 1940:6). Reiter estimated that Towa masonry

was generally insufficient to have supported a three-storey structure,
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although at Giusewa, where the masonry was little different, at least
portions of the pueblo are known to have contained three storeys (Reiter
1938:72,88). The first coat of plaster on interior walls was often coarse
adobe, which was then covered with coats of a smooth, homogenous
layer of brown clay or pulverized gypsum (Reiter 1938:59; Reiter, Mulloy
and Blumenthal 1940:6).

The exterior walls of the pueblos had few openings, and those few
that existed generally faced the plaza (Elliott 1986:17; Reiter 1938:47).
The second storey of the structure was set back from the plaza, leaving
an open space on the roof of the pueblo (Simpson 1852:16). Access to
first-storey rooms was almost exclusively achieved through the roof of
the structure, which was in turn reached via ladder (Elliott 1986:17;
Reiter 1938:47). Doorways between rooms consisted of two types—Ilow
doors approximately 60 cm high, with a few taller doorways slightly more
than a meter in height. Both types either had a sill flush with the floor,
or one 15-32 cm high and well-polished from use, and both doorway
types were generally 42-65 cm wide. The doorways tapered at the top to
a lintel composed of a single stone, and were flanked by rounded jambs
composed largely of plaster on either side (Reiter 1938:47; Reiter, Mulloy,

and Blumenthal 1940:7).
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Many first-floor interior rooms featured a hearth-deflector-bin
complex. The hearths were simple, slab-lined, plastered, and roughly
rectangular. These hearths often protruded slightly above the floor level,
and the floor of the hearth itself was often left unlined. More than half of
the hearths encountered at Unshagi had been renovated after
construction, generally by raising the floor. In some instances, a double
hearth was created by placing two slab-lined hearths immediately
adjacent to one another. Hearths were generally located in the middle of
the room floor, somewhat off-center toward the deflector (Reiter 1938:48-
49, 64; Reiter, Mulloy, and Blumenthal 1940:7).

Rooms with hearths featured a doorway (described above) or a
ventilation hole 15-25 cm in diameter. Location of the door or vent
varied based on the location of the room in the pueblo, with doorways or
vents located in the east wall of rooms on the west side of the pueblo at
Unshagi. Deflectors were located between the hearth and a ventilation
hole or doorway in the wall of the room, and placed roughly a quarter of
the way into the room. The deflectors were created of masonry and
adobe, and were roughly 75 cm long, 15-23 cm thick, and 75-90 cm
high. The tops of some deflectors at Unshagi were created in a “terraced”
form, with three steps at each end of the top, but the one intact deflector
at Nanishagi lacked this characteristic (Reiter 1938:56-64; Reiter,

Mulloy, and Blumenthal 1940:7) (Figure 12.6.)
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Figure 12.5 Terraced pueblo construction showing setback of upper
storeys.

Square or rectangular storage bins of adobe-plastered masonry
were commonly located in opposing corners along a single wall in rooms
containing hearths, with the deflector located between them. Bin height
ranged from 37-162 cm, and the bins may have been used for storing
corn. Some of the bins had a limited opening in the side, just large
enough to reach into. In some instances a low mortar partition extended
from the ends of the deflectors to the corners of the storage bins (Reiter
1938:48-58; Reiter, Mulloy, and Blumenthal 1940:7).

Additional architectural features consisted of plaster pockets, or

“crypts” built into the adobe walls—horizontally-oriented oval
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depressions roughly the size of a human fist. Subfloor pits also appear
to have been employed for storage, some being roughly spherical and
excavated into the floor and left unlined, and others containing pottery
sherds and likely representing buried storage jars (Reiter 1938:48-52).
Rooms with no features were generally located adjacent to the exterior

wall of the pueblo (Reiter 1938:64, 92) (Figure 12.6).

Wall Pocket

Storage Bin

Door or
Vent

Deflector

D Hearth

Storage Bin

Wall Facing Pueblo Plaza

Wall Facing Pueblo Exterior

Figure 12.6 Typical ground-floor Towa room suite showing interior
features (after Reiter 1938).

Less archaeological work has been conducted at Revolt-era sites,
which include Patokwa (LA 96), Boletsakwa (LA 136) and Astialakwa (LA
1825) as well as the reduction villages of Giusewa (LA 679) and Walatowa
(modern-day Jemez Pueblo, LA 8860) (Elliott 1982:11). Boletsakwa,
constructed in the early 1680s, after the first Pueblo Revolt but prior to
the reconquest, consists of two large, twin-plaza pueblos totaling some

650 rooms; it is located next to a series of considerably reduced mounds
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from an earlier pueblo which dates from approximately 1250-1400
(Elliott 1982:13; Elliott 2002:53). Patokwa, constructed in the late
1600s, appears to have originally reached two or three storeys in some
areas, contained 600 rooms, and was ultimately abandoned in 1693 or
1694 in favor of Astialakwa (Elliott 2002:50-58; Reagan 1917:31).
Astialakwa, located on a high, narrow mesa top above the bench
upon which Patokwa is situated, was also constructed in the 1680s, and
consists of a number of haphazardly-arranged room blocks of 1-10
rooms, with a total of some 170 rooms and no enclosed plazas
(identification of other unenclosed plazas is difficult, but they may have
numbered five or six). Defensive walls are present around the perimeter
of the mesa, and a number of supposed “tipi rings” are located to the
north of the structures (Elliott 1982:39; Elliott 2002:52; Dougherty
1980:17; Hendricks 2002:190). This apparent departure from the
normal Towa pattern may be accounted for by the presence of defenders
from Walatowa, Giusewa, Santo Domingo, Zuni, Acoma, and the Navajo
(Dougherty 1980:3) being present at the site. The abundance of small
room blocks may represent buildings constructed by members of
different ethnic groups. The supposed “tipi rings” may in fact be “hogan
rings” of stone slabs set to help anchor the bases of the hogan poles, a
common Navajo practice (Hogan 1992:4; Jett and Spencer 1981:60)

(Figure 8.8).
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Tewa Construction and Architecture

Even less archaeological work has been carried out in the Tewa
region than in the Towa. The primary source of information on Tewa
construction techniques comes from the pueblo of Yungue Yungue, or
San Gabriel, a Tewa pueblo occupied at the time of the Spanish entrada.
The Tewa abandoned it for Spanish use, and constructed the still-
occupied pueblo of San Juan nearby (Ellis 1987).

In 1610 Yungue consisted of a single rectangular plaza surrounded
on all sides by pueblo structures, with an entrance to the plaza at each
corner. Ruined structures described by Bandelier likewise consisted of a
quadrangle surrounding a plaza, and in some instances one or more
adjacent, partially-enclosed plazas (Bandelier 1892:38). Villages
ancestral to the modern pueblo of Nambe were generally horseshoe-
shaped in plan, with the plaza usually open to the south (Ellis 1964:40-
41).

The structures were terraced, with the upper storey set back some
distance from the plaza, with a sheer wall facing the exterior of the
pueblo. The roofs were flat, and the roof of the floor below served as
living and working space (Ellis 1987:20; Riley 1987:188). This terracing
may have reflected Tewa understanding of the vertical division of the
universe into three superimposed levels, consisting of “the below,” “the

middle” and “the above” (Ortiz 1969:23), just as the horizontal
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component of the village organization represented the horizontal
conception of the universe (Ortiz 1969:18-24). Thus, the plaza (and
possibly the kiva) would correspond to “the below,” the first storey to “the
middle,” and the second storey and roof of the first as “the above.”

Walls were constructed out of adobe, which was patted into place
in courses (Bandelier 1892:39-42; Ellis 1964:40; Ellis 1987:23-24; Riley
1987:235). The initial course of adobe was generally laid right on the soil
surface, with no foundation, although some later rooms used a course of
rock slabs or cobbles as a foundation (Ellis 1987:23-24). Ellis describes
the walls at Oya'widi as composed of smooth river stones and adobe
(Ellis 1964:40), but it is impossible to tell from this description whether
she meant cobbles held together with adobe, or, more likely, the same
type of cobble foundation beneath adobe walls as seen at Yungue
Yungue.

Pueblo house blocks were constructed in large units, with the
major parallel exterior rooms built first, then cross-walls installed,
although a family might append a few rooms to the end of an existing
structure if needed (Ellis 2987:20-21). Rooms were extremely small,
generally 2.4-2.8 meters square (Goodman 1987:92). The pueblo was
generally three rooms deep on the first floor, and entrance to ground-
floor rooms and to the upper storeys was via ladder to the roof, as floor
level doorways and windows were virtually absent (Ellis 1987:20-21) and

were “considered dangerous even into the historic period” (Ellis 1987:24).
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Some doorways existed between interior rooms, and if the entire plaza
was walled in, a few might open into the plaza itself. Even most lower
interior rooms were not connected by doorways, however, but were
accessed individually via roof hatches (Ellis 1987:24). Bandelier reports
that the few doorways present were narrow and tapered toward the top
(Bandelier 1892:44).

In large pueblos, ground-floor rooms were used almost exclusively
for storage, and second-storey rooms were used as living space. In some
instances, the ground-floor room closest to the plaza may have been
used for cooking in inclement weather (Ellis 1987:20-21; Riley
1987:188). Interior hearths consisted of a rectangular pit cut into the
floor, generally oriented toward the eastern wall. Both the floor and the
pit were plastered with adobe. An opening in the roof above the hearth
served to vent the smoke, and also as a means of entrance and egress.
In favorable weather a hearth located on the open roof of the pueblo

served for cooking (Ellis 1987:23-24).

Navajo Construction and Architecture

Superficially there is little similarity between the traditional Navajo

forked-pole hogan and the construction of pueblitos. Some elements of

architecture and construction technique, however, are comparable.
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The first consideration is means of entrance/egress from the
structure. Navajo hogans are entered through the side of the structure
(Jett and Spencer 1981:17-18, 60-61; Mindeleff 1898:492). This may
seem quite obvious to a Euro-American archaeologist, but represents a
marked departure from the Puebloan norm. From Basketmaker times
onward, Puebloans have entered and exited their pithouses, kivas, and
pueblo structures primarily via a hatch from above (Plog 1997:58-60,
78), a practice which may conceptually represent emergence from the
previous world into this one.

Additional details of Navajo entrance construction are worthy of
note: the use of trimmed logs for door lintels, and the occasional use of
flat stone slabs as door sills, in contrast to the raised thresholds found in
Puebloan doors (Jett and Spencer 1981:18; Keur 1941:31). Piles of stone
often form “piers” on either side of hogan doorways, and symbolized that
the hogan, and the songs used in its creation, would endure forever (Jett
and Spencer 1981:60; Keur 1941:19-22). The extended doorways of
Navajo hogans form a type of low, short passageway that then provided
access into the main body of the structure (Jett and Spencer 1981:60-
61).

The Navajo used pegs or projecting limb stubs on the interior of
hogans for storage of objects around hogan walls (Jett and Spencer
1981:24), a pattern also seen in the pueblitos (Powers and Johnson

1987:10). As previously noted, the hooded fireplaces encountered at
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some pueblitos are an Iberian-introduced phenomenon, and little
excavation has been carried out of pueblito floors to determine the
nature of hearths—if any—at the sites. However, if the charcoal
concentration recorded at 42 Pueblito by the 2002 survey team does
represent a hearth—and the unburned condition of the hammerstone
found in the charcoal concentration suggests that the charcoal
concentration is not the result of recent vandalism—then the hearth at
that site may have been the same type of shallow, informal, basin-shaped
structure found in many hogans (Hester 1962:47; Jett and Spencer
1981:19).

The apparent difference between hogan roof construction and the
construction techniques employed at pueblito sites, however, may not be
as great a conceptual leap as would first appear. Although the use of
viga-and-latilla construction has been employed by Puebloan groups for
centuries (Creamer 1993:18-20; Fewkes 1909:17; Fewkes 1911:35-36;
Lekson 1986:30-31), the method of construction of a forked-pole hogan
is not markedly different. The foundation of heavy, unsplit poles,
covered with smaller poles and split slats, and the whole covered with
juniper bark, brush and twigs, and then plastered with mud (Jett and
Spencer 1981:15-16, 59-62) bears remarkable similarity to the viga-and-
latilla construction technique, with the only major differences being the

horizontal, versus diagonal, orientation of the roof and the orientation of
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slats crosswise, rather than roughly parallel, to the main poles (Figure
12.7).

It should also be noted that the Navajo have long built stone-
walled hogans of piled sandstone slabs, surmounted with a traditional
forked-pole, or later, a cribbed-log hogan placed over the stone
foundation. This is a relatively late phenomenon, however, and one
attributed to the influence of Puebloan “refugees” (Jett and Spencer
1981:99). As no instances of stone-walled hogans which clearly predate
the Pueblo Revolt were encountered in the literature, to avoid a circular
argument, the masonry of these hogans was excluded from
consideration. Further dating of stone-walled hogans may reveal some
that pre-date the Pueblo Revolt, and which would further contribute to
an understanding of the pueblito question.

A well-known aspect of Navajo architecture, the prescription for
hogan doorways to face east-ward, toward the rays of the rising sun (Jett
& Spencer 1981:17-18; Mindeleff 1898:490), was not given consideration
in determination of the ethnic identity of the pueblito builders. The
reasons for this were three-fold: first, the orientation of Puebloan
doorways is variable, generally toward the center of a plaza, which may
also entail an eastward orientation, depending on the overall pueblo
layout. Second, pueblito doorway orientation is generally—and often
necessarily--determined by the topography upon which the pueblitos are

constructed. Third, the eastward orientation of Navajo structures applies
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A AN

Step 1: Primary forked poles are set in place Step 2: Two additional poles define entryway

Ay A=

Step 3: Door-posts and lintel are added to ~ Step 4: Secondaries are leaned against primaries.
entryway Rocks help prevent superstructure from shifting.

Step 5: Structure is covered in juniper bark, brush, and earth.

Figure 12.7 Hogan construction sequence.

only to dwellings, and there is little evidence that many of the pueblitos
was ever used for residential purposes. Therefore, orientation of pueblito
doorways was determined not to be a reliable indicator of the ethnic

identity of their builders.
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Rather than reiterate the elements of the above models, they are

presented below in table form, in order to facilitate comparison of the

various elements of pueblito construction with those of the various other

potential source populations for the pueblitos builders (Table 12.1)

Table 12.1 Comparison of Architectural Features. [talics indicate
features most consistent with those found at pueblitos

Construction/ | Pueblitos Towa Tewa Navajo
Architectural Pueblos Pueblos Hogans
Element
Floor Plan No pattern Horseshoe Enclosed or | Circular
shaped or partially- walls,
repeated enclosed extended
horseshoe quadrangles | doorway,
elements or hearth off
horseshoe- center
shaped toward
doorway
Room Shape Inconsistent, Regular, Regular, Circular
rounded square or square or
corners rectangular | rectangular
common
Wall Unshaped Largely Adobe Not
Construction sandstone unshaped applicable
slabs set in stone slabs (slanted roof
varying set in large also forms
amounts of quantities of walls).
adobe mortar.
masonry. Slabs | Slabs
oriented oriented
lengthwise to crosswise to
the wall. the wall.
Setback or Absent Present Present Not
Terracing of applicable
Upper Storeys
Interior Wall Plastered with | Plastered Adobe Plastered
Finish adobe, then with adobe, with mud or
“whitewashed” | then fine adobe

layer of clay
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Roof Viga-and-latilla | Unspecified, | Unspecified, | Post and
Construction presumably | presumably | slat, covered
viga-and- viga-and- with mud or
latilla latilla adobe
Access and Ground-level Few or no Few or no Ground-level
Egress exterior ground-level | ground-level | exterior
doorways, exterior exterior doorway
hatches or doorways, doorways,
doorways to doorways to | doorways to
second storey second second
story, story,
hatches to hatches to
first storey first storey
Doorways Tall, Short, Narrow, Tall,
rectangular, tapered tapered rectangular,
with wooden toward top, toward top. with wooden
lintels. Piles of | with stone lintels. Piles
stone on either | lintels. Door of stone on
side of door, jambs either side of
installed after rounded door.
wall completed. | with plaster.
Rarely rounded
with plaster.
Doorway Common Rare. Rare. Ubiquitous.
Frequency
Thresholds Low, High, Unknown. Low,
sometimes a plastered sometimes a
sandstone slab | over. sandstone
present. slab present.
Entrance At some sites Absent Absent Common
Passageway
Hearths Hooded, Plastered, Plastered Informal,
hooded slab-lined rectangular | shallow,
variant, rectangular | pit basin-
possibly pit excavated shaped.
informal on excavated into floor. Smoke
floor. Smoke into floor. Smoke vented
vented through | Smoke vented through
chimney vented through smoke hole.
(possibly through entrance
through hole in | entrance hatch.
roof for hatch.

informal
hearths).
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Deflector None noted Masonry Unknown Rare. If
plastered present, a
with adobe, single
often sandstone
terraced top slab set

upright

Shelves Parallel logs Unknown Unknown Sometimes a

placed low,

diagonally unexcavated

across corners platform

of rooms around
perimeter of
hogan

Storage Bins At two sites Common Unknown Slab-lined

only. bin in floor
(uncommon)
Wall features Pegs in walls Plaster Unknown Pegs or
for hanging, “crypts” or branch stubs
“loopholes” in | pockets for hanging
exterior walls.

Clearly, all architectural and construction features cannot be
considered equally, and the most important factors must be construction
techniques and, given the clearly defensive nature of the pueblitos, those
architectural features contributing to defense. These include overall floor
plan, terracing, doorways or the absence thereof, and entryways.

The presence of masonry architecture at pueblito sites has long
been considered significant evidence of Puebloan construction. As Hogan
(1991:7) has observed, however, “There are numerous examples of
prehistoric Puebloan architecture in the Navajo territory that could have
served as models for the pueblitos.” Indeed, the closely-spaced
sandstone slabs found at pueblito sites are somewhat more reminiscent
of the masonry at sites such as Chaco Canyon, Aztec Ruin, and Salmon

Ruin, than it is of the more “expedient masonry” (Elliott 1986:17) found
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at Towa sites. The core-and-veneer masonry at the Chacoan sites is
considerably more massive (but see the discussion of masonry in
Chapter 14 in this volume). If firmly-dated pre-Revolt stone-walled
hogans are found, it would establish the antiquity of Navajo use of
masonry techniques, and provide the basis for the comparison of those
techniques to those used in the construction of the pueblitos.

The Tewa did not employ masonry, but rather built their pueblos of
adobe. This practice could conceivably have had to be abandoned in
favor of the use of masonry upon moving to an area of higher rainfall due
to rapid wall deterioration from higher precipitation. This could not have
been the case for postulated Puebloan immigrants from the Tewa area
retreating to the Dinétah area, however, as the annual precipitation in
the Rio Grande Valley (20-50 cm, average 35 cm at Santa Fe) is higher
than that in the Dinétah region (16-35 cm, average c. 25 cm at
Farmington) (Phillips 1998:398), and therefore adobe construction would
have lasted longer in Dinétah.

A consideration of the floor plans of pueblitos and Towa and Tewa
pueblos is also vital. Towa and Tewa pueblos were built around enclosed
or partially-enclosed plazas (Figure 12.5) so that any attacker entering
the plaza would be virtually surrounded by defenders. The outward-
facing walls of the pueblo were massive, doorless and windowless,
providing no means of access to an attacking group. Likewise, the plaza-

side walls also had few or no openings, and defenders who retreated to
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the rooftops and drew up the access ladders effectively prevented
attackers from gaining a foothold in the pueblo. The entire pueblo
became, effectively, a fortress.

The defensive architecture at pueblitos is quite different, eschewing
the avoidance of ground-level entrances, and instead using such
entrances as a means of defense, with the use of long, easily-defended
entrance passages, often with a jacal or stone projection inside the
doorway which allowed the defenders to attack intruders from a position
of relative safety (Figures 12.1 and 12.2). These extended passageways
are reminiscent of those found on many hogans. The doorways, with
their wooden lintels, low thresholds, and flanking piers of stone all bear
considerable similarity to equivalent structures in Navajo hogans. It is
worth noting that, had the pueblito builders come from a Towa or Tewa
architectural background, and—inexplicably—opted to construct their
new defensive structures with the more vulnerable ground-level
doorways, they would likely have built them with the same very low
lintels and high thresholds evident in their original pueblos. The
necessity of an attacker negotiating a narrow doorway in a crouched
position, over a raised threshold, would have conferred considerable
advantage to the defenders inside. The importance that Puebloan
defenders placed on the absence of ground-floor doors and windows is
illustrated by the remodeling conducted on the “Casa Reales” (Governor’s

House) in Santa Fe after it was taken over in the successful revolt of
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1680. Doors and windows were sealed and replaced by roof hatches
accessed by ladders. Rooms were subdivided, and the structure was
effectively turned into a walled and fortified Puebloan village (Preucel
2002:16).

The lack of terracing or setbacks at the pueblitos is likewise
notable. As previously discussed, this terracing may be indicative of the
cosmological understanding of the pueblo inhabitants, and would not
have been abandoned lightly.

In light of the above considerations, Carlson’s (1965:103) assertion

requires re-examination:

[Pueblito]| construction techniques, roofing of vigas and wooden
slabs, cribbed log roofs, bins, loopholes, wooden lintels,
rectangular rooms, notched log ladders, hatchways and stone
towers are generically Puebloan. What are decidedly non-Puebloan
are the random arrangement of rooms and the entrance
passageways into many rooms. The random arrangement may be
explained as the result of growth at larger structures by accretion

and the passageways as defensive in nature.

As previously discussed, the difference between the viga-and-latilla
construction of pueblito roofs and the post-and-leaner construction of
Navajo hogans is not a large conceptual or technological leap. No
“cribbed log roofs” have been reported at any known pueblito site. Large

masonry bins have been recorded at only two sites, Three Corn Ruin (LA
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1871) and Frances Canyon Ruin (LA 2135) (Powers and Johnson
1987:18; Ron Towner, personal communication 2004). Wooden lintels,
rather than being typical of the Rio Grande Puebloans, are rather
typically Navajo. No mention of the presence of “loopholes” has been
made at Towa or Tewa pueblos. Pueblito rooms are generally better
described as sub-rectangular than rectangular, and in some cases are
not even that (Figures 12.1 and 12.2).

In the eighteenth century (admittedly, post-Revolt) stone towers
were not unknown among the Navajo, as Ungarte y Loyola reports the
Navajo building “ten rock towers within their encampment” (Farmer
1942:70). It should also be noted that although many pueblos have
grown by accretion—Carlson’s justification for the irregular layout of the
pueblitos—the regular pueblo layout is still followed, and rooms are
appended to the ends of extant wings (Ellis 1987:20; Reiter 1938:43).
Thus, the majority of Carlson’s “generically Puebloan” traits are either
rare, absent, or are attributable to Navajo construction.

In sum, the masonry techniques which formed the basis for the
hypothesis that the pueblitos were of Puebloan construction, are in fact
unlike those practiced by contemporary Puebloan groups. The absence
of setbacks, and the presence of ground-floor exterior entryways is
contrary to Puebloan defensive and architectural practices, and the
construction and form of the doorways have more in common with those

found on Navajo hogans than at pueblo sites. Other, more minor
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architectural details such as hearths and storage (or the lack thereof),
etc., likewise point to Navajo construction of these sites.

Given the results of the above comparison of architectural traits
and construction techniques, it appears improbable that the builders of
the pueblitos hailed from either the Towa or Tewa pueblos, and highly
unlikely that they were Puebloan at all. The greater likelihood is that
they were Navajo, drawing on their own architectural and technological
heritage, and applying to it their own knowledge—based on their own
tribal experiences mounting raids on Puebloan villages—of the efficacy of

masonry fortifications against the attacks of mounted raiders.
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13 Community Organization and Settlement Patterns

The paucity of archaeological research that has been conducted at
late seventeenth- and early eighteenth-century Towa and Tewa pueblos
places serious constraints on the ability to analyze the ethnicity of the
pueblito builders through settlement studies. Through the work of
Marshall (1991, 1995) and the 2002 surveys, data are available for the
pueblito complexes, and information on Navajo community organization
in the Dinétah and succeeding Gobernador phases has likewise
accumulated (see Brown 1996; Dykeman 2003; Gerow and Hogan 2000;
Hester 1962; Hogan 1992; Jett and Spencer 1981; Magers 1981; Sesler,
Hovezak and Wilshusen 2000). Unfortunately, little comparable
information is available for the Towa and Tewa, which would facilitate
comparisons. Consequently, the consideration of community
organization must be confined to two particular areas: population
density as a defensive measure and reflection of social values, and the
presence and types of religious or ceremonial structures at the sites.
Fortunately, due to the considerable divergence in practice between the
Navajo and the Puebloans as concerns these two factors, in spite of the
paucity of data, these two areas are powerful predictors of the ethnic
identity of the pueblito inhabitants.

If, as Kidder (1920) intimated, the pueblitos were built by

Puebloans, it would be anticipated that they would follow a typical
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Puebloan settlement pattern, which includes population aggregation,
both as a function of social structure and as a defensive measure.
Additionally, because much of the impetus for the 1680 revolt was
religious, and because of the prime importance of religious ceremonies as
both a protective and an incorporative force in Puebloan society, it would
be expected that Puebloan religious structures, particularly kivas, would
form a significant part of the settlement pattern. Conversely, if the
pueblitos were constructed by the Navajo as a defensive measure, it
would be expected that they would continue the dispersed settlement
and defensive patterns that had been successful for the Navajo against
their enemies in the past. Likewise, it would be anticipated that Navajo
religious structures, particularly the frequently-employed sweatlodges,
would form part of the settlement pattern. If the pueblitos proper had
been built by Puebloans, living in the midst of Navajo communities, then
one would expect to find large populations of Puebloans aggregated at
the pueblito sites, with kivas nearby, surrounded by more dispersed

Navajo residence groups making use of scattered sweatlodges.

Population Density and Defense

Pueblitos are presumed to be defensive structures for a number of

reasons: a) their appearance at a time when the inhabitants of Dinétah

were under threat of Spanish, and later Ute, attack, and the cessation of
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their construction appears to be roughly coincident with the removal of
that threat, b) the architecture of the structures appears to be defensive
in nature, and c) there is little evidence that these structures were used
either for habitations or as storage facilities.

The tendency of the Navajo to live widely dispersed over the
landscape may have originally been a functional necessity of hunter-
gatherer groups, but this characteristic is one that has continued into

the modern period. As Jett and Spencer (1981:231) have observed:

Most remaining core characteristics that are of northern
Athapaskan origin are—besides the Navajo language—in the
realms of architecture and settlement. These realms reflect not
only the means of livelihood of the people but also, importantly,
their social values. Individualism, autonomy, and privacy are
valued, but so are helpfulness and cooperation. Social interaction,

especially along homestead group and clan lines, is highly valued.

If this dispersed settlement pattern were merely a functional
necessity among the Navajo, and not a reflection of their social values,
then it would be expected that the adoption of agriculture, and a
subsistence base more closely resembling that of the prehistoric and
proto-historic Puebloans, would also tend toward a greater density of
settlement, such as that found among the Puebloans. It did not.

This dispersion also served the Navajo in times of conflict, as it

fulfilled a dual function: to lower the profile of Navajo settlements,
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making them harder to locate, and to allow for rapid retreat from

approaching enemies. Magers (1981:225) remarked that:

Traditional Navajo defensive tactics consisted largely of moving
people and stock to inaccessible places of refuge...Elements
important to Navajo defensive strategy, which would have affected
settlement patterns for the earlier periods, included need for
camouflage, compactness, seclusion, a commanding view, and

access to places of refuge.

Cosmos Mindeleff (1898:483-484) observed that:

Each hogan stands by itself, and it is usually hidden away so
effectually that the traveler who is not familiar with the customs of
the people might journey for days and not see half a dozen of
them...So prevalent is this custom of placing the houses in out-of-
the-way places that the casual traveler receives the impression
that the region over which he has passed is practically
uninhabited...Probably this custom of half-concealed habitations is
a survival from the time when the Navaho were warriors and
plunderers, and lived in momentary expectation of reprisals on the

part of their victims.

Likewise, the Puebloan tendency toward aggregation into large,
multi-family structures has both social and defensive rationales. The
division of western pueblos into two distinct moieties and numerous

societies, each with specific ritual responsibilities, results in a large
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manpower requirement in order to fill the various offices. For instance,
among the Tewa, fifty-two adults (37 men and 15 women) are needed to
fill the various ritual offices, each of whom fulfills a critical role in the
performance of ceremonies that ensure the continuance of seasonal
cycles (Ortiz 1969:81-82, 98). Historically, when the populations of
various pueblos have dropped too low to provide for the performance of
these rituals, their inhabitants have migrated to other pueblos, as was
the case with Jacona and Cuyamunge in the wake of the Spanish
Reconquest, and with Pecos in 1838 (Barrett 2002:111; Plog 1997:196).

The large numbers of people necessary for the maintenance of the
cosmological order also provides a large number of defenders when a
pueblo came under attack. The structures described in Chapter 12,
although formidable, are not inherently impregnable. When manned by
a large number of resident defenders, who by virtue of the architecture
were placed in an elevated and strategically superior position, however,
they became a significant military fortification.

This contrast in settlement patterns as related to defense is a
significant factor in examining the ethnic origins of the pueblito builders.
Palluche Canyon provides an excellent example of the kind of close
proximity found with many pueblitos—the canyon and flanking mesas
contain no less than six pueblitos: Pork Chop Pass (LA 5661),
Compressor Station Ruin (LA 5658), and Twine House (LA 127737), in

addition to 42 Pueblito, the Overlook Site, and Foothold Ruin, for a total
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of 19-20 rooms, all of which were occupied between the late 1720s and
early 1740s (Towner et al. 2001:83-84).

Were these various pueblitos in fact built by Puebloans, it would be
expected that the inhabitants of the sundry small immigrant
communities would have banded together, both for ceremonial and
defensive reasons, rather than remaining dispersed upon the landscape.
Conversely, however, this type of dispersed settlement pattern is
precisely what would be expected if the builders were Navajo, with one or
perhaps two pueblitos serving as defensive retreats for a given residence

group.

Ceremonial Structures

The Navajo construct a variety of religious or ceremonial
structures, among which are hogans, sweatlodges, shrines, large
windbreaks, and dance grounds (Jett and Spencer
1981:35,111,193,197,198). Of these, the most archaeologically
recognizable are the hogans and sweatlodges. Although their primary
use is as a residence, hogans are also considered necessary for certain
critical rituals, and a specific type of hogan was constructed for the
Mountaintop Way ceremony (Jett and Spencer 1981:59, 111).
Sweatlodges are recognizable by their associated discard piles, even after

the structure itself has disintegrated. The exception is a sweatlodge
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constructed for the Nightway ceremony, which must be completely
dismantled and all evidence of its existence obliterated after the
ceremony (Jett and Spencer 1981:197). Although Reagan (1917:42)
mentions limited use of sweat baths among the Jemez, Jett and Spencer

indicate that Puebloans do not make use of sweatlodges (1981:197).

Among the Puebloans, the most significant, and most
archaeologically recognizable, ceremonial structure is the kiva (Hegmon
1989:10), which serves as the locus for many of the critical ceremonies

alluded to above. She has remarked (Hegmon 1989:10):

Kivas and at least some plazas have a strong symbolic component,
serving to affirm pueblo world view and traditional links with the
past. They symbolize in a number of ways the origin myth of

people’s emergence from a lower world.

Of the twelve total pueblito complexes surveyed by Marshall (1991,
1995) and the 2002 Palluche Canyon team, 75 percent feature
sweatlodges, often more than one. Only the Hooded Fireplace (LA 5662),
Simon Canyon (LA 5047) and 42 Pueblito complexes do not (Marshall
1991:36, 132). By contrast, “notable...is the lack of anything that might
be identified as a kiva” (Brugge 1968:17) at pueblitos. “Not a single kiva
has been identified at a pueblito site, with the possible exception of a

depression at Tapacito Ruin” (Towner 1992:55). Marshall describes the
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feature at Tapacito Ruin as a “large but shallow depression...(with) a few
unburned sandstone blocks scattered along the west side,” and suggests
that it may represent a “borrow pit or subterranean pit structure”
(Marshall 1991:95). Another possibility, unaddressed by Marshall, is
that it may represent a slickrock tinaja, providing a source of drinking
water to the inhabitants. Two such similar tinajas, totaling a capacity of
several hundred gallons, are located approximately 150 meters west of
the pueblito (Marshall 1991:94). Being located at the base of a cliff, this
depression has filled in more rapidly than the tinajas to the west.
Significant indications that this structure may not represent a kiva are
its size, shape and presumed depth—it is oval, not circular,
approximately eight meters by six, with its long axis located roughly east-
west.

Two pithouse-like depressions recorded at Old Fort (LA 1869) by
Powers and Johnson as Anasazi sites later proved to be depressions from
Earl Morris’s 1915 excavations at the site (Towner and Johnson
1998:36).

If the pueblitos were of Puebloan construction, it is highly unlikely

that kivas would be absent. Mobley-Tanaka (2002:79) has observed that:

Despite the fact that starvation and epidemic disease, both
brought on by the Spaniards, had decimated the Rio Grande in the

years immediately preceding the Pueblo Revolt, the cause of the
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Revolt repeatedly stated by Pueblo captives questioned by the

Spanish was religious oppression.

“Beginning in the 1650s, the missionaries began to forcibly
eliminate the native religion” (Goodman 1987:89), burning sacred masks,
prayer sticks, katsina dolls, dance head-dresses and other sacred
objects, destroying kivas and brutally punishing native religious leaders
(Dozier 1966:7; Mobley-Tanaka 2002:78; Preucel 2002:4). Given the
lengths and risks that the Puebloans went to in order to evict the
Spaniards from the American southwest and to protect these important
rituals and artifacts, it would seem starkly inconceivable that they would
promptly turn around and abandon the construction and use of their
most important ritual structures in the wake of such sacrifices.

Although no excavations have been carried out at Black Mesa,
where at least a thousand Tewa defenders took refuge from the
Spaniards, surveys of the mesa-top refuges employed by the Towa have
revealed that all of the sites, with the exception of Astialakwa, contain
kivas (Elliott 2002:49-53). The absence of kivas at Astialakwa may be
accounted for in two ways. First, Astialakwa was occupied for only a
brief period. Elliott (2002:56) indicates that the majority of the Towa
moved from Walatowa to Patokwa and Boletsakwa after the 1680 Revolt,
and only after Vargas’s arrival in the southwest was Patokwa abandoned
in favor of Astialakwa. (Walter [1921:19] gives the date of the occupation

of Astialakwa as 1688.) Astialakwa, located on the mesa top, is in an
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area with little soil depth, and subterranean kivas would, of necessity,
have had to have been excavated into bedrock. Such excavation is not
unknown. At the Keresan refuge site of Kotyiti (LA 295) on Horn Mesa,
not far from the Jemez sites, two 8-10 meter diameter kivas were
excavated into bedrock to a depth of approximately two meters, and lined
with coursed cobble masonry (Dougherty 1980:43). Kotyiti was
established in 1683 in anticipation of an attempted Spanish reconquest
by Indians from Cochiti, San Felipe, and San Marcos (Capone and
Preucel 2002:99-100). At Astialakwa, with its shorter occupation span,
there may not have been time or manpower to excavate bedrock kivas, as
the population may have been occupied with construction of residential
roomblocks and repulsion of Spanish aggression.

An alternative explanation for the absence of kivas at Astialakwa
may lie in what Mobley-Tanaka (2002:79) terms “false acquiescence,” —
the appearance of the abandonment of traditional ritual, when in fact
such ritual had merely been masked. Some instances of such “false
acquiescence” have been recorded for the Revolt period. The key Pueblo
Revolt leader, Popé, made use of an old storage room as a kiva, in order
to conceal his activities from the Spaniards (Mobley-Tanaka 2002:78). At
Zuni and Acoma, kivas went from subterranean plaza features to
incorporated room in the residential room blocks, for the same reason—it
allowed the ceremony participants to move to and from the ceremonial

structure without attracting the attention of the Spanish missionaries.
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Such roomblock kivas are also found at some Anasazi sites, including
Salmon Ruin. Although Popé made temporary use of interior pueblo
rooms as a “kiva” in order to conceal his activities from the Spanish
missionaries, this alternative for “false acquiescence” was not
permanently adopted in lieu of the more dangerous and potentially
catastrophic option of revolt.

The lack of sufficient soil depth to permit the construction of
subterranean structures could, conceivably, explain the lack of kivas at
some pueblito sites, but at others, such as Foothold and 42 Pueblito,
such an explanation is inadequate, because the soil depth is certainly
adequate. As illustrated by the Kotyiti example, this was not viewed as a
major barrier, in any case.

No plaza kivas—the type employed by the Towa and Tewa,
postulated source groups for immigrants to the Navajo—are found at
pueblito sites, and none of the structures appear to contain roomblock
kivas. The Rio Grande pueblos revolted in 1680 and again in 1694
specifically in order to preserve their religious freedoms, including the
use of plaza kivas. Nor would there be any reason for the postulated
Puebloan refugees in Dinétah to abandon their plaza kivas for roomblock
kivas in the pueblitos, as in their new homeland they would have been

far from the vigilant eyes of the Spanish missionaries.
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Comparison Against the Model

As noted above, several significant differences in settlement
patterns are evident between the Navajo and Puebloans, some of which
are related to defense, and others to religious practices. These
differences are summarized in Table 13.1, and compared to the

settlement patterns evident in pueblito sites.

Table 13.1 Comparison of Settlement Characteristics. Those most
closely resembling the pueblitos are shown in italics.

Settlement Navajo Puebloan Pueblito
Characteristic
Population Low, dispersed High, aggregated | Low, dispersed
Density in small into large upon the
settlements villages landscape
across the
landscape
Defensive Camouflage, Fortress-style Camoulflage,
Techniques flight architecture, fortress-style
superior tactical | architecture,
position and superior tactical
superior position
numbers
Ceremonial Sweatlodges Kivas Sweatlodges
Structures present at
pueblito
complexes, no
kivas evident

The evidence for assigning the ethnic affiliation of the pueblitos, on
the basis of settlement and community organization, consists of two
types: negative and positive. Negative evidence—the absence of certain

critical factors—leads to the conclusion of who the builders were not:
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they were not Puebloan. This evidence includes the absence of kivas,
and the inability of most pueblitos to house sufficient numbers of
individuals to fulfill the social and religious offices deemed critical by the
Puebloans to the continued functioning of society and the cosmos.
Positive evidence—the presence of certain factors—leads to the
conclusion of who the pueblito builders were: they were Navajo. This
evidence includes the dispersion of pueblitos on the landscape in spite of
the proximity of many pueblitos to one another, and the presence of
numerous sweatlodges in the vicinity of the pueblitos. Thus, both lines
of argument based on settlement and community organization—both
negative and positive—lead to the same conclusion: the pueblitos were

built by the Navajo.
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14 Tapacito Pueblito: A Reconsideration

Towner (1997:131) has observed that Tapacito Ruin (LA 2298) is
“architecturally, ceramically, chronologically, and topographically
different from other pueblitos and should be viewed as a separate entity.”

That separate consideration is the purpose of this chapter.

Architecture and Settlement Pattern Evidence

Tapacito Ruin is located in a relatively open and unfortified
position on a wide bench on a mesa, near the confluence of Tapacito
Creek and Largo Canyon (Marshall 1991:89; Towner and Dean 1992:326;
Wilson and Warren 1974:18). This results in a more restricted field of
view than is encountered at many pueblitos (Powers and Johnson
1987:27), which are generally situated with a commanding view of large
portions of the surrounding landscape.

Tapacito is unique among pueblitos in that the main walls are of
massive core-and-veneer construction, with the two outer wall sections
being built of large (20-40 cm) sandstone blocks, and the interstices filled
with masonry rubble. This results in a wall that is approximately one
meter thick (Marshall 1991:90; Powers and Johnson 1987:27; Towner
and Dean 1992:317,326; Wilson and Warren 1974:10), making Tapacito

Ruin an “archetype of the ‘casa fuerte’ or ‘strong house” (Marshall
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1991:89). The massive exterior walls of Tapacito Ruin are approximately
8-9 meters on a side, and the corners are remarkably square (Powers and
Johnson 1987:27). There are no exterior doorways, and access to the
structure must have been via roof hatches, of which one still remains
(Marshall 1991:90; Powers and Johnson 1987:27; Wilson and Warren
1974).

The quadrangle formed by the core-and-veneer walls is subdivided
into four rooms (Figure 14.1) by simple masonry walls of slabs of
sandstone one stone (c. 0.25 meters) thick (Marshall 1991:90; Wilson
and Warren 1974:12), resulting in a “quartered square” floor plan which
is unique among pueblitos (Towner and Dean 1992:326). In sheltered
areas, traces of adobe plaster coated in a white paint are still visible on

the walls (Wilson and Warren 1974:12).

Scale

2 4
meters

- Core-and-Veneer Wall

e  Single-Course Wall

Figure 14.1 Plan view of Tapacito Ruin (after Powers and
Johnson 1987).
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A parapet constructed in the same technique as the interior
partitions, and estimated to originally have stood one to one-and-a-half
meters high surmounts the exterior walls (Marshall 1991:90; Wilson and
Warren 1974:12). This may have served as additional protection for
defenders, both by allowing observation and attack of enemies from the
roof of the structure, and also by raising the height of walls would-be
attackers must scale to a total of three-and-a-half to four meters.

The interior walls are pierced by two rectangular doorways with
wooden lintels. Room IV would only have been accessible through this
doorway, as there is only a chimney flue, and no hatch, in the roof of
that room. Hooded fireplaces also occur in the corners of two of the
rooms (Wilson and Warren 1974:12).

The roof is of typical viga-and-latilla construction. The vigas have
been debarked, but not shaped. The latillas are surmounted by a layer
of sandstone slabs, which is in turn coated with a layer of adobe (Wilson
and Warren 1974:12). This would have helped to prevent the inhabitants
from being “smoked out” by setting fire to the roof of the structure.

Two additional rooms (Rooms I and II) were appended to one end of
the pueblito after the construction of the main structure. These are
composed of a single thickness of a non-local tabular white sandstone. It
appears that these rooms were never completed and roofed, and they are

now partially collapsed. An additional room, Room VII, consists of a
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masonry foundation for yet another room, although it is estimated that
the wall heights never exceeded one meter (Marshall 1991:93).

Tapacito Ruin dates to a single construction event in the autumn
of 1694 (Towner and Dean 1992). The original tree-ring sample
expedition to Tapacito, in 1941, also collected nine other samples
yielding cutting dates, eight from 1690 and one from 1689 (Towner and
Dean 1992:319-325). The proveniences of these earlier samples (all
pinyon) is unknown, but Towner and Dean (1992:326) suggest that they
could come from a no-longer-extant hogan (Marshall reports five forked-
pole hogan rings and the masonry base of a possible cribbed-log hogan

at the site [Marshall 1991:93]).

Ceramic Evidence

In spite of Towner and Dean’s assertion that the ceramic
assemblage at Tapacito Ruin differs considerably from those at other
pueblito sites (1992:326-327), this appears not to be the case.
Marshall’s assessment of 1220 sherds from the site did not yield any of
the Hopi yellowwares cited by Towner and Dean (Marshall 1995:A3-9;
Towner and Dean 326-327). The percentages of contemporary
tradewares at Tapacito Ruin are presented in Table 14.1, along with the
percentages encountered in Marshall’s total sample of 6508 sherds from

seven pueblito sites.
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With the exception of the glazewares and Ocate micaceous wares,
the ceramic profile at Tapacito Ruin differs little from that at other sites.
The higher percentage of Rio Grande glazewares likely represents the
pueblito’s early date, as the production of these wares declined in the
seventeenth century (Marshall 1995:31; Shepard 1942:147). Hooded
Fireplace Ruin, (another early pueblito, dating from 1723) is the only
other pueblito at which they are encountered (Marshall 1995:95; Towner

1997:224-225).

Table 14.1 Tradeware Frequencies at Tapacito Ruin (data from
Marshall 1995:75, A3-A9).

Ceramic Type Tapacito Ruin Total Sample
(n=1220) (n=6508)

Puname Series 0.5% 0.69%

Acoma Series 0.4% 0.36%

Cochiti Series 0.2% 0.03%

Rio Grande Glazeware | 0.7% 0.13%

Ocate Micaceous 0.7% 0.14%

Tapacito Ruin was the only pueblito site at which Marshall and his
team recovered Ocate Micaceous sherds, finding a total of nine from two
proveniences. These sherds suggest some contact with Plains Apache
groups, perhaps the Jicarilla (Marshall 1995:98). The Cochiti series

sherds, likely from a glazeware bowl, are the only Cochiti series sherds
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recorded by Marshall for any pueblito sites (1995:98). Like the other
glazeware sherds, this may be attributable to Tapacito Ruin’s early date.
Of the other intrusive sherds at Tapacito, the Puname series
sherds (which included 3 Zia Plain Gray utility sherds, as discussed in
Chapter 11, the only non-Navajo utility wares at the site), are indicative
of contact with pueblos along the lower Jemez drainage (Marshall
1995:93, A3-9). The Acoma series sherds are the second most common

at pueblito sites (Marshall 1995:93).

Conclusion

Towner and Dean hypothesize that Tapacito Ruin may represent a
site at which a Navajo family permitted Puebloan refugees, likely from
Jemez, to construct a pueblito in their midst, making Tapacito the only
genuinely Puebloan pueblito (Towner and Dean 1992:327). Towner also
suggests that this Puebloan occupation at Tapacito Ruin may represent
the origins of the Coyote Pass clan (Towner 1996:168). There are
problems with this interpretation, however.

First, the location of Tapacito Ruin seems unusual for a group
fleeing the Spanish reprisals after the Pueblo Revolt. During the re-
conquest, most Puebloan groups sought sanctuary on the natural
ramparts of the local mesas, and established their pueblos there. If

Tapacito Ruin were occupied by a fragment of one of these groups, it
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would appear natural that they would opt for the additional protection of
the mesa top, or at least establish the pueblito at the edge of the bench,
thus cutting off potential routes of approach for an enemy group.
However, unlike the refuge pueblos of the Rio Grande and the later
pueblitos, use was not made of this natural defense, although it was
available.

Second, the wall construction techniques employed at Tapacito
Ruin are completely unlike those used by the Jemez, or by the Tewa. In
fact, the closest similarity is to the massive Pueblo II period walls found
in Chaco Canyon. It is possible that the Navajo, faced with the necessity
of defense, and knowing from their own experience the difficulty of
mounting an attack against pueblo-style fortifications, drew upon the
ruins of Chaco Canyon as a reference for masonry construction. This
hypothesis may initially appear far-fetched, but the Chaco Wash run
adjacent and parallel to Largo Canyon, and Navajo legends tell of the
Navajo sojourning in the area (Matthews 1994:140, 195). The masonry
structures which the Navajo would have encountered in the Rio Grande
drainage among the Jemez and other contemporary Puebloan groups
would have been coated with a thick layer of well-maintained adobe
plaster, thus concealing the construction technique from view. The
crumbling walls of the Pueblo II structures in Chaco Canyon, however,
would have been available for inspection and emulation by the Navajo. It

is possible that the later departure from the core-and-veneer
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construction technique at subsequent pueblitos was presaged by the use
of the single-course thick partition walls within Tapacito Ruin, and its
use in the incomplete Rooms One, Two, and Seven. The construction of
the double facing-walls, which were then filled with rubble, markedly
increased the time, material, and manpower commitment involved in the
construction of a pueblito. For a structure which was not likely to have
been utilized as a full-time residence, and which would potentially be
abandoned upon the death of one of the inhabitants, such a commitment
seems overblown. One of the rationales behind the massive core-and-
veneer walls at Chaco is the necessity of supporting the weight of several
successive storeys, a level of engineering unnecessary at the smaller
pueblitos. It is worthy of note that although the principle of the use of
wooden lintels over doorways is one utilized in the construction of Navajo
hogans, it was also used in the construction of the Chaco Canyon
structures.

The construction of hooded fireplaces, as discussed in Chapter 12,
was adopted from the Spaniards. However, the principle of the curved
chimney bears considerable similarity to the Navajo principle of venting
smoke through the top of the hogan—the shape of the hooded fireplace
being approximately that of a quarter of a conical hogan. Even the
construction bears similarities, as the leaning slats supported by the
corner are similar to the “leaners,” or secondaries, supported by the

forked poles of a forked-pole hogan. Moreover, the Navajo may have
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observed such structures when visiting the Spanish missions at
Puebloan villages to trade—unlike the masonry wall construction, the
construction techniques of the hooded fireplaces would have been open
to view.

Had Tapacito Pueblito been constructed by Puebloans, it would be
expected that the profile of the utility ware assemblage would have been
considerably different. Of the 1059 utility ware sherds at the site, only
three (0.28 percent) were from a non-Navajo vessel, from the Southern
Tiwa pueblo of Zia (Marshall 1991:A3-9). If, as Towner and Dean
postulate, Puebloans were welcomed into an extant immigrant
community, one would expect either Puebloan utility sherds, or variant
Puebloan utility sherds constructed using local materials. A similar
pattern would be expected among the service ware sherds, with a
preponderance of sherds representative of the pueblo of origin. Neither is
the case at Tapacito.

Towner also suggests that Tapacito Ruin may be the origin site for
the Coyote Pass Clan among the Navajo. In addition to the factors cited
above which make this highly improbable, it appears that the accession
of the Coyote Pass clan occurred after the destruction of Awatovi in AD
1700 (see Chapter 10). Additionally, if the residents were from Jemez,
one would expect a certain number of the service ware sherds to be of
Jemez Black-on-White—a type which is entirely absent from Tapacito

Ruin.
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It appears highly likely, therefore, that Tapacito Ruin is in fact an
indigenous Navajo phenomenon, and the first step in the development of

a unique defensive strategy in the American Southwest.
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15 Conclusion

Western scientific understanding of the nature and development of
Navajo culture has long been heavily influenced by the “refugee
hypothesis,” although at the time of its formulation by A.V. Kidder in the
early part of the twentieth century, it was simply that—a hypothesis. A
hypothesis, however, that soon achieved the status of accepted fact, and
was not seriously questioned until the last decade of the twentieth
century, almost seventy years after Kidder first published his hypothesis.
These challenges (Hogan 1991; Towner 1996) were based upon historical
and chronometric data, respectively. The necessity of the application of
archaeological data to the resolution of the question has not been
overlooked, however, and calls have been made for a review of the
archaeological evidence (see Brown 1996:47, 52; Wheeler, Wilcox and
Ayers 1996:232). It is the examination of such archaeological evidence
which has been the focus of this work.

In an attempt to expand the sample size available for study, a
survey of the site complexes surrounding three pueblitos in and around
Palluche Canyon, New Mexico, were undertaken. The results of the
surveys at 42 Pueblito (LA 86895), the Overlook Site (LA 10732) and
Foothold Ruin (LA 9073) expanded the previous sample, established by

Marshall (1991), by thirty-three percent. The project also added fifteen
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newly-recorded sites to the database at the New Mexico Laboratory of
Anthropology, providing additional data for future archaeological
research in the area.

Archaeological data were then applied to the question of the ethnic
affiliations of the pueblito inhabitants, focusing on three general
categories of data: ceramics, in particular utility wares; architecture and
construction techniques; and settlement patterns and community layout.
Comparisons were drawn between the characteristics of the pueblito
sites, and those of the Navajo, Towa, and Tewa—these latter groups
being those determined by Hogan (1991) on the basis of historical
records, to have been the most likely source populations for immigrants
to the Dinétah area. An examination of the ethnohistorical record, rather
than that provided by Spanish chroniclers, was also undertaken to find
evidence of the postulated presence of Puebloan refugees in the Navajo
area.

Ethnohistoric Navajo accounts indicate that there was no major
influx of Puebloan immigrants to the Navajo, but rather that accessions
of Puebloan groups occurred gradually, over a period of many years.
Likewise, there is little ethnohistorical evidence among the Tewa and
Towa of a retreat to the Navajo. The origin of the Navajo Coyote Pass
Clan, sometimes cited as indicative of Puebloan refugees among the

Navajo was determined instead to have arisen from a single Jemez
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woman captured in a raid, and that the addition of this clan likely
postdates AD 1700.

Utilizing the data from both the 2002 Palluche Canyon surveys,
and from Marshall’s 1990 surveys (Marshall 1991), ceramic evidence for
the presence of Puebloan immigrants at pueblito sites was examined,
based on the presence or absence of Puebloan utility wares, and was
determined to be non-existent. Only small numbers of Puebloan
decorated ware sherds have been encountered at the pueblito complexes,
and only eight sherds of Zia utility wares were encountered at all twelve
sites combined. Had Puebloan immigrants constructed the pueblitos, it
would be expected that they would have a) brought small numbers of
utility vessels with them, which would then be deposited at the site in
the form of sherds, and b) created larger quantities of utility vessels,
employing traditional manufacturing techniques, but local materials.
Neither was determined to have been the case at the pueblito sites, and
the Puebloan decorated wares represent the wide spectrum of sherds one
would anticipate from trade activities, rather than a preponderance of
sherds from a single Puebloan group, which would be the case if the
immigrants hailed from a specific pueblo or language group.

The similarity between the construction of the Navajo pueblitos
and the Puebloan pueblo structures was a major contributing factor to
the formulation of the “refugee hypothesis.” These similarities were

determined to be more superficial than real, however. Architectural
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details such as doorways (or the lack thereof), room shape, lintels, hearth
style, storage bins, and the setback of upper storeys were all considered,
as well as details of roof and wall construction. The masonry techniques
employed at the pueblitos and those used at Towa pueblos were
determined to be quite different, and the Tewa use of all-adobe wall
construction was more different still. The use of ground-floor exterior
doorways, wooden lintels, hooded fireplaces, the irregular room shape,
the absence of interior storage bins and slab-lined hearths, and the lack
of setbacks on the upper storeys of structures were all determined to be
non-Puebloan in nature, and many of these details have direct Navajo
correlates.

The relationship between population density, social structure, and
defensive techniques was also considered. The Navajo, Towa, and Tewa
were examined, and this evidence was then compared with the known
data regarding pueblitos. The dispersion of pueblito sites on the
landscape was determined to be a hallmark of Navajo settlement, and
contrary to the social and defensive practices of Puebloan groups.
Although the fortress-like architecture and superior tactical position it
conveyed was Puebloan in nature, some important aspects of Puebloan
tactical architecture—such as U-shaped buildings housing large
numbers of defenders and surrounded the enemy on three sides—were
determined to be missing. Some aspects of Navajo defensive techniques,

such as camouflage, are evident in pueblito construction, and in this
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respect alone, pueblito structures appear to be an amalgam of Puebloan
and Navajo defensive techniques.

The importance of ceremonial structures, particularly of kivas
among the Puebloans, and the absence of such structures at pueblito
sites was also considered. Given that the prime rationale for the
mounting of the 1680 Pueblo Revolt was to protect the native religion
from Spanish attempts at eradication, the lack of kivas at pueblito sites
was deemed particularly strong evidence for the lack of Puebloans at
those same sites.

Taken together, the absence of ethnohistorical accounts of
Puebloan refugees among the Navajo, and the absence of ceramic,
architectural, and settlement pattern evidence for Puebloan immigrants
at the pueblito sites, indicates that the builders and inhabitants of the
sites were not Puebloan. The evidence is not entirely negative, however.
The preponderance of Navajo ceramics—especially utility wares—the
numerous Navajo elements present in the architecture of the pueblito
sites, and the correlation between the pueblitos and Navajo settlement
patterns and defensive techniques all argue cogently that the inhabitants
of the pueblitos were not merely not Puebloan, but that they were Navajo.

Tapacito Ruin (LA 2298) has long been acknowledged by
archaeologists to be unique among pueblitos, and the suggestion has
been made that it represented the only truly “Puebloan” pueblito. The

ceramic, architectural, construction, and settlement pattern evidence
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from this particular site was given separate consideration in Chapter 14.
Like the other pueblitos, Tapacito Ruin was determined to have been of
Navajo origin, and it was suggested, based on this analysis, that this
represented the initial adoption of this defensive technique among the
Navajo.

In concert with the historical and chronometric data regarding the
pueblitos, therefore, it appears that the question of the ethnic identity of
the pueblito builders has finally been conclusively answered: the Navajo

pueblitos are, in fact, Navajo.

Implications and Directions for Further Research

As is universally the case in archaeology, however, the answer to
one question in archaeology only breeds a litter of new ones. In this
instance, so much of the academic understanding of Navajo history,
archaeology, and the development of the Navajo culture has been
predicated on the assumption of intense inter-cultural exchange in the
period after the revolt, that almost all of the notions regarding the Navajo
will have to be re-evaluated, some old questions jettisoned, and new ones
formulated.

Perhaps some of the most fascinating questions raised by the
rejection of the “refugee hypothesis” are those which it was always

deemed to answer. Anthropologists have long noted the similarities
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between Navajo and Puebloan ceremonialism and creation stories, a
similarity attributed to post-Revolt co-residence. How, then, did these
similarities develop? Have the Navajo in fact been in the Southwest
longer than previously believed? Does Navajo ceremonialism bear greater
similarity to that of one Puebloan group than another, and what
implications might that have for Navajo migration routes into the
Southwest?

Other questions which arise are related to the pueblitos
themselves: can a pattern in the development and refinement of a
defensive system be traced, from the massive Chacoan-style architecture
at Tapacito Ruin, to the adoption of a perimeter-wall style such as that at
Old Fort (LA 1869) to the final small, isolated structures typical of the
pueblito? To what extent do these developments reflect a changing
response to a changing threat, and to what extent do they reflect a
continuing adaptation of a new defensive technique to the Navajo way of
life?

Kidder’s “refugee hypothesis” has finally, after more than eight
decades, has been tested, and disproved. But the pueblitos have no less
fascination for archaeologists now than they did for Kidder in the early
1900s, and they will continue to provide the basis for many more

hypotheses in the future.
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Introduction

This appendix discusses the terrestrial photogrammetry
techniques that were used to create detailed hogan feature maps for the
2002 Palluche Canyon Survey. All the maps were produced on a
computer using digital photographs taken in the field. The information
is presented in order to make the techniques and resources available for
other researchers.

Figures are shown that illustrate each of the steps required to
create feature maps. For an illustrative feature map in this appendix,
four adjoining grid cells (Figure A.2) were selected from Overlook Hogan 3
that showed both the wood from the original hogan and the stones in the
vicinity. These four grid cells were manipulated just like the more
numerous grid cells showing entire hogan sites.

The entire process utilized digital images. All of the original
photographs were taken with an Olympus C700 digital camera. The
digital images were transferred from the camera to a Toshiba 1900
Laptop computer via a USB 1.1 connection. The computer was located off
site but was available to review the images each evening after they were
taken. The software used to produce the feature maps consisted of
Microsoft Windows XP Home Edition and Adobe PhotoShop Elements
1.0. Although the hardware and software listed above were employed for

this project, other similar hardware and software could be utilized.
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Photographing the Site

Site photography utilized a 3 m by 3 m collapsible grid frame
(Figure A.1 and Appendix B) to determine the location of pictures. The
first step in taking pictures for a feature map was to establish a
temporary photography datum, marked with a pin flag. Then the grid
frame was overlaid on the feature with one of the grid intersections
located at the temporary datum. The initial placement of the grid should
be selected to keep the number of subsequent grid placements to a
minimum. The grid frame was carefully oriented to true North using a
compass adjusted for the local declination. An orientation photograph
was then taken to show the location of the grid frame relative to the
feature, the temporary datum and the background. This photograph was
taken from the south edge of the grid facing north and shows the relative
positions of the cells in the final map. Use of this orientation photograph
provides insurance against mis-numbering of the photographs or grid
cells. If necessary, errors can be corrected in the lab by referring to the
orientation photo. Use of the orientation photo should not be considered
as a substitute for good record-keeping in the field, however. In the 2002
Survey, one site required taking pictures of the grid frame from the west
due to the presence of trees and a cliff. Such deviation from the norm

should be noted in the photography record, so that it can be corrected for
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in the lab, and the final map or photograph oriented toward north. Once
all the grid cells were photographed, temporary pin flags were positioned
along the edges of the grid frame to facilitate repositioning the frame. The
grid frame was then moved to the new location and the flags were
removed. Only the temporary datum flag was left in the hogan feature
while photographing cells to avoid confusion about the location of the
temporary datum. Use of a different color of flag for the datum, or
marking the datum flag in order to distinguish it from other flags can

avoid confusion at this stage.

% WM —, v I 0V 2 e

Figure A.1 Orientation photo of Hogan 3 showing
photogrammetry grid frame.

Once the grid frame was positioned, photographs were taken of
each of the individual grid cells. These photographs were taken from the

west edge of the grid cell facing east. The west-to-east orientation of the
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photographer in the picture. (This orientation requires that the grid cell

photographs will have to be rotated 90 degrees before a map can be

prepared.) The photographer stood outside of the west edge of the cell

and located all four corners of the cell in the photograph. As each of the

grid cell photographs was taken, the photograph number was recorded

on graph paper (providing a Reference Grid) to correlate the photograph

with the site map. Figure A.2 for a sample reference grid showing

photograph numbers. The gray area indicates the four cells that were

used for examples in this appendix.

15| 16 | 17

18 | 19 | 20 2 3

21 | 22 | 23 ) 6 | 10
24 | 25 | 26 8 9 11
27 | 28 | 29 12 | 13 | 14

L
#

Overlook Hogan 3

Grid Frame Location

Cell Boundary
Temporary Photography Datum

Photograph Reference Number

Figure A.2 Photograph locations on the reference

grid for Hogan 3.
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Storing and Renaming Grid Cell Files

After all the photographs for a site map were taken, they were
downloaded to the laptop computer via a USB connection. All the
photographs used in this project were saved as JPEG (Joint
Photographers Expert Group) files. Once in the computer, the grid cell
photographs were copied to a new folder, for example “Hogan 3.” After
the files were saved in the new folder, all the grid cell photographs for
Hogan 3 were renumbered with names that ranged from 01.jpg to 37.jpg,
corresponding to the numbers assigned to them on the Reference Grid.
The renaming was carried out to ensure that the files were stored in the
correct order as noted in the grid drawn in the field (Figure A.2). Figure
A.3 shows examples of the original grid cell photographs. The original
photographs had names such as P9260692 (the camera-assigned file
name of the original photograph shown in Figure A.1), and were saved in
a separate folder as a backup. A removable backup disk was also used,
so the files could be saved outside of the computer for data continuity if
something untoward happened to the computer or its disk. (In the
absence of a removable backup disk, these files could also be burned to a

compact disk.)
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Figure A.3 Original photographs of grid cells, Hogan 3.

Grid Cell Rotation

Once the grid cells were renamed, they were rotated 90 degrees
clockwise (Figure A.4), so that each image was now oriented south-to-
north. By selecting all the files (click on the first file and shift+click on

the last file), a single rotate command in Windows XP rotated all the files.
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Figure A.4 Hogan 3 grid cells after rotation.

Parallax Removal

The ideal manner in which to take the photograph of each cell
would be to locate the camera directly above the center of the cell. With a
38 mm lens (35 mm camera equivalent) on the digital camera this proved

to be impracticable in the field. A special frame could be constructed to
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hold the camera above the center of the cell but the materials were not
available, and the photography would be much more time consuming.
Instead, the picture of each cell was taken from the west side of the cell,
as described above. Each cell photograph then had to be manipulated to
remove the parallax introduced by the non-vertical camera angle. The
parallax appears as converging grid lines in Figures A.3 and A.4.

The following documentation describes in detail how the parallax
was removed from each grid cell photograph. PhotoShop Elements was
used as the tool to remove the parallax. All terminology in the following
discussion relates to PhotoShop Elements. Items to be clicked with a
mouse are shown in Bold. Drop down menus to be selected with a mouse
are shown in the following example: Image > Transform > Distort. This
indicates that the user should click on Image, then in the drop down
menu, move the mouse to (or click on) Transform and finally in the next
drop down menu, click on Distort.

Start PhotoShop Elements. Select File Browser to open the cell
photograph. Click on the pull down list to choose the folder that contains
the file. This may require working through the folder tree the first time.
Then double click on the file to be opened. The file browser remembers
the folder that was chosen.

Next, select View and determine if there is a check mark in front of
Snap signifying that the “snap to grid” function is turned on. If there is a

check mark in front of Snap, click on Snap to remove the check mark
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and turn off the “snap to grid” function. If the “snap to grid” function is
turned on, all “handle” movements that control image distortion in the
distort function described below will snap to the nearest grid
intersections. “Handles” are points on the bounding box for the image
that can be dragged with the mouse to distort the image. Since small
movements of the “handles” are necessary to adjust the parallax, freedom
to position the “handles” anywhere is necessary. Once the “snap to grid”
function is turned off, the program will remember this setting.

Next, enlarge the window that contains the photograph of the grid
cell by moving the edges of the window. Then choose the Rectangular
Marquee Tool. Use the marquee tool to outline the cell photograph so
that all four cell corners (intersections of the grid lines in the grid frame)
are located in the selected area. Choose Image > Crop to crop the area
that contains the four reference points. This removes portions of the
photograph which appear outside of the selected grid cell. Select Image
> Transform > Distort to start the parallax removal process. One by one
move the four corner “handles” until the four sides of the grid cell form a
rectangle at the edge of the crop window. Double click on the center of
the rectangle to finalize the distortion correction. Use the marquee tool to
outline the new rectangle and choose Image > Crop. If the cell still isn’t
quite rectangular, repeat the distort and crop steps.

Once the grid cell is rectangular, choose Image > Resize. Click the

Resample Image box and then choose Bicubic. Unclick the Constrain
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Proportions box. The program will remember these values. Set the
Width and Height values to 1100 pixels. Choose OK to scale the image.
This will scale the grid cell rectangle into a square. By setting the size of
the square to 1100 pixels for each photograph, all the grid cells in the
hogan feature map will be the same size. (The value 1100 pixels was
chosen as the size because the original photographs were about that
size.) Any consistent pair of values can be used as long as the width and
height are equal. The user may even choose a width and height to match
some predetermined scale. The width and height may also be set to
values in inches or centimeters.

Select File > Save As to save the modified file. Save the file with a
new name. For example, if the original file was 01.jpg name the new file
could be hO1.jpg (any different name is OK, but some connection back to
the original file name is helpful). Select Save to save the file in the same
folder that contains the original file. In the JPEG window, set the Quality
Value to 4 and select OK. Close the grid cell window and start the
process for the next cell by using the File Browser. Figure A.5 shows the

four grid cells after the parallax has been removed.
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Figure A.5 Images of Hogan 3 after parallax removal.

Merge All the Files for a Site

Once all the individual cells for a feature have had the parallax
corrected, it is time to put them together to form an image of the entire
feature.

Start PhotoShop Elements. Choose File > Photomerge. In the
window that opens, set the Image Size Reduction to 50 percent if there
are more than about 20 400 KB photographs to merge. Choose Add. In

the next window that opens, choose all the files that make up the entire
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site. The easy way to select the files is to click on the last file in the set
(assuming they are in numeric order) and then shift+click on the first
file. Choose Open. Check the list to ensure that all the files have been
chosen. Unclick Automatically Attempt to Arrange Source Images
since it only works with linear images not two-dimensional images. Then
choose OK.

The computer will then display lots of images and will finally settle
on the window that allows the photographs to be merged. Figure A.6
shows the Photomerge screen at the beginning of the process to produce
the merged image in Figure G7. It is very helpful to have your hand
drawn grid of the site (Figure G2) to help get the grid cells in the right
order. In the merge window, unclick Snap to Grid. The photomerge
screen contains three windows: the source window containing the source
files (across the top), the image window that shows the work area relative

the entire image (on the right) and the work area (lower left).
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Figure A.6 The Photomerge screen in Photoshop Elements.

Drag the first source file from the source window into the work
area. On the slider under the image window choose 37 percent to reduce
the size of the source file in the work area. Move all the source files into
their relative positions in the work area. Leave a small space between
each file. Move the slider to about 65 percent to increase the size the files
in the work area. Moving the red rectangle around in the image window
(Figure A.6, right-hand side) changes the portion of the site displayed in
the work area. Merge the files in the work area by starting with the
center file and moving the surrounding files so they align with the center
file. Work out from the center and keep aligning files. (Two files being
aligned may overlap one another.) Once all the files have been merged

into the best possible configuration, choose OK.
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Select File > Save As to save the merged file. Save the file with a
new name. Select Save to save the file in the same folder that contains
the original file. In the JPEG window, set the Quality Value to 4 and
select OK. The photomerge process is finished. See Figure A.7 for a

picture of the four merged files.

Figure A.7 Hogan 3 after Photomerge.

Background Removal

The files produced by photomerge show the entire site but can be

difficult to read because of brush, cacti, shadows and other miscellany.
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As a result, the next step in the process is to remove the background, if
desired, to help discern patterns. This process is particularly useful for
larger sites. The process described below addresses the removal of the
background using PhotoShop Elements, but other graphics programs,
such as Adobe Illustrator, can be used to achieve a similar effect.

Start PhotoShop Elements. Use the File Browser to open the
merged file. Expand the image window to create a large work space.
Select the Eraser to remove the background. In the window that allows
the definition of the eraser parameters, choose a brush size and a brush
type. The brush size is set in a pull down menu and the brush type is set
by specifying the Mode. In the sample picture shown in Figure A.8, the
picture was blown up so individual pixels could be seen (smaller images
can be used for production work). An eraser with a brush size of 3 and a
Mode of Brush was used to outline each piece of wood and each stone.
Then an eraser with a brush size of 3 and a Mode of Pencil was used to
expand the outline. Brush feathers the edge and pencil leaves a sharp
edge. The feathered edge looks better when printed. Finally, a larger
eraser with a brush size of 19 and a Mode of Pencil was used to clean
out the background between the outlines. The largest brush size used in
the project was 65.

During background removal, some portion of the image was left in
each of the corners to insure that the map sizes remained constant and

that the corners of grid remained visible. If wood or stone exists in a
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corner, it is left there. If nothing of interest exists in a corner, a small
triangle is left. Since the maps are scaled using minimum and maximum
coordinates, this ensures that if maps are overlaid, they will be the same
size. In Figure A.8, three corners contain triangles and the fourth corner
contains stone.

Select File > Save As to save the file with the background
removed. Save the file with a new name. Select Save to save the file in
the same folder that contains the original file. In the JPEG window, set
the Quality Value to 4 and select OK. Figure A.8 shows the merged file

with the background removed.

.

Figure A.8 Hogan 3 with the background removed,
showing wood and stone.
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In the search for discernible patterns, the next step in this project
was to separate the wood from the stone. Using the same process that is
described in background removal, a copy of the Wood & Stone file where
the background was removed was used. All of the stone was removed
with the eraser and the file that contains only wood was saved. The Wood
& Stone file with the background removed was used again, and in this
case all the of wood was removed and the file that contained only stone
was saved.

Figure A.9 shows just the wood in the Hogan Site Map while Figure

A.10 shows just the stone.

L 4 ) GNP

Figure A.9 Hogan 3 showing only Figure A.10 Hogan 3 showing only
wood. stone.
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Black-and-White Images

Figures A.9 and A.10 show the patterns of wood and stone as a
photograph. This may be problematic if the document is to be
photocopied, since some of the light colors and light grays may not show
up well. The following process indicates how to replace the color with
black. The description that follows is for the process using PhotoShop
Elements, but other graphics programs can also be used.

Start PhotoShop Elements. Use the File Browser to open the file
that has had the background removed. Expand the working window to
give the maximum work area. Choose Image > Mode > Grayscale to
remove all color from the image. Expand the image so that individual
pixels can be seen and choose an area with lots of wood and/or stone.
Choose Image > Adjustments > Threshold. In the popup window, move
the slider to approximately 240. Watch the image as you move the slider
and choose a value that is a compromise between extraneous white spots
in the black areas and black spots in the white areas. Then choose OK.

Select the Eraser to remove the black spots in the white areas and
use the Pen to fill in the white spots in the black areas. When all the
spots are fixed, select File > Save As to save the black and white file.
Save the file with a new name. Select Save to save the file in the same
folder that contains the original file. In the JPEG window, set the Quality

Value to 4 and select OK.
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Figures A.11, A.12 and A.13 show images where the wood and
stone have been turned to black. Figures A.12 and A.13 show the wood
and stone patterns clearly. This portion of Hogan 3 was selected for
illustrative purposes because it showed both wood and stone, and no
definite patterns are visible. The only pattern that might be seen is that
the center of the hogan is in the lower left corner and the wood in the

hogan radiated outward from the center.

Figure A.11 Black-and-white image of Hogan 3
showing wood and stone.
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Use of Layers

Cleaning up the Black and White images takes time to delete and
fill in pixels. Instead of cleaning up all three images (Wood & Stone,
Wood and Stone) it is possible to clean up the individual Wood and Stone
images and merge the two images to make the Wood & Stone image.

Start PhotoShop Elements to merge the two images. Use the File
Browser to open the Stone image and then open the Wood image. Chose
Select > All to select all of the Wood image. Choose Edit > Copy to save
the Wood image to the clipboard. Close the Wood image window. Choose
Layer > New > Layer to create a new layer on top of the Stone image.
Choose Edit > Paste to copy the clipboard image of Wood onto the new
layer. Use the Magic Eraser to erase the background on the new Wood
layer. At this point both layers should be visible in the working window.
Choose Layer > Flatten Image to merge the two layers.

When the two layers have been merged, select File > Save As to
save the black and white Wood & Stone image. Save the file with a new
name. Select Save to save the file in the same folder that contains the
original two files. In the JPEG window, set the Quality Value to 4 and

select OK.
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Comments

Once the limited set of PhotoShop Elements procedures that are
necessary to complete the project have been learned, the procedures
required to produce these images are easy to repeat. If an individual is
starting from scratch, the learning curve is moderate to difficult
depending on the computing knowledge of the individual. During the
course of this project, by the time each step was finished, the procedure

was easy to carry out because a number of short cuts were found. Future

users will benefit from the instructions contained herein.

A
Figure A.12 Black-and-white Figure A.13 Black-and-white
image of Hogan 3 showing only image of Hogan 3 showing only
wood. stone.
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A PhotoShop Elements User Manual is very helpful the first time

through certain steps in the process. For example, working with layers

required the user manual although the help menu might have been

sufficient.

While taking photographs of a feature, the grid frame should be

laid flat on the ground so that the frame and twine are not raised above

portions of the site surface. If the grid frame or twine is held above the

ground, the camera may see a portion of the site that is outside the

actual grid cell boundary, producing some cell overlap (Figure A.14). This

can happen if there is brush or stones on the site that lift the grid frame,

or if the ground is otherwise uneven (Figure A.1 where the grid frame is

resting on logs and brush).

. — Camera

Cell
Boundary ~\

Cell
e Boundary

Possible Overlap —

T

Figure A.14 Grid cell overlap caused by a raised boundary.
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A partial solution to the cell overlap problem is to place markers on
the ground directly below the intersections of the twine and grid frame.
Possible examples of markers are black and white disks 1.5 inches in
diameter. Vertical sticks or wires inserted through the markers would
facilitate the placement and movement of markers. The photographer
would use the disks as the corners of the grid cells. The markers would
then be used as cell corners in the parallax removal step in PhotoShop
Elements. Where a cell corner is under a rock or log, white tape could be
used to point toward the point of intersection on the ground making the
corner visible during parallax removal. However, image overlap becomes
evident in the process of merging the cell photos, and provided that
adequate care is taken in placement of the grid in the field, the problem
is not a serious one.

The final merged image is approximately to scale but is not exact.
When the source files are merged, there is some overlap to line up
objects in the image. After parallax removal, the grid cell size was set to
1100 pixels. The first step in the photomerge process was to reduce the
1100 pixel cell size by 50 percent, giving a 550 pixel cell size. After
merging the grid cell images, the average cell size was 532 pixels based
on the horizontal and vertical dimensions of the five hogans and one
stone circle. Table A.1 for the dimensions of each Feature Map. This

means that the average cell size was 96.79 percent of the original cell
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size which indicates a 3.21 percent overlap of grid cells in the final

image. If the entire image is expanded by 3.38 percent to increase the

average cell size to 550, the error on object placement in the hogan

feature map should be no more than +/-5 cm. This accuracy should be

at least as good as images hand drawn in the field. As described in the

previous paragraph, reducing cell overlap caused by elevation of the grid

would improve the overall accuracy.

Table A.1 Site Map Properties.

Width | Height | Width | Height | /V6ra8¢ | Average
Pixel Pixel
Map Name In In In In . .
Pixels | Pixel Cell Cell Width | Height
Xers Xels s ©"S | per Cell | Per Cell
Foothold Hogan 4018 | 3195 7.5 6 535 533
1
Overlook Hogan 4195 | 3089 8 6 524 514
1
Overlook Hogan 2711 | 2633 5 5 542 526
2
Overlook Hogan 3677 | 2674 7 5 525 534
3
Overlook Hogan 3236 | 3245 6 6 539 540
4
Overlook Stone 1602 | 1628 3 3 534 542
Circle
Average Width
and Height of 533.18 531.5
Cells in Pixels
Average Cell Size
for the Project in 532.33
Pixels
Average Cell Size
for the Project in 0.9679
Meters
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A computer with a fair amount of memory and a fast processor is
beneficial because PhotoShop uses lots of memory and performs lots of
computations. The Toshiba 1900 laptop computer used for this phase of
the project runs at 1.6 GHz and contains 512 MB of memory.

JPEG files have a problem displaying sharp edges if the Quality
Value is low. They tend to have JPEG artifacts around sharp edges which
can show up in detailed prints. The JPEG artifacts show up as a pattern
of dots along the sharp edge. Two solutions are available to solve this
problem: use file types that have loss-less compression or increase the
JPEG Quality Value to a maximum of 12. The black and white Wood file
(Figure A.12) was 112 KB with a Quality Value of 4. The same file with a
quality Value of 12 was 235 KB but the JPEG artifacts did not show up.
While the file size doubles, this is still far better than the 1.04 MB
required for a Bit Map file (BMP). If files are being manipulated at the
pixel level, it is best to use the higher Quality Value JPEG file. A
PhotoShop Data file (PSD) saves all the data as there is no data
compression. The PSD file for Figure G9 is 971 KB compared to 104 KB
for the same image stored as a JPEG file with a Quality Value of 4. The
use of high quality PSD files is probably unnecessary because the
original camera images are JPEG files.

PhotoShop Elements “remembers” the parameters that have been
set during previous uses of the program. This makes running the

program convenient. It also means that some parameters may have been
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set prior to starting this project and may not be included in this
discussion about how to use the program.

All the photographs were taken in September and October and the
manipulation of the images occurred during the following January. As a
result, the lessons learned could not be applied to the field work after the
fact. Since all the procedures for using PhotoShop Elements had to be
figured out while working on the project, it took longer than if the
procedures had been known in advance. All-in-all, the procedures work
well and produce good images. The images can be blown up to large sizes

and still retain good detail.

Conclusions

The terrestrial photogrammetry techniques developed for the 2002
Palluche Canyon Survey are relatively simple, require little additional
time in the field, and do not require highly specialized equipment,
computer programs, or capital outlays. For these reasons, the
techniques could be used in a number of field research applications,
including both survey and excavation applications.

The production of detailed maps for archaeological sites is a task
which often consumes considerable field time, which in turn reduces the
amount of fieldwork that can be accomplished in a given time frame.

Although this technique was developed in order to provide detailed maps

www.manaraa.com



279

of surface features, the same techniques could be employed to produce
detailed site maps of excavations, whether they be small-scale or large-
scale. In the case of excavations, the excavation grid units could be used
in lieu of the portable 3 x 3 meter grid frame used for this survey. If
desired, photographs could be taken of each excavation level (5 or 10
centimeter units, for example) as it was reached in each excavation
square. It would then be possible to create maps at each level of an entire
site, effectively allowing researchers to visually “peel back” the site one
level at a time...a capability which would be particularly useful at
complicated, multi-component sites.

The technique developed by the 2002 Palluche Canyon Survey
team (or “Sinkey system”) has a number of advantages over other site
imaging techniques, such as the use of a bipod. For instance, in order to
prepare an excavation site for photography using a bipod, all excavation
squares must have reached the same level (a hogan or pithouse floor, for
instance), and must be prepared for photography—artifacts pedestaled,
backdirt removed, etc. Inevitably, this results in lost time if some
portions of the site are still being prepared, while others are ready. Use
of the Sinkey system reduces this down time, as excavation squares can
be prepared individually for photography as they are completed, and the
whole assembled into a site map upon return from the field.

An additional advantage of the Sinkey system over traditional site

photography techniques is the amount of detail which can be captured
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for mapping. The use of a bipod, particularly for large sites, results in
inevitable loss of detail due to the distance from the camera to the
subject. With the Sinkey system, because the photographer is less than
2 meters (the average height of an individual) from the subject,
considerable detail can still be maintained. When the final feature
montage is assembled, the amount of detail to be included in the final
feature maps can then be determined by researchers in the lab.

The accuracy of maps produced using this system is extremely
high—higher than with traditional hand-mapping technologies, and also
higher than maps produced using photographs taken with a bipod,
particularly of large sites. This is in part because of the greater detail
which can be captured, but also because it addresses the distortion
caused by parallax—the visual phenomenon which causes lines, such as
railroad tracks, to appear to converge with increasing distance. Even
with a bipod, not all portions of the site are the same distance from the
camera—those being directly under the lens being closer—which
introduces an element of distortion to the photograph, and to subsequent
maps produced from that photograph. This system addresses, and

corrects for, parallax, which allows greater accuracy in mapping.
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Appendix B
Construction of the Photogrammetry Grid Frame

by

Leslie-lynne Sinkey
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Construction Technique

The 3 x 3 meter photogrammetry grid frame was constructed using
four lengths of %” CPVC pipe, and four 90 degree elbows, mason’s twine,
and ring terminals (Figure A.1 in Appendix A), purchased at the local
hardware store. The pipe is sold in slightly over 3 meter lengths, and
was cut to the appropriate length using a hacksaw. It is important to
include in the calculations the additional length contributed by the elbow
joints when attached to the pipe, in order to achieve a grid frame that is
precisely 3 x 3 meters in interior dimensions (exterior dimensions will be
slightly larger, due to the diameter of the pipe.)

Once the pipe was cut to length and the grid frame assembled, it
was necessary to divide the grid into one-meter increments.
Measurements were taken, and two points marked on each of the pipes,
representing one meter intervals. A drill was used to drill through each
pipe at these points. Mason’s twine (also available at the hardware store,
as were the ring terminals), was then fed through the holes in the pipe,
and through the corresponding holes in the pipe on the opposite side of
the grid frame. Care was necessary at this point, as the mason’s twine
must be sufficiently taut to provide an accurate grid, but not so taut that
it distorts the pipes, which are quite flexible. Checking measurements

with a tape measure can preclude distortion.
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: Figure B.1 Ring terminal, available in
-:_‘, electrical section of hardware store. Actual
size: 1.7 x 0.8 centimeters

For this project, bright yellow mason’s twine was employed. The
twine is available in a number of bright colors, as well as in white. The
use of colored twine made distinguishing the edges of the grid cells in the
final photographs much easier than might be possible with white,
especially in areas with light-colored soils. The ends of the mason’s
twine were secured using ring terminals, which would not pull through
the holes in the pipe, as might be the case with simple knots.

Once frame construction was complete, the elbow joints were
removed, the two pairs of pipes, joined by mason’s twine, were rolled
together, and the elbow joints were strung on a spare piece of mason’s
twine to prevent their loss. The pipes can be mounted on top of an
expedition vehicle’s roof rack for transportation. The entire assembly
weighs only a few pounds, and can easily be carried to the site over one
person’s shoulder.

It should be noted that in using this system, as with all
archaeology, careful record-keeping is an absolute necessity. In order to

ensure that once the researchers have returned to the lab, it must be
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possible to place the photographs in their proper positions in the feature

grid.

o AJLb
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Appendix C

Detailed Hogan Feature Maps

for Overlook Hogan 4

by

Lawrence O. Sinkey
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The following images show three Hogan Feature Maps of Overlook

Hogan 4. The first map shows the photographic image following the

merge step (no background removal). The second shows a photographic

image with only the background removed. The third shows the Black-

and-white image. The three images show the detail that can be produced

when making maps using the terrestrial photogrammetry techniques

described in Appendices A and B, and provide a perspective on the

results obtained than is provided in the more limited four-cell

illustrations in Appendix A.
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Figure C.1 Photography reference
grid for Overlook Hogan 4.
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Figure C.2 Merged photos of Overlook Hogan 4.
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Figure C.3 Photograph of Overlook Hogan 4, with the background
removed.
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Figure C.4 Black-and-white map of Overlook Hogan 4 showing wood and
stone.
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